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Preface

This documentation describes the functions that are available for IBM DB2 Web Query for
IBM i.

How This Manual Is Organized

This manual includes the following chapters:

ContentsChapter/Appendix

Describes how to create a user interface in the local
development environment using the HTML Composer.

Using the HTML Composer1

Describes how to create Active Technologies
Dashboards and Rich Internet Application using the
HTML Composer.

Creating Active
Technologies Dashboards
and Rich Internet
Applications With HTML
Composer

2

Documentation Conventions
The following table lists and describes the conventions that apply in this manual.

DescriptionConvention

Denotes syntax that you must enter exactly as shown.THIS TYPEFACE

or

this typeface

Represents a placeholder (or variable), a cross-reference, or an
important term.

this typeface

Indicates a default setting.underscore
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DescriptionConvention

Highlights a file name or command. It may also indicate a button,
menu item, or dialog box option you can click or select.

this typeface

Indicates keys that you must press simultaneously.Key + Key

Indicates two or three choices; type one of them, not the braces.{ }

Indicates a group of optional parameters. None is required, but
you may select one of them. Type only the parameter in the
brackets, not the brackets.

[ ]

Separates mutually exclusive choices in syntax. Type one of them,
not the symbol.

|

Indicates that you can enter a parameter multiple times. Type only
the parameter, not the ellipsis points (...).

...

Indicates that there are (or could be) intervening or additional
commands.

.

.

.
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Using the HTML Composer1
Topics:

The HTML Composer enables you to
graphically create an HTML page that
incorporates forms, reports, graphs, and
Web objects. The HTML Composer is fully
integrated with JavaScript and Cascading
Style Sheets (CSS).

Uses for HTML Composer

Getting Started With HTML Composer

Creating a Report Page Layout
The HTML Layout Painter is now referred
to as the HTML Composer. This name
change does not affect the functionality
of the tool.

Creating and Using Parameters in
HTML Composer

Chaining Controls for Dependencies
in HTML ComposerNote: The HTML Composer does not

support OLAP-enabled reports. The HTML
Composer is accessible only through the
DB2 Web Query Developer Workbench.
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Uses for HTML Composer
You can do the following when creating an HTML form:

Build an HTML webpage. HTML Composer enables you to add push buttons, hyperlinks,
and other objects that launch other DB2 Web Query reports in your application.

Create a webpage for one or more reports that contain parameters.

Create a complete dashboard by adding multiple reports and graphs into a single HTML
page.

Create an advanced report layout by including images, frames, and other web elements.
You can change the location, size, and properties of all objects in your layout.

Set background, font, and other properties in the Style Composer tool.

Create a Rich Internet Application (RIA) to create an interactive webpage experience
inside a browser. For details, see Creating a Rich Internet Application (RIA) With the HTML
Composer.

Getting Started With HTML Composer

How to:

Access HTML Composer

Reference:

HTML Composer Windows and Toolbars

Standard Toolbar

Components Toolbar

Formatting Toolbar

The HTML Layout Painter is now HTML Composer.

Note:  The name changes does not affect the functionality of this tool.  HTML Composer
does not support OLAP-enabled reports. If you execute a report from HTML Composer with
this option, the output window will not display the OLAP controls, and you will receive a
scripting error. In order to execute this type of report, you must use a frame. For more
information, see Adding a Frame to the Layout on page 22.

How to Access HTML ComposerProcedure:

1. From the Domains folder under Managed Reporting, click Reports.
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2. Right-click a subfolder and select New, then HTML File.

The New Html File dialog box opens.

3. Enter a name for the new HTML file in the File name field.

4. Ensure that Composer is selected in the Create with field.

5. Click Create.

The HTML Composer opens.
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HTML Composer Windows and ToolbarsReference:

The following image is an example of HTML Composer.

The main elements of HTML Composer are:

Menu Bar

Displays pull-down menus for HTML Composer.

Developer Workbench Toolbar

Displays tool buttons, such as Open and Run.

Standard Toolbar

Displays buttons, such as Cut and Paste that allow you to edit the layout.

Components Toolbar

Contains buttons that add objects and controls to the layout.

Formatting Toolbar

Displays buttons that format and align text when using a text element in the layout.
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Positioning Toolbar

Contains buttons that control the appearance of the layout. For details, see Positioning
Toolbar on page 252.

Utilities Toolbar

Contains buttons that control synchronization and chaining. For details, see Utilities
Toolbar on page 255.

Properties Window

Displays the Properties tab, which contains the Properties subtab and the Events subtab
when an object is selected in the layout. The Properties window also contains the
Thumbnails tab.

The Properties subtab contains options for the properties of the object.

The Events subtab displays the JavaScript events associated with objects in the
layout.

For details, see Working With the Properties Window on page 66.

Thumbnails Tab

Enables you to view a thumbnail of the page layout. Thumbnail view allows objects on
the page to participate in actions with controls on the Parameters tab. You may also
refresh the Thumbnails tab, enlarge or reduce the thumbnails, and change the zoom
levels. Reports and graphs appear as placeholder objects on the Thumbnails tab.

QuickLinks Window

Displays links to information on Help, configuration options, metadata creation, and
reports and procedures.

Note: QuickLinks is turned off by default. If you need to access QuickLinks, select
QuickLinks from the View menu (when you are in the Developer Workbench Explorer).

Design Tab

Displays the design view where you can add and position objects to the layout.

Parameters Tab

Displays information about the parameter values and input controls in your report or
graph. For details, see Working With the Parameters Tab on page 73.

Embedded JavaScript

Displays the HTML code and the JavaScript code for objects in the HTML layout.

Note: You may reorder the position of the Design tab, Parameters tab, and Embedded
JavaScript by left-clicking and dragging the tabs on the bottom of the HTML layout.
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Standard ToolbarReference:

The Standard toolbar contains the following buttons:

DescriptionButton

Saves the HTML file to the current project. This button is dimmed once
the layout is saved and no new changes have been made. When a
change has been made to the layout, the Save button is active until
the layout is saved again.

Removes the highlighted object(s) and saves it to the clipboard.

Copies the highlighted object(s) to the clipboard.

Pastes the object(s) to the specified location.

Deletes the highlighted object(s).

Resets the layout by reversing the last action performed.

Repeats the last action performed.

The Refresh All option enables you view any edits or changes that you
made to your layout. Refresh All reloads all objects and reruns the
reports and graphs in Design view.

Note: Refresh also shows changes made to reports and graphs that
are referenced in your layout.
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Components ToolbarReference:

The Components toolbar contains the following buttons:

DescriptionButton

Inserts a report object to the layout.

For details, see Adding a Report, Graph, or Compound Document to
HTML Composer on page 18.

Inserts a graph object to the layout.

For details, see Adding a Report, Graph, or Compound Document to
HTML Composer on page 18.

Inserts a placeholder for a control.

For details, see Using Controls to Supply Incoming Parameter Values on
page 124.

Inserts a placeholder for an IFRAME. An IFRAME can have its own URL
and contain HTML content, and it can be a placeholder for a drill-down
report.

For details, see Adding a Frame to the Layout on page 22.

Inserts a placeholder for an image.

For details, see Adding an Image to the Layout on page 30.

Inserts text.

For details, see Adding Text to the Layout on page 33.

Inserts a line.

For details, see Adding a Line to the Layout on page 28.

Adds a group box.

For details, see Adding a Group Box to the Layout on page 44.
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DescriptionButton

Adds a text box.

For details, see Using a Text Box on page 134.

Adds a hidden control.

For details, see Using a Hidden Parameter Value on page 207.

Adds a drop-down list.

For details, see Using a Drop-Down List on page 141.

Adds a list box (a drop-down list that allows multiple selections).

For details, see Using a List Box on page 146.

Inserts a placeholder for a double list parameter control.

For details, see Using a Double List Control on page 149.

Adds a push button.

For details, see Adding a Push Button to the Layout on page 46.

Adds a reset button.

For details, see Adding a Reset Button to the Layout on page 51.

Adds a radio button.

For details, see Using Radio Buttons on page 169.

Adds a check box list.

For details, see Using Check Boxes on page 167.
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DescriptionButton

Inserts a text area.

For details, see Using a Text Area on page 138.

Inserts a tree control.

For details, see Using Tree Controls on page 173.

Inserts a hyperlink.

For details, see Adding a Hyperlink to the Layout on page 39.

Adds a calendar.

For details, see Adding a Dynamic Calendar on page 200.

Adds an ActiveX control or a Visual Discovery control.

When adding ActiveX controls in HTML Composer, only true ActiveX
controls are shown in the list. The first time that an ActiveX control is
added, a message appears indicating that it is reading ActiveX controls
from the registry. This list is cached for future use and only ActiveX
controls are added.

Inserts a panel to group objects together. The panel is invisible at run
time.

For details, see How to Group Objects on the HTML Page on page 252.

Inserts a slider parameter control bar.

For details, see Using a Slider Control on page 196.

Inserts a tab control.

For details, see Adding a Tab Control to the Layout on page 53.

Inserts a label. A label is simply a piece of text. The label component
enables you to create and name a label, and link it to a control.

For details, see Adding a Label to the Layout on page 63.

IBM DB2 Web Query for IBM i 15

1. Using the HTML Composer



Formatting ToolbarReference:

The Formatting toolbar contains options that can be applied to individual strings of text, as
well as to the entire text element, with the exception of the alignment options. The alignment
options can only be applied to the text element.

For more information about using text elements, see Adding Text to the Layout on page 33.

DescriptionButton

Applies bold formatting to the text.

Applies italic formatting to the text.

Applies underline formatting to the text.

Applies superscript typography to the text.

Font style opens the Font dialog box where you can set the Font, Font
Style, Size, Color, and Effect of the text.

Aligns the text element to the left.

Aligns the text element to the center.
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DescriptionButton

Aligns the text element to the right.

Aligns the text to fill the width of the text element.

Creating a Report Page Layout

In this section:

Adding a Report, Graph, or Compound Document to HTML Composer

Adding a Frame to the Layout

Adding a Line to the Layout

Adding an Image to the Layout

Adding Text to the Layout

Adding a Hyperlink to the Layout

Adding a Group Box to the Layout

Adding a Push Button to the Layout

Adding a Reset Button to the Layout

Adding a Tab Control to the Layout

Adding a Label to the Layout

Working With the Properties Window

Layering Objects

Working With the Events Subtab

You can use HTML Composer to create an HTML page that launches and displays your
reports and graphs. You can add elements to the HTML page, such as reports, graphs, text,
and controls.

You can also set properties for the HTML page in HTML Composer. For details, see Setting
HTML Page Properties on page 237.
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Adding a Report, Graph, or Compound Document to HTML Composer

How to:

Add an Existing Report or Graph to a Layout

Reference:

Report Properties in the Properties Window

Graph Properties in the Properties Window

You can add reports and graphs to HTML Composer that will display when you run the layout.
You can add an existing report or graph that resides on an available server.

You can also include parameters in a report or graph whose values can be assigned with
controls that are added with HTML Composer. For information, see Using Controls to Supply
Incoming Parameter Values on page 124.

You can set the graphic used as a placeholder for a report or graph in the layout using the
HTML Page tab, located in the Developer Studio Options dialog box. For details, see How to
Set Page Properties on page 256.

Note:

In order for a graph to fit an HTML Composer frame properly at run time, in InfoAssist,
you must select the Autofit command and verify that any graph headings are embedded.
You must also embed the graph, into the HTML page, using the Import existing graph
command.

You can reference an existing graph in your HTML page. To ensure the entire graph is
displayed without the need to scroll, you must resize the frame so the entire graph fits.

InfoMini procedures cannot be referenced in an HTML page.

How to Add an Existing Report or Graph to a LayoutProcedure:

1. Insert a report or graph object by doing one of the following:

Click the Report or Graph button from the Components toolbar.

The cursor changes into a crosshair. Click and drag the crosshair to create a report
or graph object and adjust it to the size you want.
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A report or graph object is created in the layout and assigned the name report(n) or
graph(n), where n is a number. The object will appear in gray and white to indicate
that the placeholder does not have a report or graph associated with it. Once a report
or graph is associated with the object, the object displays the contents of the report
or graph if live or simulated data is active (live data is the default) or a colored
placeholder if preview is off in the HTML Page tab, located in the Developer Studio
Options dialog box.

Right-click in the layout and select New Report or New Graph from the context menu.

2. Right-click the report or graph and select Reference existing procedure.

3. Enter the name of the procedure you want to add to the layout.

4. Click Open.

The report or graph object appears in the Design view of HTML Composer.

5. Optionally, change the properties by adjusting the properties displayed in the Properties
tab of the Properties window. For details, see Report Properties in the Properties Window
on page 20.
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Report Properties in the Properties WindowReference:

When a report is selected, the Properties tab in the Properties window contains options that
control the properties of your report.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Graph Properties in the Properties WindowReference:

When a graph is selected, the Properties tab in the Properties window contains options that
control the properties of your graph.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Frame to the Layout

How to:

Add a Frame to the Layout

Assign a URL, HTML File, or Report to a Frame

Show/Hide a Frame in the Layout

Reference:

Frame Properties in the Properties Window

You can use a frame to embed additional web sources or run reports. You can also use a
frame as the output location or target for a drill-down report. You can also use a frame to
run a table of contents report, an OLAP report, a PDF report, or an Excel® report.

How to Add a Frame to the LayoutProcedure:

1. Insert a frame by doing one of the following:

Click the Frame button.

From the Insert menu, select Components, then click Frame.

The cursor changes into a crosshair.

2. Click and drag the crosshair to create a frame and adjust it to the size you want.

A frame is created in the layout and assigned the name iframen, where n is a number.

3. Optionally, change the properties of the frame by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see Frame Properties in the
Properties Window on page 27.

How to Assign a URL, HTML File, or Report to a FrameProcedure:

1. Insert a frame by doing one of the following:

Click the Frame button.

or

From the Insert menu, select Components, then click Frame.

The cursor changes into a crosshair.

2. Click and drag the crosshair to create a frame and adjust it to the size you want.
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A frame is created in the layout and assigned the name iframe(n), where n is a number.

3. Right-click the frame, and select Frame Properties from the context menu.

The Hyperlink Properties dialog box opens.

4. Click the New button to create a new action. From the drop-down list in the Action field
you can select:

URL. To assign a URL address to the frame, select URL and enter the fully-qualified
URL in the Source field.

HTML File. To assign an HTML file to the frame, click select HTML File and enter
the file location in the Source field, or click the browse (...) button to browse to the
location. An HTML file refers to the HTML files in your application.

External Procedure. To assign an external procedure to the frame, select External
Procedure and enter the procedure location in the Source field, or click the browse
(...) button to browse to the location.

5. Click OK.

6. Optionally, change the properties of the frame by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see Frame Properties in the
Properties Window on page 27.
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How to Show/Hide a Frame in the LayoutProcedure:

1. From HTML Composer, use the controls to supply parameter values for a report.

Note: A report with parameters requires that you select values (at run time) in order to
generate the output.

2. Click the frame (report object) and select False from the Auto Execute drop-down list in
the Properties tab of the Properties window.

Note: False is the default Auto Execute option for reports with parameters.

3. Right-click the frame (report object) in the Design view and select Style from the context
menu.

The Style Composer opens.

4. Select Layout from the left side of the Style Composer to view the layout options for the
selected frame.
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5. From the Flow control area, select Do not display from the Display drop-down list.

This option hides the frame at run time until the values are selected.

6. Click OK to close the Style Composer.

7. Run the HTML page.
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In the example below, the frame is not shown before the values are selected.

In the same example below, parameter values have been selected and the frame appears
showing the output results.
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Frame Properties in the Properties WindowReference:

When a frame is selected, the Properties tab in the Properties window contains options that
control the properties of frames.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Line to the Layout

How to:

Add a Line to the Layout

Reference:

Line Properties in the Properties Window

You can add a horizontal or vertical line to the layout. This is useful for distinguishing between
sections of your launch or display page.

How to Add a Line to the LayoutProcedure:

1. Do one of the following to add a line:

Click the Line button.

or

From the Insert menu, select Components, then click Line.

The cursor changes into a crosshair.

2. Click and drag the crosshair to create a horizontal or vertical line.

A line is created in the layout.

3. Optionally, change the line properties by adjusting the properties displayed in the
Properties tab of the Properties window. For details, see Line Properties in the Properties
Window on page 29.
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Line Properties in the Properties WindowReference:

When a line is selected, the Properties tab in the Properties window contains options that
control the properties of lines.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding an Image to the Layout

How to:

Add an Image to a Layout

Reference:

Image Properties in the Properties Window

You can add an image to the layout. This is useful for including graphics, such as a company
logo.

You can insert an image into your report layout and add a hyperlink to it. After you run your
report and click the image you can launch a URL or run a report the same way you can by
clicking a hyperlink or push button. For more information, see How to Add a Hyperlink to a
Push Button or an Image on page 43.

Note: When inserting images, images must be referenced from a specific directory location.
Links to images are not supported.

How to Add an Image to a LayoutProcedure:

1. Do one of the following to add an image:

Click the Image button from the Components toolbar.

or

From the Insert menu, select Components, then click Image.

The cursor changes into a crosshair.

2. Click and drag the crosshair to create the image object and adjust it to the size you
want.

The Get source file dialog box opens.

3. Navigate to the directory where the image is located using the Look in drop-down list,
then select the image you want to add to the layout.

Note:

You may also specify a fully-qualified URL or a relative URL that points to an image
file by entering it in the File name area. A fully-qualified URL must start with http://
or https://. A relative URL must start with a known context root that DB2 Web Query
uses, such as /approot/appname/imagename.png.

You can multiselect image files from the Get source files dialog box. The files will
be cascaded on the canvas and can then be moved as required.
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4. Click Open.

5. Optionally, change the properties of the image by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see Image Properties in the
Properties Window on page 32.

Note: You can always return an image to its original size by right-clicking the image and
selecting Restore size from the context menu.

Images will retain their aspect ratio if they are resized by pressing and dragging their
corner borders.
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Image Properties in the Properties WindowReference:

When an image is selected, the Properties tab in the Properties window contains options
that control the properties of selected images.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding Text to the Layout

How to:

Add Text to a Layout

Format Text in the Layout

Insert a Bulleted or Numbered List Into a Text Element

Insert Nested Lists Into a Text Element

Reference:

Text Properties in the Properties Window

You can add text to the layout. This is useful for including headings in your webpage, or
adding directions or an explanation for your report or graph.

How to Add Text to a LayoutProcedure:

1. Insert text to the layout by doing one of the following:

Click the Text button from the Components toolbar.

or

From the Insert menu, select Components, then click Text.

The cursor changes into a crosshair.

2. Drag the crosshair to create the text object and adjust it to the size you want.

A text object is created in the layout and assigned the name textn, where n is a number.

3. Replace the text with the text you want to appear in the layout.

4. Optionally, change the text properties by adjusting the properties displayed in the
Properties tab of the Properties window. For details, see Text Properties in the Properties
Window on page 38.
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How to Format Text in the LayoutProcedure:

You may apply various formatting and style options to words and individual text characters
within the text element. The formatting options are available from the Formatting toolbar in
HTML Composer.

Note: Any formatting and styling that you may have applied to individual text strings within
the text element will remain unchanged. Changes made to the entire text element are only
applied to part of the text string that has not been formatted.

1. Insert a text element into the layout and type text in the text element.

2. Select the text that you wish to format.

To format the entire text element, single-click the text object in the layout.

To format an individual word or text character, highlight part of the text within the
text element.

The Formatting toolbar is activated.

Note: The Bold, Italic, Underline, Superscript, and Font Style options are available when
formatting individual words or text characters. The Font Style and Alignment options are
available when the entire text element is selected.

3. Select from the formatting options available from the Formatting toolbar.

4. Select Font Style from the Formatting toolbar to open the Font dialog box, from which
you can change the type, style, color, size, and effect of the font.

Tip: You may also access the Font Style dialog box from the Font ellipsis button of the
Styling Font field in the Properties window.

5. Click OK to close the Font dialog box.

The format options are applied to the text selected.
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How to Insert a Bulleted or Numbered List Into a Text ElementProcedure:

To insert a bulleted or numbered list into a text element:

1. Insert a text element into the layout and enter text on different lines, as shown in the
following image.

2. Highlight and right-click the text.

The right-click context menu opens.

3. Select Bullets and then either Disc, Circle, or Square if you want a bulleted list. Select
Numbering and then either Numbers, Lowercase Letters, Uppercase Letters, Small Roman
numerals, or Large Roman numerals if you want a numbered list. Both options are shown
in the following image.
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For example, the following image shows each item of text on a different line with a bullet
next to it.

Note:

Alternatively, you can select a bullet type before typing text to begin the list. Pressing
Enter will begin the next item in the list on a separate line.

To change the bullet or number list type of an existing list, place your cursor on the
list level you want to change and reselect a bullet or number list type. Selecting None
will remove the bullets or numbers for that level and move any nested lists up one
level. In order to switch between bullets and numbers, you must first remove the
current list option by selecting None and then applying the list option you want.

How to Insert Nested Lists Into a Text ElementProcedure:

To insert a nested list into the text element:

1. Insert a text element into the layout and create a list, as shown in the following image.

2. Place your cursor after a list item.

3. Right-click and select Nested List and then select a bulleted or numbered list option.
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A list is started within the current list, allowing you to enter text on that list level, as
shown in the following image.

Note: Pressing Tab while your cursor is on the same line as a list item will move that
item one level down, resulting in a nested list. The bullet or number type selected is the
next list type in the right-click context menu. For example, if you have a bulleted list that
uses the disc bullet type, pressing Tab to move an item down one level will cause that
nested list to have a circle bullet type.

You can continue to nest lists within other lists by using the same steps shown above.

Note: You cannot skip a list level. For example, in order to insert a nested bulleted list
or nested numbered list on a lower level, there must be a list one level up from it.

IBM DB2 Web Query for IBM i 37

1. Using the HTML Composer



Text Properties in the Properties WindowReference:

When text is selected, the Properties tab in the Properties window contains options that
control the properties of the text component.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Hyperlink to the Layout

How to:

Create a Hyperlink

Add a Hyperlink to a Push Button or an Image

You can create a hyperlink for your HTML page. A hyperlink can execute a report, link to a
URL, or open an HTML page. You can create a hyperlink in two ways:

Insert a hyperlink. For details, see How to Create a Hyperlink on page 41.

Add a hyperlink to a push button or image. For details, see How to Add a Hyperlink
to a Push Button or an Image on page 43.

The following is an image of the Hyperlink Properties dialog box.

Action

The URL action will create a hyperlink that brings you to a webpage. This action will allow
you to enter a URL in the Source section.

The HTML File action will create a hyperlink that will bring you to an HTML Composer
page. You will be able to select the HTML file to link to from the Source section.

The URL File action will create a hyperlink that will invoke a Managed Reporting .url file.
You will be able to select the .url file to link to from the Source section. This action is
only available if you are creating an HTML page hyperlink in the Repository area.
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The Embedded Procedure action will link to a procedure that is already embedded in the
page. The Source section will allow you to choose from the procedures already linked
to the current page.

The Schedule action enables you to schedule a report or graph using Report Broker. For
more information on using scheduling, see Adding Report Broker Schedule Capability to
HTML Composer on page 265.

The External Procedure action will link to a procedure that is not embedded in the page.
You must navigate to and specify the procedure from the Source section.

The Visual Discovery Exclude action is only available when a Visual Discovery control is
used on the page. From the Source section, you will be able to choose a datapool already
located on the page. This action will cause the currently Visual Discovery data to remain,
while hiding the unselected data.

The Visual Discovery Restore action is only available when a Visual Discovery control is
used on the page. From the Source section, you will be able to choose a datapool already
located on the page. This action will cause hidden Visual Discovery data to be shown
on the Visual Discovery control.

The Refresh Active Reports action is only available when an Active Report is on the page.
This action will refresh all active reports currently on the page.

Source

The source of where the hyperlink directs to. For URL actions, this is a hyperlink. For
HTML actions, you will need to navigate to the HTML file you are directing to. For the
Embedded Procedure action, this would be a selection from a list of available procedures.
For the External Procedure action, you would have to navigate to the procedure you are
directing to.

Target Type

The Window Target Type will execute the action in a new window.

The Frame Target Type will execute the action in a selected frame.

The Deferred Target Type will run the report deferred.

The InfoWindow Target Type will execute the action in the Web Query generated
InfoWindow.

Target/Template Name

The Target/Template Name contains a list of targets in which the action can be executed
from. These targets can be controls, frames, windows, or distribution methods when
the Action is set to Schedule. These options can be different for specific actions.
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Note: If the distribution method is a combination (for example, email, report library, and
FTP) then, at run-time, you will be presented with an intermediate dialog requesting you
to choose a single distribution method.

Size (Width/Height)

Allows for customization of the InfoWindow dimensions. This option will replace
Target/Template Name when using InfoWindow as the Target Type.

When a parameter is added to the HTML page, the Additional parameters button becomes
available at the bottom of the Hyperlink Properties dialog box, as shown in the following
image.

The Additional parameters button lets you pass the selected parameter in the hyperlink
being defined. Clicking the green OK button selects the parameter. Clicking the red Cancel
button closes the parameter drop-down list.

How to Create a HyperlinkProcedure:

1. Do one of the following to create a hyperlink:

Click the Hyperlink button from the Components toolbar.

or

From the Insert menu, select Components, then click Hyperlink.

The cursor changes into a crosshair.

2. Drag the crosshair to create a hyperlink object and adjust it to the size you want.
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The Hyperlink Properties dialog box opens.

3. Enter the text you want to display as the hyperlink in the Display Text field.

4. Set the action of the hyperlink:

To link to a URL, select URL in the Action section, and enter the URL in the Source
field.

To open an HTML page, click select HTML in the Action section, and enter the HTML
page in the Source field.

To execute an embedded procedure, select Embedded procedure and enter the
procedure name in the Source field, or click the browse (...) button to browse to the
procedure.

To execute an external procedure, select External procedure and enter the procedure
name in the Source field, or click the browse (...) button to browse to the procedure.

To refresh or repopulate active reports based on selected values in active controls,
select Refresh active reports and specify the source or which active report(s) should
be refreshed.

For more information about active controls, see Creating Active Dashboards With the
HTML Composer.

5. Optionally, direct the output to a specific location by selecting Window or Frame in the
Target Type field.

6. Specify a name for the target window or frame by selecting one of the default values
from the Target/Template Name drop-down list or by typing the name of a new or existing
window or frame in the Target/Template Name field.
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7. Click OK.

Note: If linking hyperlink properties to another page or procedure, HTML Composer
parses the other file for unresolved parameters and opens the New Parameters dialog
box.

8. Execute the request and click the hyperlink to launch the source you entered in the
Hyperlink Properties dialog box.

Note: If your hyperlink target type is an InfoWindow, you can move the InfoWindow by
clicking the title bar and dragging it. You can move the InfoWindow regardless of if it is
pinned or unpinned.

How to Add a Hyperlink to a Push Button or an ImageProcedure:

To add a hyperlink to a push button or image, complete the following steps.

1. Insert a push button or image from the Components toolbar and add it to the layout.

2. Right-click the push button or image, and select Create hyperlink. The Hyperlink Properties
dialog box opens.

3. Click the New button to generate a new request and select URL from the Action drop-down
list.

4. Type a URL in the Source field.

5. Optionally, in the Target Type field, direct the output to a specific location by selecting
Window or Frame from the drop-down list.

6. In the Target/Template Name field, specify a target window or frame by selecting one
of the default values from the drop-down list or by typing the name of a new or existing
window or frame.

7. Click OK.

Note: If linking hyperlink properties to another page or procedure, HTML Composer
parses the other file for unresolved parameters and opens the New Parameters dialog
box.

8. Execute the request and click the push button, or image, to launch the source you
entered in the Hyperlink Properties dialog box.
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Adding a Group Box to the Layout

How to:

Add a Group Box

Reference:

Group Box Properties in the Properties Window

A group box can be used to create a border around a group of objects, for example, forms
or reports and graphs.

How to Add a Group BoxProcedure:

1. Insert a group box by doing one of the following:

Click the Group box button from the Components toolbar.

or

From the Insert menu, select Controls, then click Group Box.

The cursor changes into a crosshair.

2. Drag the crosshair to create a group box and adjust it to the size you want.

A group box is created in the layout and assigned the name groupbox(n), where n is a
number.

3. Optionally, you may change the default name of the group box and format the text, as
shown in the image below.

For more information about formatting text, see How to Format Text in the Layout on
page 34.

4. Optionally, change the group box properties by adjusting the properties displayed in the
Properties tab of the Properties window. For details, see Group Box Properties in the
Properties Window on page 45.
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Group Box Properties in the Properties WindowReference:

When a group box is selected, the Properties tab in the Properties window contains options
that control the properties of group boxes.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Push Button to the Layout

How to:

Create a Push Button in Place of a Submit Button

Run Multiple Reports With One Submit Button

Reference:

Push Button Properties in the Properties Window

You can add a push button to the layout. A push button enables you to execute a report, or
link to a URL or HTML file. This behavior is similar to a hyperlink.

How to Create a Push Button in Place of a Submit ButtonProcedure:

1. If the submit button is deleted from the layout, a push button can be used to replace
the button. Insert a push button by doing one of the following:

Click the Push Button from the Components toolbar.

or

From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.

2. Drag the crosshair to create a push button and adjust it to the size you want.

A push button is created in the layout and assigned the name button(n), where n is a
number.

3. Assign an action to the push button by using the Hyperlink Properties dialog box.
Right-click the push button and select Hyperlink properties from the context menu.

The Hyperlink Properties dialog box opens. Use the Hyperlink Properties dialog box to
assign a target and action to the push button.

4. Click OK to close the Hyperlink Properties dialog box.

5. Run the HTML page.

6. Click the push button to submit your request.

How to Run Multiple Reports With One Submit ButtonProcedure:

The submit button on a control enables you to submit your request after selecting parameter
values at run time. You may run multiple reports with one submit button.
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Note: A push button can also be used in place of a submit button.

1. Right-click the submit button or the frame for the whole control, and select Hyperlink
properties from the context menu.

The following image is an example of the submit button selected.
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The following image is an example of the whole control selected.

The Hyperlink Properties dialog box opens.
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2. Click the New button and use the drop-down lists to add the second report request to
be executed with the submit button.

Repeat these steps for multiple procedures.
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Push Button Properties in the Properties WindowReference:

When a push button is selected, the Properties tab in the Properties window contains options
that control the properties of your buttons.

Click a property to display a description of the selected property at the bottom of the
Properties window.

50 IBM

Creating a Report Page Layout



Adding a Reset Button to the Layout

How to:

Create a Reset Button

Reference:

Reset Button Properties in the Properties Window

You can add a reset button to the layout. A reset button enables you to reset the entire page
back to its initial settings.

How to Create a Reset ButtonProcedure:

1. If the reset button is deleted from the layout, you may create a new reset button. Insert
a reset button by doing one of the following:

Click the Reset button from the Components toolbar.

or

From the Insert menu, select Controls, then click Reset Button.

The cursor changes into a crosshair.

2. Drag the crosshair to create a reset button and adjust it to the size you want.

A reset button is created in the layout and assigned the name reset(n), where n is a
number.

3. Run the HTML page.

4. When selecting criteria to submit a report, click the reset button to reset the entire page
back to its initial settings.
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Reset Button Properties in the Properties WindowReference:

When a Reset button is selected, the Properties tab in the Properties window contains
options that control the properties of your buttons.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Tab Control to the Layout

How to:

Create a Tab Control

Enable Full Screen Mode for the Tab Control

Add Additional Tabs

Modify and Style the Tabs

Modify the Size, Appearance, and Location of the Tabs

Use the Tab Item Background Properties Field

Add Background Images to Tabs

Associate Components to the Tab Body

Reference:

Tab Control Properties in the Properties Window

You can add a tab control to the layout. Tab controls enable you to create multiple pages
in one HTML form and present a better display for viewing secondary information.

When a tab control object is added to the layout, each tab control consists of:

A tab item.

A tab item is the tab label. You may edit the name of the tab item, style the tab item,
and add multiple tab items. Each tab item is associated with a tab body.

A tab body.

A tab body is the tab page where you associate your components, such as report and
graph objects, images, and lines.

The Tab control can be displayed as a full screen or part of an HTML page.
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In the example below, the selected tab shows a report and a second tab that contains a
graph.

How to Create a Tab ControlProcedure:

1. Insert a tab control to the layout by doing one of the following:

Click the Tab control button from the Components toolbar.

or

From the Insert menu, select Components, then click Tab Control.

The cursor changes into a crosshair.

2. Drag the crosshair to create a tab control object and adjust it to the size you want.

Tip: You should make the object large enough to associate report/graph components
within the tab control.

A tab control object is created in the layout and assigned the Properties name tab(n),
where n is a number of the tab. By default, the tab control has one tab page. Each tab
page consists of a tab item (tabitem(n)) and tab body (tabitembody(n)).

3. Optionally, change the properties of the tab control by adjusting the properties displayed
in the Properties tab of the Properties window.

How to Enable Full Screen Mode for the Tab ControlProcedure:

You may resize the tab control to fit the full screen of your layout, making the tab control
the full background of your browser window at run time. When set to full screen mode, scroll
bars will not be applied to the output window. Therefore, you may have to adjust the tab
control (and any items on the tab) in the layout to ensure that they appear appropriately for
display at run time.
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Note: It is recommended you set the tab control to full screen mode at the beginning of the
development process. If there are existing components on the layout that are not part of
the tab control, these components will become inaccessible if the tab control is changed to
full screen mode.

1. From the Insert menu, select Components, then click Tab Control.

The cursor changes into a crosshair.

2. Drag the crosshair in the layout to create the tab control object.

3. Right-click the tab control and select Full screen mode from the context menu, as shown
in the image below.
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The tab control displays as a full screen in the layout, as shown in the image below.

Note: This setting can be applied only to one tab control in your application. If one tab
control is set to full screen mode, the full screen mode item will be greyed out for any
additional tab controls.

4. To resize the tab control, right-click and uncheck the Full screen mode option, as shown
in the image below.
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How to Add Additional TabsProcedure:

1. Select the tab control object in the layout.

2. Right-click and select Add tab item from the context menu.

A tab is added to the tab control object.

3. To align multiple tab items, select the tab control object and click AutoArrange from the
context menu,
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The tab items are resized to the size of the widest tab item and evenly spaced.
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Tab Control Properties in the Properties WindowReference:

When a tab control is selected, the Properties tab in the Properties window contains options
that control the properties of your tabs.

Note: You may set options for the tab control, individual tab items, and the tab body.

Click a property to display a description of the selected property at the bottom of the
Properties window.

How to Modify and Style the TabsProcedure:

You may modify and style the tab item(s) and tab body properties.
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1. Use the Formatting toolbar to format the text in the tab item.

2. Click the tab item/tab body and use the right-click context menu to edit the text (if
applicable), Font Style, Style, and Properties.

How to Modify the Size, Appearance, and Location of the TabsProcedure:

When the tab control is selected, you may change the default size of the tab labels, the
appearance of the tabs, and the location of the tab items on the tab control.

These properties are available from the Properties tab of the Properties window when the
tab control is selected. The tab control appears as tab(n) in the Properties window drop-down
list.

1. To change the default size of the tab labels, adjust the Tab: default distance, Tab: default
height, and Tab: default width properties.

2. To change the appearance of the tabs, select Straight or Round from the Tab: edges
properties field.

The default tab edge is Straight.
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3. To change the location of the tab items on the tab control, select Top, Bottom, Left, or
Right from the Tab: location properties field.

The default tab location is Top.

Note: If the tab location changes, any background images applied to the tabs will not
be rotated. You will have to reinsert a different image that is rotated appropriately.

How to Use the Tab Item Background Properties FieldProcedure:

In addition to using the Style Composer, you can add background images to tab items by
using the Background properties field.

The Background properties field is available from the Properties tab of the Properties window
when the tab item is selected. The tab item appears as tabitem(n) in the Properties window
drop-down list.

1. Select the tab item in the layout, or click the tabitem(n) property from the Properties
window drop-down list.

2. Click the Background ellipsis button from the tab item properties window.

The Get source file dialog box opens, as shown in the image below.

3. Select a File name and click Open.

The background image is added to the tab item.

You may have to manually resize the tab item to fit the image.
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Note: If the tab location is changed (from Top to Left for example), any background
images applied to the tabs will not be rotated. You will have to reinsert a different image
that is rotated appropriately.

How to Add Background Images to TabsProcedure:

You may add background images to a tab item or tab body using the Style Composer. For
example, you may add a small icon with text to a tab item or your company logo as the
background image for a tab body.

Note: Background images can also be applied to tab items by using the Background
properties setting. For more information, see How to Use the Tab Item Background Properties
Field on page 61.

1. Select Style from the right-click context menu of the tab item/tab body.

The Style Composer dialog box appears.

2. Select Background to show the Background image options.

3. Select a source file in the Image field and adjust the Tiling, Scrolling, and Position
options.

Tip: If you are adding an icon to a tab item, select a small image and do not tile the
image.

4. If you are using text in addition to a background image for a tab item, select Text from
the Style Composer to view and change the Alignment options.
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5. Click OK to close the Style Composer.

The background image is added to the tab item/tab body.

How to Associate Components to the Tab BodyProcedure:

You may associate any component from the Insert menu (such as an image or line) to the
tab body. This procedure details how to add a report or graph object component to the tab
body.

1. To add a new report or graph object to the tab body:

Select New Report or New Graph from the Insert menu.

The cursor changes into a crosshair.

In the tab control body, drag the crosshair to create the report or graph object and
adjust it to the size you want.

Open, import, or reference a report or graph procedure.

2. To associate an existing component in the layout to a tab body:

Select the component in the layout.

Press the Alt key and drag the component into the tab body.

The component is associated to the tab body.

Adding a Label to the Layout

How to:

Add a Label

Reference:

Label Properties in the Properties Window

You can add a label to the layout. A label is simply a piece of text. The label component
enables you to create and name a label. You can also link it to a control by assigning the
label HTML for property the same value as the Unique Identifier property for the control.

How to Add a LabelProcedure:

1. Insert a label to the layout by doing one of the following:

Click the Insert Label button from the Components toolbar.
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or

From the Insert menu, select Components, then click Label.

The cursor changes into a crosshair.

2. Drag the crosshair to create the label and adjust it to the size you want.

A label is created in the layout and assigned the name labeln, where n is a number.

3. Replace the label text with the text you want to appear in the layout.

4. Assign the label to an existing control in the layout by assigning the label properties:

Select the label in the layout.

Select the HTMLfor property field in the Properties tab of the Properties window.

Type in the Unique Identifier property name for the control you want to link the label
to.

For example, suppose you have a drop-down list in your layout. The default Unique
Identifier property name assigned to the drop-down list object is combobox1. Enter
combobox1 in the HTMLfor property field to link the label to the drop-down list in your
layout.

Optionally, change the label properties by adjusting the properties displayed in the
Properties tab of the Properties window. For details, see Label Properties in the
Properties Window on page 65.
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Label Properties in the Properties WindowReference:

When label is selected, the Properties tab in the Properties window contains options that
control the properties of the label in your layout. New pages will show labels as <LABEL>
tags in the Properties window.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Working With the Properties Window

How to:

Dock the Properties Window

The Properties window is a dockable window that consists of several tabs and components.

A Properties tab consists of the following components:

A hierarchical drop-down list of objects that are currently in the layout. For the selected
object, there are additional subtabs on the Properties tab.
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A Properties subtab that lists attributes for the selected object. The attributes appear
on the left. Click in the right column to set the properties for the attribute.

The Properties subtab options are accessible in the Design view of HTML Composer.

An Events subtab lists all JavaScript events that can be assigned an action for an
object.

Note:

To code a JavaScript event for an object, select a JavaScript event and click the
ellipsis button in the Events subtab. HTML Composer adds the event to the HTML
code and switches from Design to HTML view. In the HTML view, you are prompted
to define the event. Add the appropriate JavaScript code.

When copying a control that has event handlers, the copied control inherits the
original controls event handlers. You must manually change the copied controls
event handlers in the event tab. You can then create the JavaScript for those event
handlers.
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The following image is an example of the HTML code that appears when a JavaScript
event is selected from the Events subtab in HTML Composer.

A Thumbnails tab enables you to view a thumbnail of the page layout. Thumbnail view
allows objects on the page to participate in actions with controls on the Parameters tab.
You may also refresh the Thumbnails tab, enlarge or reduce the thumbnails, and change
the zoom levels. Reports and graphs appear as placeholder objects on the Thumbnails
tab.

How to Dock the Properties WindowProcedure:

For layout purposes, you may want to dock or reposition the Properties window. You can
dock the Properties window on all four sides of HTML Composer. When you choose to dock
the Properties window on the top or bottom, the columns are split in half.

1. Click the Properties title bar on the Properties window.
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The Properties window appears as shown in the following image when you double-click
the title bar.

2. Drag the Properties window to the side of the screen that you prefer, or it can float in
the middle of the screen.

3. Release the mouse when the Properties window is on the side of the screen that you
prefer.

If you dock the Properties window on the bottom of the screen, it will appear as shown
in the following image.
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To undock the Properties window, click the Properties title bar, then move the window
to the desired location in the layout.

Layering Objects
You can layer objects that are added to the page layout by using the object right-click menu,
as shown in the following image.

The options are:

Bring to front. Moves an object to the front so that it is stacked on top of every other
object it overlaps.

Send to back. Moves an object to the back so that it is stacked below every other object
it overlaps.

Move forward. Moves an object forward one position in the stacking z-order.

Move backward. Moves an object backwards one position in the stacking z-order.

When using any of these commands, the stacking order of the object will change. This is
reflected in the z-index property in the Properties window. The z-index is the stacking order
of a specific object.
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Working With the Events Subtab
The Events subtab displays a list of all available JavaScript events that can be used in
conjunction with an object. The events that are available change depending on what type of
object is selected. For example, a report object has different events available than a button
object. When no object is selected, events for the HTML page are displayed.

Double-clicking on an event will create a function block for the selected object, using that
event. You can view the created functions in the Embedded JavaScript tab, where you can
type the JavaScript code to execute when the selected event occurs.

The following is a list of events that are available from the Event subtab and the
circumstances in which the JavaScript code is called.

CircumstanceEvent

Page is loaded.Load

Page is unloaded.UnLoad

Object or page is clicked.Click

Object or page is double-clicked.Double Click

Mouse pointer is moved down.Mouse Down

Mouse pointer is moved up.Mouse Up

Mouse pointer is moved over an object.Mouse Over

Mouse pointer is moved.Mouse Move

Mouse pointer is moved away from an object.Mouse Out

Key is pressed and released.Key Pressed

Key is pressed.Key Down

Key is released.Key Up

Object is the current focus.Focus

Object is not the current focus.Blur

Before a control is populated.Before Load

After a control is populated.After Load
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CircumstanceEvent

Value within the control is selected.Value Selected

Value within the control is changed.Value Changed

Creating and Using Parameters in HTML Composer

In this section:

Creating Parameter Values

Using Controls to Supply Incoming Parameter Values

Using Input Controls to Supply Parameter Values

Supplying Parameter Values to External Reports

Styling Your Layout

Specifying Browser Defaults With the Style Composer

Laying Out Objects With HTML Composer

Controlling the HTML Composer Environment

Adding Report Broker Schedule Capability to HTML Composer

Using JavaScript Code With HTML Composer Pages

Specifying an HTML File as a Load Screen

You may create an unbound parameter, an incoming parameter (a parameter that is bound
to a control), a control that is bound to a parameter, or an unbound control.

72 IBM

Creating and Using Parameters in HTML Composer



Creating Parameter Values

In this section:

Working With the Parameters Tab

Adding a New Unbound Parameter

Creating a Static List of Values

Creating a Dynamic List of Values

Automatically Populating Fields With Dynamic Values

Parameter Value List Options

Parameter values and input controls can be created with a dynamic or static list of values:

A dynamic list retrieves values from a specified data source when the request is run.

A static list consists of a list of values you supply. These values do not change unless
you change them.

An active control lists active report values that mimic active report menu items.

Note: The active controls cannot be associated to any parameters in the layout. This
type of control can only be associated with an active report in the layout.

Working With the Parameters Tab
The Parameters tab enables you to create and modify parameter values, input controls, and
customize parameter conditions. You may also bind parameters to controls and chain controls
to one another. The Parameters tab consists of the following components:

Input control objects. You may select the input control object to view and edit the
Properties and settings of the control.

Creating an input control from the Design view prompts you to create a bound
parameter on the Parameters tab. For details, see Using Input Controls to Supply
Parameter Values on page 133.

Editing an input control, which is inserted when setting input controls for new
parameters. For details, see Automatically Creating Controls From the New Parameters
Dialog Box on page 125.

Add new parameters. Right-click anywhere on the Parameters tab to add a new
parameter.

Note: Manually adding a parameter creates an unbound parameter. For details about
adding new parameters, see Adding a New Unbound Parameter on page 74.
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Refresh unresolved parameters. All parameters on the parameters tab are parsed
every two minutes to check if any are unresolved. If there are, their surrounding polygon
is colored red. If you want to check for unresolved parameters on demand, right-click
and select Refresh unresolved.

Binding controls and parameters. Input controls and parameters can be bound and
unbound from the Parameters tab.

You may bind a parameter to an input control, or bind an input control to a parameter.

Binding a parameter to a control makes it an incoming parameter that will populate
the control. Drag a parameter object to a control object on the Parameters tab.

Binding a control to a parameter will populate the parameter. Drag a control object
to a parameter object on the Parameters tab.

Chain one control to another. Chaining will populate controls based on the selected
value from the prior control in the chain. You can chain static and dynamic controls, link
or unlink parts of a chain, and create conditions on links in a chain. Chains are
represented by lines connecting control objects on the Parameters tab. By clicking the
arrow head in a link of a chain, the Properties and settings dialog box enables you to
modify and set properties and conditions of the chain.

Note: Chaining is applicable only for controls, not parameters. For details about chaining,
see Chaining Controls for Dependencies.

Adding a New Unbound Parameter

How to:

Add a New Unbound Parameter

An unbound parameter is useful when passing a parameter value used on another page.
You may also bind the new parameter to a control to create an incoming parameter, or bind
a control to the parameter.

How to Add a New Unbound ParameterProcedure:

The following steps describe how to add a new parameter:
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1. Right-click anywhere on the Parameters tab and select Add parameter.

Enter the parameter value information. Options are Single select, Multiselect OR, and
Multiselect AND.

2. If using a single value, select Single select.

Note: Single select is the default option when adding a new parameter.

a. Enter the Selected Value to be assigned to a single variable.

b. Enter the name for the parameter in the Name field, or keep the default name.

c. Optionally, you may use the Format field to define the format of the parameter, such
as A20, or D12.2.

If this field is left blank, it automatically applies the Alphanumeric format to the
value field.

3. If using a multiselect value, select Multiselect OR or Multiselect AND.

The Value, Display, and Selected columns appear.
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a. Click the New button to enter a list of static values.

b. In the Value column, enter the value to be passed to the selected parameter.

c. In the Display column, enter the text that represents the parameter value in the
control the user views.

d. In the Selected column, check the box for the value you want to be selected by
default. More than one value can be selected.

Note: If opening HTML Composer with an existing page from a previous release and
the tool cannot resolve the Value and Display fields, XML index values appear for
the fields instead. Unresolved Value and Display fields occur as a result of -INCLUDE,
or amper variables, that may exist in an existing procedure.

Repeat these steps until the list contains all of the values you want to include.

4. Optionally, you may select values and click the Delete button to eliminate any values,
and use the up and down arrows to rearrange the order of the values.

5. Close the Properties and settings dialog box to create an unbound parameter.
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6. To modify the parameter value, right-click the parameter on the Parameters tab and
select Properties and settings to make your edits.

Tip: You may also use the Undo and Redo buttons located on the Standard toolbar.
Note that the undo/redo buttons treat the entire Properties and settings dialog as one
action.

7. Optionally, bind a control to a parameter to populate the parameter. Select the center
of the parameter name object, left-click and drag the parameter to the center of the
control object, and release the mouse to complete the binding.

8. Optionally, bind the new parameter to a control to create an incoming parameter. Select
the center of the control object, left-click and drag the control to the center of the
parameter object, and release the mouse to complete the binding.

For details about creating an input controls, see Using Input Controls to Supply Parameter
Values on page 133.

Creating a Static List of Values

How to:

Add a New Static Value

Add an Ignore Value

Add an Everything Value

Use Values From a Procedure

Import Values From an External File

Reference:

Properties and Settings (Incoming Static Parameter and Unbound Control)

Properties and Settings Dialog Box (Unbound Parameter)

Properties and Settings Dialog Box (Bound Parameter)

When creating a list of static values, you can select from the following options:

Add new value

Add ignore value

Add everything value

Use values from procedure

Use values from external file
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When the options are added to the Value list, the display text can be customized, but the
value cannot be changed.

You may create an unbound static parameter, an incoming static parameter (a parameter
that is bound to a control), or a control that is bound to a static parameter. For details, see
How to Add a New Static Value on page 82.

Properties and Settings (Incoming Static Parameter and Unbound Control)Reference:

The Properties and settings dialog box appears when creating or editing a static value on
the Parameters tab.

The options available depend on the type of static value.

The following image is the Properties and settings dialog box that appears for an incoming
static parameter (a parameter that is bound to a control), and an unbound control (a control
that is not bound to a parameter).
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The Properties and settings dialog box contains the following fields and options when Static
is selected as the Data type.

Data type

Determines whether values are obtained from a static or dynamic list, or an active report.

Static. Uses a static list of values you supply. A list of static values can also be created
in InfoAssist.

Static values

Is a list of supplied values for a static list.

Value. The value to be passed to the selected parameter.

Display. The text that represents the value in the control the user views. Press the Ctrl
+ Shift keys to add a value to the Display field.

Selected. The value to act as the default value. If the control is multi-select, more than
one value can be selected.

New. Creates a new value.

Delete. Deletes a supplied value from the list.

Move Up. Moves the selected value up in the list.

Move Down. Moves the selected value down in the list.

Send display value

Select this option to send the display value, rather than the actual data, to the parameter.
For more information, see How to Send the Display Value for Static and Dynamic Controls
on page 104.

The Send display value option appears when creating an incoming static parameter (a
parameter that is bound to a control), or an unbound control (a control that is not bound
to a parameter). It is not available when creating an unbound static parameter.

Values are procedures names

Select this option to have a control populated with procedure names, so that when a
value is selected, that procedure executes. The Value column is the procedure name
itself and cannot be edited. The Display column is editable.

For more information on how to use the Values are procedures names option, see How
to Use Procedure Names as Values on page 111.

Properties and Settings Dialog Box (Unbound Parameter)Reference:

The Properties and settings dialog box appears when creating or editing a static value on
the Parameters tab.
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The options available depend on the type of static value.

The following image is the Properties and settings dialog box that appears when adding a
new unbound parameter.

The Properties and settings dialog box contains the following fields and options when adding
an unbound parameter with Single select. Single select is the default option when adding a
new parameter.

Name

The default name assigned to the parameter. Optionally, you may enter a new name for
the parameter.

Format

The Format field defines the format of the parameter, such as A20, or D12.2.

This field is optional. If this field is left blank, it automatically applies the Alphanumeric
format to the value field.

Selected Value

Enter the selected value to be assigned to the parameter.
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The Properties and settings dialog box contains the following fields and options when adding
an unbound parameter with Multiselect OR or Multiselect AND, as shown in the image below.

Static values

Is a list of supplied values for a static list.

Value. The value to be passed to the selected parameter.

Display. The text that represents the value in the control the user views. Press the Ctrl
+ Shift keys to add a value to the Display field.

Selected. The value to act as the default value. If the control is multi-select, more than
one value can be selected.

New. Creates a new value.

Delete. Deletes a supplied value from the list.

Move Up. Moves the selected value up in the list.

Move Down. Moves the selected value down in the list.
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Properties and Settings Dialog Box (Bound Parameter)Reference:

The Properties and settings dialog box appears when selecting a bound parameter on the
Parameters tab.

The Properties and settings dialog box for a parameter is read-only and displays the values
for the bound control.

The following image is the Properties and settings dialog box that appears when selecting
a bound static parameter.

The Properties and settings dialog box contains the following read-only values:

Value

Shows the selected value for the static parameter data.

Display

Shows the static parameter display value.

How to Add a New Static ValueProcedure:

The steps below describe how to manually add a new static value.

You may create an unbound static parameter, an incoming static parameter (a parameter
that is bound to a control), or a control that is bound to a static parameter.

1. Create a new parameter.

a. Right-click anywhere on the Parameters tab and select Add parameter.

The Properties and settings dialog box opens.
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b. Enter the parameter value information. Options are Single select, Multiselect OR,
and Multiselect AND.

c. If using single value, select Single select.

Single select is the default option when adding a new parameter.

Enter the Selected Value to be assigned to a single variable.

Enter the name for the parameter in the Name field, or keep the default name.

Optionally, you may use the Format field to define the format of the parameter,
such as A20, or D12.2.

If this field is left blank, it automatically applies the Alphanumeric format to the
value field.

d. If using a multiselect value, select Multiselect OR or Multiselect AND.

The Value, Display, and Selected columns appear.
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Click the New button to enter a list of static values.

In the Value column, enter the value to be passed to the selected parameter.

In the Display column, enter the text that represents the parameter value in the
control the user views.

In the Selected column, check the box for the value you want to be selected by
default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

Optionally, you may select values and click the Delete button to eliminate any
values, and use the up and down arrows to rearrange the order of the values.

e. Close the Properties and settings dialog box to create an unbound parameter.

An unbound static parameter is useful when passing a parameter value used on another
page. You may also bind the new parameter to a control to create an incoming parameter,
or bind a control to the parameter.

2. Bind the new parameter to a control.

84 IBM

Creating and Using Parameters in HTML Composer



Binding a new parameter to a control creates an incoming parameter. An incoming
parameter is a static parameter that is bound to a control. The parameter value will
populate the control.

a. Select the Design tab and create an input control. For example, insert a list box or
a drop-down list.

b. Click the Parameters tab.

The Properties and settings dialog box appears for the control.

c. Close the Properties and settings dialog box.

Close this dialog since you are populating the control with the parameter value,
which has already been created in step 1.

d. Select the center of the parameter name object, left-click and drag the parameter
to the center of the control object, and release the mouse to complete the binding.

The following image is an example of an incoming parameter. Notice the direction
of the arrow.

e. To unbind the parameter, select the arrow head on the line, so that the line is bold,
right-click and select Break binding.

3. Create a control that is bound to a parameter.

Create a control with static values and bind the control to a parameter to populate the
parameter with the control values.

a. From the Design view of HTML Composer, select a control from the Controls
sub-menu of the Insert menu. For example, insert a list box or a drop-down list.
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The cursor changes into a crosshair.

b. Drag the crosshair to create the control and adjust it to the size you want.

c. Click the Parameters tab.

The Properties and settings dialog box appears for the control.

d. Select Static as the Data type.

Static is selected by default.

e. Create the parameter values for the control:

In the Value column, enter the value to be passed to the control.

In the Display column, enter the text that represents the static parameter value
in the control the user views.

In the Selected column, check the box for the value you want to be selected by
default. More than one value can be selected.

Repeat these steps until the list contains all of the values you want to include.

Optionally, you may select values and click the Delete button to eliminate any
values, and use the up and down arrows to rearrange the order of the values.

f. Close the Properties and settings dialog box to create the control with static values.
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g. Bind the new control to a parameter: Select the center of the control object, left-click
and drag the control to the center of the parameter object, and release the mouse
to complete the binding.

The image below is an example of a control that is bound to a parameter. Notice
the direction of the arrow.

h. To unbind the control, select the arrow head on the line, so that the line is bold,
right-click and select Break binding.

i. To change the default type of control, right-click the control object on the Parameters
tab or the Design tab and select Set Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button,
Text Area, Text box, Single source Tree control, and Multi source Tree control.

4. To modify the static value, right-click the control or parameter on the Parameters tab,
and select Properties and settings to make your edits.

How to Add an Ignore ValueProcedure:

The add ignore value option sends _FOC_NULL to the server at run time and is intended for
use with complex applications. The add ignore value option is available for Multiselect OR
and Multiselect AND static parameters.

1. From HTML Composer, use controls to supply parameter values for a report.

A report with parameters requires that you to select values (at run time) in order to
generate the output.

2. Click the Parameters tab.

The parameters associated with each control can be controlled with the Parameters tab.
The properties of a control can be controlled with the Properties tab.

3. Select a multiselect control object from the Parameters tab.

The Properties and settings dialog box opens.
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4. Select Add ignore value from the Static values drop-down list.

5. Optionally, select Send display value to send the display value, rather than the actual
data, for the parameter values in the report.

6. Close the Properties and settings dialog box.

7. Run the HTML page and select the Ignore All value to ignore the parameter values.

Note: Sending _FOC_NULL to a procedure will result in any clause of that procedure that
uses that variable to be ignored.

How to Add an Everything ValueProcedure:

The add everything value option uses JavaScript to send every value present in the parameter
list to the server at run time. The add everything value option is available for Multiselect OR
and Multiselect AND static parameters.

The add everything value option is not available for a Double List Control.

1. From HTML Composer, use controls to supply parameter values for a report.

2. Click the Parameters tab.

3. Select a multiselect control object from the Parameters tab.
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The Properties and settings dialog box opens.

4. Select Add everything value from the Static values drop-down list.

5. Optionally, select Send display value to send the display value, rather than the actual
data, for the parameter values in the report.

6. Close the Properties and settings dialog box.

7. Run the HTML page and click the Select All parameter value to view all the parameter
values.

How to Use Values From a ProcedureProcedure:

This is the default option which populates the static list with field names predefined in the
procedure. The use values from procedure option is available for Multiselect OR and
Multiselect AND static parameters.

1. From HTML Composer, use controls to supply parameter values for a report.

2. Click the Parameters tab.
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3. Select a multiselect control object from the Parameters tab.

The Properties and settings dialog box opens.

4. Select Use values from procedure from the Static values drop-down list.

The field names from the procedure appear in the Properties and settings dialog box.

5. Optionally, select Send display value to send the display value, rather than the actual
data, for the parameter values in the report.

6. Close the Properties and settings dialog box.

7. Run the HTML page and select the parameter values from the procedure.

How to Import Values From an External FileProcedure:

This option enables you to use a local external file to provide values for the parameter. The
import values from an external file option is available for Multiselect OR and Multiselect
AND static parameters.

1. From HTML Composer, use controls to supply parameter values for a report.

2. Click the Parameters tab.

3. Select a multiselect control object from the Parameters tab.

The Properties and settings dialog box opens.

4. Select Use values from external file from the Static values drop-down list.

The Open dialog box appears.

5. Select a text file from your local machine and click Open.

The external file can be a comma-delimited file with single values on each line, or two
values per line.

For example, in the following text file, BOS is the data value and Boston is the display
value.
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The imported values are loaded into the Static values area of the Parameters tab.

If there is only one value on the line in the text file, the value will populate both the data
value and the display values.

6. Run the HTML page to see the imported values for the selected parameter.
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Creating a Dynamic List of Values

How to:

Create a Dynamic Value

Sort the Dynamic List of Values

Check for Duplicate Values

Reference:

Properties and Settings Dialog Box (Dynamic Values)

Properties and Settings Dialog Box (Bound Parameter)

Dynamic values are available by default if a parameter used in the procedure is associated
with the selected control. A dynamic list retrieves values from a specified data source when
the request is run.

Properties and Settings Dialog Box (Dynamic Values)Reference:

The Properties and settings dialog box appears when creating or editing a dynamic parameter
on the Parameters tab.
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The following image is the Properties and settings dialog box with a Dynamic Data type.

The Properties and settings dialog box contains the following fields and options when Dynamic
is selected as the Data type:

Data type

Determines whether values are obtained from a static or dynamic list, or an active report.

Dynamic uses a list of values retrieved from a selected data source when the request
is executed. This is the default if you use an Accept clause in a Master File to create an
amper variable parameter within a procedure. For more information, see How to Create
a Dynamic Value on page 96.
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Embedded procedure

Is the data source from which the values will be retrieved.

External Procedure

Is the existing procedure that will be called.

You may modify the external procedure directly from the Properties and settings dialog
box on the Parameters tab. If you modify the request, you can save the external procedure
and overwrite the original request.

Value field

Is the data source field from which the values will be retrieved.

Display field

Is the text that represents the parameter value in the control the user views.

There should be a relationship between the Value field and the Display field. The Display
field is user-friendly text corresponding to the Value field.

Source Code for the procedure

When the Value field is selected for an Embedded procedure, or when an external
procedure is selected the corresponding source code appears.

Add "ALL" Option

Adds the option to select ALL data source values to the control. Alternate text can be
substituted for ALL using the text field to the right. For more information, see Parameter
Value List Options on page 103.

Add ‘No selection' option

Optimizes performance by populating a chain one control at a time, instead of all the
controls when the page initially loads. Selecting the Add ‘No selection’ option enables
you to populate controls when necessary.

Cache run time data

When adding dynamic parameters to the HTML page, input controls retrieve data through
procedures. Select this option to cache the run-time data for the selected input control.
This setting is off by default.

This setting overrides the Default caching option from the HTML Page tab, which is
located in the Developer Studio Options dialog box. For more information about the HTML
Page tab, see HTML Page Tab on page 259.
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Limit values returned

Indicates that a specific number of field values will be retrieved from the data source.
The specific number of fields is selected with the menu to the right.

Sort

Clicking Sort enables you to set the sort order for displaying values in dynamic list
controls. This option is useful when you want to sort each control independently of the
others.

By default, the request retrieves dynamic display values from the BY sort field in the
request. The results display values based on the value field.

Sort by

When Sort is enabled, you may sort the display value by the Value field or the Display
field selected from the Properties and settings dialog box. The default is Value field.

Sort order

When Sort is enabled, you may select the sort order as Ascending or Descending. The
default sort order is Ascending.

Send display value

Select this option to send the display value, rather than the actual data, to the parameter.
For more information, see How to Send the Display Value for Static and Dynamic Controls
on page 104.

Selected Value

Enter the value(s) to be selected as the default value whenever the procedure is run.
For more information, see How to Use Selected Values as the Default Value on page 115.

Check for duplicate values

When creating a dynamic list of values for a report, you may remove duplicate values
from input controls. For more information, see How to Check for Duplicate Values on
page 102.

Properties and Settings Dialog Box (Bound Parameter)Reference:

The Properties and settings dialog box appears when selecting a bound parameter on the
Parameters tab.

The Properties and settings dialog box for a parameter is read-only and displays the values
for the bound control.
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The following image is the Properties and settings dialog box that appears when selecting
a bound dynamic parameter.

The Properties and settings dialog box contains the following read-only values:

Datasource file

Shows the selected Master File for the parameter data source.

Value field

Shows the value field for the dynamic parameter data.

Display field

Shows the dynamic parameter display field.

Multiselect

Shows OR or AND, if there is a Multiselect OR or Multiselect AND dynamic parameter.

Selected Value

Shows the selected value, if there is one assigned to the variable.

How to Create a Dynamic ValueProcedure:

The steps below describe how to create a dynamic list of values.

You may need to create a dynamic control that is bound to a parameter. Creating a control
with dynamic values and binding the control to a parameter will populate the parameter with
the control values.
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1. From the Design view of HTML Composer, select a control from the Controls sub menu
of the Insert menu. For example, insert a list box or drop-down list.

The cursor changes into a crosshair.

2. Drag the crosshair to create the control and adjust it to the size you want.

3. Click the Parameters tab.

The Properties and settings dialog box opens.

4. Select Dynamic as the Data type.

The dynamic value options appear.

5. Create the dynamic values for the control.

a. If you are using an Embedded procedure to supply dynamic values, follow the steps
below.

Select Embedded procedure.
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Click the Embedded procedure ellipsis button.

The Get source file dialog box opens.

Select the Master File name and click Open.

Click the ellipsis button from the Value field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value field.

Tip: You may also use the Object Inspector icons to select a field and close the
Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a
value will select the value and close the dialog without using any button, and
pressing the Esc key will cancel the dialog without using any button.

The selected field is automatically added to the Display field and the source
code for the embedded procedure appears.
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Optionally, you may click the Display field ellipsis button to select a different
field name for the Display field.

b. If you are using an External Procedure to supply dynamic values, follow the steps
below.

Select External Procedure.

Click the External Procedure ellipsis button.

The Get source file dialog box opens.

Select the procedure (.fex) file name and click Open.

The parameter names from the procedure are automatically added to the Value
field and Display field, and the source code for the external procedure appears.
For details, see Automatically Populating Fields With Dynamic Values on page 103.

Optionally, you may click the Value field and Display field ellipsis button to select
a different field name.
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Tip: You may also use the Object Inspector icons to select a field and close the
Object Inspector. The green icon is OK, the red icon is Cancel, double-clicking a
value will select the value and close the dialog without using any button, and
pressing the Esc key will cancel the dialog without using any button.

Only the parameter names from the external procedure will be available for
selection.

6. Optionally, select the Add "ALL" option to add the select ALL data source values to the
control.

7. Optionally, select the Add 'No selection' option to optimize performance by populating a
chain one control at a time instead of all the controls when the page initially loads.

8. Optionally, select the Cache run time data option to cache the run time data for the
selected input control.

9. Optionally, select Limit values returned, and select or type the number of field values
you want to retrieve from the data source in the box to the right of this option.

10. Optionally, click the Sort option to enable and select the sort order options for displaying
values in dynamic list control.

11. Optionally, select the Check for duplicate values option to remove any duplicate value
entries from the input control at run time.

12. Close the Properties and settings dialog box to create the control with dynamic values.

13. Bind the new control to a parameter. Select the center of the control object, left-click
and drag the control to the center of the parameter object, and release the mouse to
complete the binding.

The following image is an example of a control that is bound to a parameter. Notice the
direction of the arrow.

14. To unbind the control, select the arrow head on the line, so that the line is bold, right-click
and select Break binding.
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15. To change the default type of control, right-click the control object on the Parameters
tab or the Design tab and select Set Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button,
Text Area, Text box, Single source Tree control, and Multi source Tree control.

16. To modify the dynamic value, right-click the control and select Properties and settings to
make your edits.

How to Sort the Dynamic List of ValuesProcedure:

This option is useful when you want to sort each control independently of the others.

Note: If sort options are not selected, the request retrieves dynamic display values from
the BY sort field in the request, and the results display values based on the value field. Sort
options are not selected by default.

1. Select a dynamic control from the Parameters tab.

The Properties and settings dialog box opens.

2. Select Sort to enable the sort options.

You may select the Sort by and Sort order options for the control.

The following image are the sort options that appear on the Properties and settings
dialog box of the Parameters tab, when a dynamic control is selected.

3. Select the Sort by options:

Sort by Value sorts the value by the field name from the Value field. This is the default
Sort by selection.

Sort by Display sorts the value by the field name from the Display field.

4. Select the Sort order options:

Sort order Ascending sorts the value from lowest to highest. This is the default Sort
order selection.

Sort order Descending sorts the value from highest to lowest.

5. Close the Properties and settings dialog box.
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Tip: You may repeat these steps and select sort options for each dynamic control on
the HTML page.

6. Run the HTML page to see the sort results.

How to Check for Duplicate ValuesProcedure:

When creating a dynamic list of values for a report, you may remove duplicate values from
input controls. This is useful if you are using your own procedure that does not use a
structured data source.

The Check for duplicate values option is turned off by default.

1. From HTML Composer, create an input control with a dynamic list of values.

2. Select the input control and click the Parameters tab.

The Properties and settings dialog box opens for the input control.

3. Select the Check for duplicate values check box.

The Check for duplicate values option is only available when creating a dynamic list of
values for an input control.

4. Close the Properties and settings dialog box to save your selection.

5. Save and run the HTML page.

The input control removes duplicate value entries.

The following example shows a list box with a list of city values.
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Automatically Populating Fields With Dynamic Values
When the name of a dynamic parameter matches a corresponding field name in a data
source, HTML Composer automatically populates the field name values for the parameter.

The data source is populated by a default based on the first data source used in the report
or graph. The data source field is populated for the Value and Display fields in the Properties
and settings dialog box of the Parameters tab (when Dynamic is selected as the Data type).
This generates a layout report that is ready to run as long as the parameter names match
the field names.

Parameter Value List Options

How to:

Send the Display Value for Static and Dynamic Controls

Use Procedure Names as Values

Use Selected Values as the Default Value

When creating a static or dynamic list of values, you may add an ALL value to the list of
values and/or send the display value in a parameter.

The ALL feature allows developers to automatically add an ALL value to a list of values. An
ALL value does the following:

For dynamic parameters, the ALL feature sends a value of FOC_NONE to the reporting
server alerting the server to bypass or ignore the parameter altogether. Ignoring the
parameter would return all values in the data source.

With static parameters, the ALL value typically uses JavaScript to return all of the values
displayed in the list. This prevents you from having to select every value in the list
manually. When using the ALL feature with static parameters, you can select from the
following options:

Add ignore value. This option sends FOC_NONE to the server at run time, alerting
the server to bypass or ignore the parameter altogether. It is intended for complex
applications.

Add everything value. This option uses JavaScript to send every value present in
the control list to the server at run time. The Add everything value option is only
available with a Multiselect OR variable type.

When using a Dynamic or active report Data type, you may enter the value(s) to be selected
as the default value whenever the procedure is run. For more information, see How to Use
Selected Values as the Default Value on page 115.
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Note: You may also enter the selected value when adding a new unbound parameter on the
Parameters tab. For more information, see Adding a New Unbound Parameter on page 74.

How to Send the Display Value for Static and Dynamic ControlsProcedure:

From HTML Composer, you may send the display value, rather than the actual data, to the
parameter. The display value can also be used for headings and footings in the report output.
Note that the report heading and footing need to be created in InfoAssist before accessing
the HTML Composer.

The Send display value option appears when creating an incoming static parameter (a
parameter that is bound to a control), or an unbound control (a control that is not bound to
a parameter). It is not available when creating an unbound static parameter.

1. From HTML Composer, import a report that contains a parameter.

When importing a report with parameters, the New Parameters dialog box appears
prompting you to create the control type.
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The report and control type is added to HTML Composer.

2. To send the display value for the parameter selection, select the control object (for
example, select listboxn) in the Design view and click the Parameters tab.

The Properties and settings dialog box opens.

Note: The options available in the Properties and settings dialog box vary, depending
on the type of values (static or dynamic) you are creating.

3. For a static list of values, the Value, Display, and Selected columns appear on the
Properties and settings dialog box.

In the Display column, enter the text that represents the parameter value that the
user views.

Repeat this step until the list contains all of the values you want to include.
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Select Send display value.

Optionally, you may select values and click the Delete button to eliminate any values,
and use the up and down arrows to rearrange the order of the values.

Close the Properties and settings dialog box.

For more information about static values, see Creating a Static List of Values on page
77.

Click the Design tab to view the display values in the control object of HTML Composer.
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4. For a dynamic list of values, the Value field and the Display field appear on the Properties
and settings dialog box.

Sending the display value for Dynamic values is only applicable if you are using a Data
source that contains both an internal data value and a field that the internal data value
maps to for display purposes.

a. If using an Embedded procedure to supply dynamic values, follow the steps below.

Select Embedded procedure.

Click the Embedded procedure ellipsis button.

The Get source file dialog box opens.

Select the Master File name and click Open.

Click the ellipsis button from the Value field.

The Object Inspector opens with the field names from the selected Master File.

Double-click a field name to add it to the Value field.

The selected field is automatically added to the Display field and the source
code for the embedded procedure appears.

Optionally, you may click the Display field ellipsis button to select a different
field name for the Display field.

Optionally, select Add "ALL" option to automatically add an ALL value to a list of
parameter values.

Optionally, select Add 'No selection' option to optimize performance by populating
a chain one control at a time instead of all the controls when the page initially
loads.

Ensure that Send display value is checked.

Send display value is selected by default.

b. If using an External Procedure to supply dynamic values, follow the steps below.

Select External Procedure.

Click the External Procedure ellipsis button.

The Get source file dialog box opens.

Select the procedure (.fex) file name and click Open.

The parameter names from the procedure are automatically added to the Value
and Display field, and the source code for the external procedure appears.
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Optionally, you may click the Value field and Display field ellipsis button to select
a different field name.

Note: Only the parameter names from the external procedure will be available
for selection.

Optionally, select Add "ALL" option to automatically add an ALL value to a list of
parameter values.

Optionally, select Add 'No selection' option to optimize performance by populating
a chain one control at a time, instead of all the controls when the page initially
loads.

Ensure that Send display value is checked.

Send display value is selected by default.
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The following image is an example of the Properties and settings dialog box with
Send display value selected for a dynamic value.

Close the Properties and settings dialog box.

For more information about dynamic values, see Creating a Dynamic List of Values
on page 92.
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Click the Design tab to view the display values in the control object of HTML
Composer.

5. Run the HTML page.

6. Select the parameter for the report and run the report.

The display value is shown in the report heading.
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For example, in the image below, Gotham 40 is selected as the Store Code and shows
the display value in the report heading. The actual value, R1040, is shown in the Store
ID column.

Note: HTML Composer passes &var_TEXT if the report procedure uses it, regardless of
whether the send display value check box is checked or unchecked.

How to Use Procedure Names as ValuesProcedure:

The Values are procedures names option lets you populate a control with procedure names.
When that procedure name is clicked, the procedure executes.

1. Create an HTML page that contains a listbox, a push button, and a report.

Note: In this procedure a list box is used. However, the following controls are also able
to use the Values as procedures names option: double list, drop-down, radio button,
and check box.

2. Select the list box to bring up the Properties and settings dialog box.

Note: If the Properties and settings dialog box does not open, select View and click
Properties and settings.

3. Select Static as the Data type.
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4. At the bottom of the Properties and settings dialog box, select Values are procedures
names, as shown in the following image.

5. Click the New button and select procedures from your directory, as shown in the following
image.
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Note: You can add multiple procedure names to the Properties and settings dialog box
by multiselecting procedures while in the Get source file dialog box.

6. Once the procedures has been added to the Properties and settings dialog box, edit the
display name of the procedures value by double clicking the display contents if they are
not highlighted already.

The following image shows the procedure values with new display names.

7. Right-click the button you created and click Create Hyperlink.

The Hyperlink Properties dialog box opens.

8. Create a hyperlink that opens a selected procedure from a control in the report frame
created earlier.

a. For the Action, select Procedures from control from the drop-down list.

This option coincides with the Values are procedures names option found in the
Properties and settings dialog box. This option will point to an entire procedure for
the hyperlink, rather than a simple value. This option is only available when a control
on the HTML Page is using the Values are procedures names option.

b. Select listbox1 as the Source.
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The source can be different if you use a different control. For example, combobox1,
customselect1, radio1, or checkbox1.

c. Select Frame as the Target Type.

You could also select New Window as the target if you wanted the procedure to
open in a new window.

d. Select report1 as the Target/Template Name.

The created hyperlink is shown in the following image.

9. Run the page.

10. Select the procedure from the listbox and click the button.
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The report is run, as shown in the following image.

How to Use Selected Values as the Default ValueProcedure:

When using a Dynamic or active report Data type, you may enter the value(s) to be selected
as the default value whenever the procedure is run.

If you import a procedure (.fex) that has a dynamic prompt value, then the input box is
populated with values retrieved from the data source. If the selected value is available in
the data source, the value(s) are selected by default. If the selected value is not available
in the data source, then the value(s) that you entered are ignored and the first value retrieved
from the data source is selected.

1. From HTML Composer, import a report that contains a parameter.
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When importing a report with parameters, the New Parameters dialog box appears
prompting you to create the control type.

The report and control type is added to HTML Composer.

2. To enter the selected value to be used as the default value, select the control object
(for example, select listboxn) in the Design view and click the Parameters tab.

The Properties and settings dialog box opens.

Note: The options available in the Properties and settings dialog box vary, depending
on the type of values (static or dynamic) you are creating.

3. For a dynamic list of values, the Value field and the Display field appear on the Properties
and settings dialog box.

a. If using an Embedded procedure to supply dynamic values, follow the steps below.

Select Embedded procedure.

Click the Embedded procedure ellipsis button.

The Get source file dialog box opens.

Select the Master File name and click Open.

Click the ellipsis button from the Value field.

The Object Inspector opens with the field names from the selected Master File.
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Double-click a field name to add it to the Value field.

The selected field is automatically added to the Display field and the source
code for the embedded procedure appears.

Optionally, you may click the Display field ellipsis button to select a different
field name for the Display field.

Optionally, select Add "ALL" option to automatically add an ALL value to a list of
parameter values.

Optionally, select Add 'No selection' option to optimize performance by populating
a chain one control at a time, instead of all the controls when the page initially
loads.

Enter the exact parameter value in the Selected Value input field, as it appears
in the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon between
the values. For example, CA;GA.

You may enter selected values with a semicolon (;) or a comma (,). Additionally,
you may also have embedded commas or semicolons in the data values. If you
have these embedded characters, you must enclose all of the values in the input
area in double quotation marks (" "). For example:

ENGLAND;ITALY

ENGLAND,ITALY

"ENGLAND","IT,ALY"

Note that even though one value in the last set has the embedded comma, both
values need to be enclosed in double quotation marks.

Close the Properties and settings dialog box.

b. If using an External Procedure to supply dynamic values, follow the steps below.

Select External Procedure.

Click the External Procedure ellipsis button.

The Get source file dialog box opens.

Select the procedure (.fex) file name and click Open.

The parameter names from the procedure are automatically added to the Value
field and Display field, and the source code for the external procedure appears.
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Optionally, you may click the Value field and Display field ellipsis button to select
a different field name.

Note: Only the parameter names from the external procedure will be available
for selection.

Optionally, select the Add "ALL" option to automatically add an ALL value to a
list of parameter values.

Enter the exact parameter value in the Selected Value input field, as it appears
in the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon (;) between
the values. For example, CA;GA.

You may enter selected values with a semicolon (;) or a comma (,). Additionally,
you may also have embedded commas or semicolons in the data values. If you
have these embedded characters, you must enclose all of the values in the input
area in double quotation marks (" "). For example:

ENGLAND;ITALY

ENGLAND,ITALY

"ENGLAND","IT,ALY"

Note that even though one value in the last set has the embedded comma, both
values need to be enclosed in double quotation marks.

Close the Properties and settings dialog box.

For more information about dynamic values, see Creating a Dynamic List of Values
on page 92.
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The following image is an example of the Dynamic Data type Properties and settings
dialog box, with parameter values in the Selected Value field.

4. For an active report list of values, the Available active reports, Menu Option Types, and
Common Columns appear on the Properties and settings dialog box.

Select one or more active reports from the list of Available active reports. The selected
report will be bound to the active report control in the layout.

When an active report is selected, Refresh for active reports is enabled by default.

Select the Menu Options Types for the active report control to sort, filter, list or select
columns. You can also change presentation styles of the bound active report and
the associated report and graph objects synchronized to the active report.

Optionally, select the Add "ALL" option to automatically add an ALL value to a list of
parameter values.
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Enter the exact parameter value in the Selected Value input field, as it appears in
the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon between the
values. For example, CA;GA.

You may enter selected values with a semicolon (;) or a comma (,). Additionally, you
may also have embedded commas or semicolons in the data values. If you have
these embedded characters, you must enclose all of the values in the input area in
double quotation marks. For example:

ENGLAND;ITALY

ENGLAND,ITALY

"ENGLAND","IT,ALY"

Note that even though one value in the last set has the embedded comma, both
values need to be enclosed in double quotation marks (" ").

Close the Properties and settings dialog box.

For more information about active report values, see Creating Active Dashboards With
the HTML Composer.
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The following image is an example of the active report Data type Properties and settings
dialog box, with parameter values in the Selected Value field.

5. For a single-select unbound parameter, the Selected Value input field appears on the
Properties and settings dialog box.

Enter the exact parameter value in the Selected Value input field, as it appears in
the data source.

Parameter values are case-sensitive.

Optionally, you may enter more than one value by using a semicolon between the
values. For example, CA;GA.

You may enter selected values with a semicolon (;) or a comma (,). Additionally, you
may also have embedded commas or semicolons in the data values. If you have
these embedded characters, you must enclose all of the values in the input area in
double quotation marks (" "). For example:
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ENGLAND;ITALY

ENGLAND,ITALY

"ENGLAND","IT,ALY"

Note that even though one value in the last set has the embedded comma, both
values need to be enclosed in double quotation marks.

Close the Properties and settings dialog box.

For more information about single-select parameters, see Adding a New Unbound
Parameter on page 74.

The following image is an example of the Single select parameter Properties and settings
dialog box, with parameter values in the Selected Value field.

Even though it is a Single select parameter, multiple values are specified and selected.

6. Run the report.

The selected value, if available from the data source, is automatically selected
(highlighted) in the parameter list.
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The example below shows CT, GA as the selected values in the State parameter list in
the report output.

7. Click the Run button to run the report with the selected value parameters.

The report output appears.

If the selected value is not available in the report results, then the value that you entered
is ignored and the first value retrieved from the data source is shown.

IBM DB2 Web Query for IBM i 123

1. Using the HTML Composer



Using Controls to Supply Incoming Parameter Values

In this section:

Automatically Creating Controls From the New Parameters Dialog Box

Using the Delete Container Only Option

How to:

Manually Create a Control in the Layout

Change the Type of Control Associated With a Parameter

Bind or Unbind a Parameter To/From an Existing Control

Reference:

Types of Controls

Controls enable you to prompt users for a parameter value. When you create a parameter
as part of a report or graph, HTML Composer automatically adds a control, Submit button,
and Reset button for the parameter to your layout. The parameter appears on the Parameters
tab. You can also add an input control and bind it to a parameter.

When you delete a parameter in InfoAssist that was assigned a control in HTML Composer,
you must delete the associated controls individually in the layout.

Controls, with the exception of a text box which does not supply a list of possible values,
can supply values with a dynamic or static list of values:

A dynamic list retrieves values from a specified data source when the request is run.

A static list consists of a list of values you supply. These values do not change unless
you change them.

An active report control lists active report values that mimic active report menu items.

The active report controls cannot be associated to any parameters in the layout. This
type of control can only be associated with an active report in the layout.

The properties of a control, as well as the parameters associated with each control, can be
controlled with the Properties tab of the Properties window, and with the Parameters tab.
For details, see Working With the Properties Window on page 66 and Working With the
Parameters Tab on page 73, respectively.

Note: Pertaining to the Default selection property, at run time, when using a combo box,
there must be a value selected. In order to have nothing selected, you must add the Make
selection value.
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For details about static and dynamic controls, see Creating a Static List of Values on page
77 and Creating a Dynamic List of Values on page 92.

For details about active controls, see Creating Active Dashboards With the HTML Composer.

Automatically Creating Controls From the New Parameters Dialog Box
When a report contains one or more new amper variable parameters created in InfoAssist,
the New Parameters dialog box appears when you save the report. You can set the Control
Type for each parameter prior to returning to HTML Composer. This eliminates the need to
select each parameter individually to set the associated Control Type.

If you reference or import an existing report that uses a Master File containing a parameter,
the New Parameters dialog box opens with that parameter in the list, as well as any
parameters from the report procedure

Note: When referencing or importing an existing report that uses a Master File containing
a parameter, the Add “ALL” option and the Add “No Selection” option are unavailable.

If linking hyperlink properties to another page or procedure, HTML Composer parses the
other file for unresolved parameters and opens the New Parameters dialog box.
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The following image shows the New Parameters dialog box. For each parameter, you will
find Name and Control Type fields, a Create control check box, and a Chain control check
box. The Control Type ellipsis button enables you to select a new or existing control type for
the parameter.

The Parameter grouping options menu in the New Parameters dialog box provides options
for the placement of the controls associated with new amper variable parameters created
in InfoAssist. The option selected is set from the HTML Page tab, which is located in the
Developer Studio Options dialog box. You may create a single or multiple layer form, or select
an existing form from the layout.

Select Do not create a form to insert the controls for each of the new parameters in
separate locations on the HTML page.

Select New multiple layer form to insert the controls for all of the new parameters inside
one form element you can position anywhere on the HTML page. This form element also
contains submit (run) and reset buttons. The multiple layer form contains group boxes
around each element in the form. You may move and resize each element of the control.
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Select New single layer form to insert the controls for all of the new parameters inside
one form element, which you can position anywhere on the HTML page. This form element
also contains submit (run) and reset buttons. The single layer form contains all of the
elements within a single group box.

Single layer is the default form type selected in the HTML Page tab. To change the default
form type, select Options from the Window menu. The Developer Studio Options dialog
box will open. From the Developer Studio Options dialog box, select the HTML Page tab.

Select form(n), where n is the number of a control that already exists in the layout. The
parameter is added to the selected control.

Select Don't show this message again and use default selection to control whether or not
the New Parameters dialog box appears when adding parameters in HTML Composer.

Tip: You may view the New Parameters dialog box again by selecting Show New Parameters
dialog from the HTML Page tab. To access the HTML Page tab, select Options from the
Window menu. The Developer Studio Options dialog box will open. From the Developer
Studio Options dialog box, select the HTML Page tab.

Select Auto chain controls in above specified order to automatically chain the selected
controls from the New Parameters dialog box. The auto chain option is useful since it
creates the chain, or links of a chain, automatically for the parameters selected in the
Chain control column. For more information, see Automatically Chaining Parameters From
the New Parameters Dialog Box on page 278.

Select Create controls for all Parameters to switch between creating controls for all or
none of the parameters in the New Parameters dialog box. When importing or referencing
a report with parameters to an HTML page, all of the controls will have Create control
selected by default. The create controls for all parameters selection is useful when there
is a long list of parameters that you do not want to add controls for on the HTML page.

To edit the Control Type that you selected from the New Parameters dialog box, select the
parameter object on the Parameters tab or the Design tab, right-click, and select the control
type option from the Set Control Type menu.

How to Manually Create a Control in the LayoutProcedure:

When you create a parameter as part of a report or graph, HTML Composer automatically
adds a control, Submit button, and Reset button for the parameter to your layout. Manually
adding a control to the layout enables you to create the individual objects on the control.

Inserting a control in the Design view creates the control object in the layout with the Submit
button and Reset button. You must manually add the input controls to be used in the control.
For more information, see Using Controls to Supply Incoming Parameter Values on page 124.

1. Insert a control by doing one of the following:
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Click the Insert form button from the Components toolbar.

You may select Multiple Layer Form or Single Layer Form as the form type. If no form
type is selected, single layer form is the default.

From the Insert menu, point to Components, then point to Form, then select a form
type (Multiple Layer Form or Single Layer Form).

The cursor changes into a crosshair.

To change the default form type, select Options from the Window menu. The Developer
Studio Options dialog box opens. From the Developer Studio Options dialog box, select
the HTML Page tab.

The multiple layer form contains group boxes around each element in the form. You may
move and resize each element of the control. The single layer form contains all of the
elements within a single group box.

2. Drag the crosshair to create a control and adjust it to the size you want.

A control is created in the layout and assigned the form(n), where n is a number.

3. You may add input controls in the control object to create parameter values.

Create an insert control and add it in the control object. For example, insert a List
Box, Drop Down List, and so on.

Click the Parameters tab to create parameter values.

The Properties and settings dialog box opens. Creating an input control from the
Design view prompts you to create a bound parameter on the Parameters tab.

Create the parameter values for the input control.

For details about creating parameter values, see Creating Parameter Values on page
73.

Optionally, you may close the Properties and settings dialog box for the input control
if you wish to bind a parameter to a control.

4. Bind the input controls to a parameter.
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Binding a control to a parameter will populate the parameter. Drag a control object to a
parameter object on the Parameters tab. For details about creating input controls, see
Using Input Controls to Supply Parameter Values on page 133.

5. Optionally, you may assign hyperlink properties to the Submit button. For more
information, see How to Add a Hyperlink to a Push Button or an Image on page 43.

How to Change the Type of Control Associated With a ParameterProcedure:

1. In the Parameters tab or the Design tab, select the input control associated with the
parameter name.

2. Right-click and select Set Control Type.

3. Select the type of input control for the form.

Options are Calendar, Check box, Drop down list, Hidden, List box, Radio button, Text
area, Text box, Single source Tree control, and Multi source Tree control.

The following image shows the input control options when right-clicking a control object on
the Design tab.

How to Bind or Unbind a Parameter To/From an Existing ControlProcedure:

When a control is automatically added to the layout with the New Parameters dialog box, it
is associated (bound) to a parameter. Click the Parameters tab and notice the direction of
the arrow. The control object is bound to the parameter object, which means that the control
will populate the parameter.
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If you deselect the Create control option from the New Parameters dialog box, the deselected
parameter name is added to the Unbound Parameters box on the Parameters tab. The
Unbound Parameters box is a container for the unbound parameters, only for parameters
not selected from the New Parameters dialog box. Any parameters created or unbound from
the Parameters tab are not automatically moved here. Optionally, you may click and drag
parameters to and from the Unbound Parameters box for your own organization.

1. To unbind a parameter from a control:

Click the Parameters tab.

Select the arrow head on the line between the parameter and the input control, so
that the line is bold.

Right-click and select Break binding.

2. To bind a parameter to a control:

Click the Parameters tab.

Select the center of the input control object.

Click and drag the control to the center of the parameter object.

Release the mouse to complete the binding.

Types of ControlsReference:

Controls can be single-select or multiselect. Single-select controls enable you to select a
single value from a list of supplied values. Multiselect forms enable you to select multiple
values from a list of supplied values.

Examples of single-select controls are:

A text box. For details, see Using a Text Box on page 134.

A drop-down list. For details, see Using a Drop-Down List on page 141.

Radio buttons. For details, see Using Radio Buttons on page 169.

A text area. For details, see Using a Text Area on page 138.

Check boxes. For details, see Using Check Boxes on page 167.

Examples of multi-select controls are:

A list box. For details, see Using a List Box on page 146.

A tree control. For details, see Using Tree Controls on page 173.
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A drop-down list is the default control type for all single-select parameters on the New
Parameters dialog box. A list box is the default control type for all multi-select parameters
on the New Parameters dialog box.

You can change the type of input control using the Parameters tab. For details, see How to
Change the Type of Control Associated With a Parameter on page 129.

Note: Individual multiselect parameters must be designated as multiselect in InfoAssist in
order to process multiple values.

Using the Delete Container Only Option
When creating parameters, the Grouping option selected in the New Parameters dialog box
generates a container for controls. After the container is created, you may choose to delete
the container by using the Delete Container Only option. This option allows you to delete
the container without deleting the objects inside. You can Delete Container Only using the
Edit menu, by using the Ctrl + Delete keys, or by right-clicking the container and selecting
Delete Container Only from the context menu.

The following image shows the Delete Container Only option on the Edit menu.
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The following image shows the Delete Container Only option on the context menu when right-
clicking a container.

Note: If you delete a form container, the Reset button is deleted with the form. The Reset
button is deleted because it is attached to the form.
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Using Input Controls to Supply Parameter Values

In this section:

Using a Text Box

Using a Text Area

Using a Drop-Down List

Using a List Box

Using a Double List Control

Adding a Paging Control in HTML Composer

Adding a Search Control in HTML Composer

Using Global Search and Paging

Using Check Boxes

Using Radio Buttons

Using Tree Controls

Using a Slider Control

Adding a Dynamic Calendar

Using a Hidden Parameter Value

Creating Hyperlink Actions With Additional Parameters

Binding a Button, Hyperlink, or Image to Populate a Control

How to:

Use Controls to Populate Another Control Based on Selected Values

Creating an input control from the Design view prompts you to create a bound parameter on
the Parameters tab. Binding a control to a parameter will populate the parameter.

Note:

You may also add input controls from the New Parameters dialog box that appears when
creating a report or graph with parameters. For more information about the New
Parameters dialog box, see Automatically Creating Controls From the New Parameters
Dialog Box on page 125.

Except for the Hidden control, the Properties and settings dialog box will display for all
controls when in the Design tab and Parameters tab. The Properties and settings dialog
box will display for the Hidden control only when in the Parameters tab.
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Using a Text Box

How to:

Create a Text Box

Enter Masked Text in a Text Box

Reference:

Text Box Properties in the Properties Window

A text box enables you to enter a value in a text entry field.

How to Create a Text BoxProcedure:

A text box only provides a single-select value.

1. Add a text box by doing one of the following:

Click the Text Box button from the Components toolbar.

or

From the Insert menu, select Controls, then click Text Box.

The cursor changes to a crosshair.

2. Drag the crosshair to create a text box and adjust it to the size you want.

A text box is created in the layout and assigned the name edit(n), where n is a number.

3. Optionally, change the properties of the text box by adjusting the properties displayed
in the Properties tab of the Properties window. For details, see Text Box Properties in
the Properties Window on page 137.

4. To bind an existing parameter to the text box:

Binding a parameter to a text box creates an incoming parameter. An incoming parameter
is a parameter that is bound to a control. The parameter value will populate the text box
with values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the text box with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the text box object, and release the mouse to complete the binding.
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To unbind the parameter from the text box, select the arrow head on the line, so that
the line is bold, right-click, and select Break binding.

5. To bind the text box to a parameter:

If binding a text box to a parameter, the value can only be single select. Binding the text
box to a parameter will populate the parameter with the single value.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the single value for the text box. You can create a single Static or Dynamic
value.

Close the Properties and settings dialog box to create the text box with the single
value.

Bind the text box to a parameter. Select the center of the text box, left-click and drag
the text box to the center of the parameter object, and release the mouse to complete
the binding.

How to Enter Masked Text in a Text BoxProcedure:

When entering a value in a text box at run time, you may set the mask text property so that
the text is not displayed as text, but masked by default characters. This is recommended
when using passwords or other sensitive information.

1. Select the Text Box object to view the associated properties.

You may also select the text box properties from the drop-down list of the Properties
window. The properties for the text box appears as edit(n) <INPUT>.
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2. From the Mask text property field, select Yes.

3. Run the report and enter a value in the text box.

The value being entered appears as masked text, as shown in the following image.
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Text Box Properties in the Properties WindowReference:

When a text box is selected, the Properties tab in the Properties window contains options
that control the properties of your text box.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Using a Text Area

How to:

Create a Text Area

Reference:

Text Area Properties in the Properties Window

A text area is a single-select control that enables you to enter multiple lines of text that can
be assigned to a single variable. The behavior is similar to a text box, but you are not
restricted to entering just one line of text. For example, if you want to assign a paragraph
(multiple lines of text) to a variable that can be referenced by a procedure, you can add the
paragraph to a text area from the Properties and settings dialog box on the Parameters tab.

Note: When the Multiple property is set for a text area control, you can enter data values
separated by semicolons, commas, or carriage returns.

The following image shows the text area component in HTML Composer.

How to Create a Text AreaProcedure:

1. Click the Text Area  button from the Components toolbar.

or

From the Insert menu, select Controls, then click Text Area.

The cursor changes to a crosshair.

2. Drag the crosshair to create a text area and adjust it to the size you want.

A text area is created in the layout and assigned the name textarea(n), where n is a
number.
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3. Optionally, you can change the properties of the text area in the Properties tab of the
Properties window. For details, see Text Area Properties in the Properties Window on
page 140.

4. To bind an existing parameter to the text area:

Binding a parameter to a text area creates an incoming parameter. An incoming parameter
is a parameter that is bound to a control. The parameter value will populate the text
area with values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the text area with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the text box object, and release the mouse to complete the binding.

To unbind the parameter from the text area, select the arrow head on the line, so
that the line is bold, right-click, and select Break binding.

5. To bind the text area to a parameter:

If binding a text area to a parameter, the value can only be single select. You can create
one or more lines of text for the single value. Binding the text area to a parameter will
populate the parameter with the single value.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the single value for the text area. You can create a single Static or Dynamic
value.

Note: If you are creating a Static Data type for the text area, you may enter one or
more lines of text by typing or pasting text into the Selected Value input field.

Close the Properties and settings dialog box to create the text area with the single
value.

Bind the text area to a parameter. Select the center of the text area, left-click and
drag the text area to the center of the parameter object, and release the mouse to
complete the binding.
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Text Area Properties in the Properties WindowReference:

When a text area is selected, the Properties tab in the Properties window contains options
that control the properties of your text area.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Using a Drop-Down List

How to:

Add a Drop-Down List

Select Multiple Values From a Drop-Down List

Reference:

Drop-Down List Properties in the Properties Window

A drop-down list enables you to select a single value from a list of supplied values. You can
use a dynamic or static list of values for the drop-down list.

How to Add a Drop-Down ListProcedure:

1. Add a drop-down list by doing one of the following:

Click the Drop Down List button from the Components toolbar.

or

From the Insert menu, select Controls, then click Drop Down List.

The cursor changes to a crosshair.

2. Drag the crosshair to create a drop-down list, and adjust it to the size you want.

A drop-down list is created in the layout and assigned the name combobox(n), where n
is a number.

3. Optionally, change the drop-down list properties by adjusting the properties displayed
in the Properties tab of the Properties window. For details, see Drop-Down List Properties
in the Properties Window on page 145.

4. Binding a parameter to a drop-down list creates an incoming parameter. An incoming
parameter is a parameter that is bound to a control. The parameter value will populate
the drop-down list with values. To bind an existing parameter to the drop-down list:

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the drop-down list with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the drop-down list object, and release the mouse to complete the
binding.
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To unbind the parameter from the drop-down list, select the arrow head on the line,
so that the line is bold, right-click, and select Break binding.

5. To bind the drop-down list to a parameter:

Binding the drop-down list to a parameter will populate the parameter with a list of
values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the list of values for the drop-down list. You can create a list of Static or
Dynamic values.

Close the Properties and settings dialog box to create the text box with the list of
values.

Bind the text box to a parameter. Select the center of the text box, left-click and drag
the text box to the center of the parameter object, and release the mouse to complete
the binding.

How to Select Multiple Values From a Drop-Down ListProcedure:

When using a drop-down list input control to supply parameter values, the Multiple property
value indicates whether multiple values can be selected from a list of supplied values at
run time.

Note: A multiselect list enables you to select multiple values by using the Ctrl key while
selecting values. In order to select multiple values in the drop-down list, the procedure must
be set up to accept multiple values. Ensure that the Variable Type for the parameter value
is Multiselect OR or Multiselect AND in the procedure.

1. From HTML Composer, insert a report with parameters that accept multiple values.

For example, create a report with Multiselect OR as the variable type for the parameter,
accepting a dynamic list of values from ggsales, with REGION as the value for returned
and displayed fields.

2. When the New Parameters dialog box appears, accept the default control type of Drop
down list and click OK.

A drop-down list is created in the layout and assigned the name combobox(n), where n
is a number.

3. Select Multiple from the Multiple drop-down list in the Properties tab of the Properties
window.
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This indicates that multiple items can be selected from the drop-down list.

4. Save and run the HTML page.

Select multiple values by using the Ctrl key while selecting values from the drop-down
list, as shown in the following image.

IBM DB2 Web Query for IBM i 143

1. Using the HTML Composer



The drop-down list shows the selected multiple values. Click the Run button to run the
report with the selected value parameters.
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Drop-Down List Properties in the Properties WindowReference:

When a drop-down list is selected, the Properties tab in the Properties window contains
options that control the properties of your drop-down list.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Using a List Box

How to:

Add a List Box

Reorder the Selected Values in the List Box

Reference:

List Box Properties in the Properties Window

A list box enables you to select single or multiple values at one time:

A single-select list enables you to select only one value for each time a request is run.

A multiselect list enables you to select multiple values by using the Ctrl key while selecting
values. In order to provide multiple values, the procedure must be set up to accept
multiple values.

List box values can be dynamic or static.

How to Add a List BoxProcedure:

1. Add a list box by doing one of the following:

Click the List box button from the Components toolbar.

or

From the Insert menu, select Controls, then click List Box.

The cursor changes to a crosshair.

2. Drag the crosshair to create a list box, and adjust it to the size you want.

A list box is created in the layout and assigned the name listbox(n), where n is a number.

3. Optionally, change the properties of the list box by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see List Box Properties in the
Properties Window on page 148.

4. Binding a parameter to a list box creates an incoming parameter. An incoming parameter
is a parameter that is bound to a control. The parameter value will populate the list box
with values. If binding a parameter to a list box, the value can be single or multiselect.
To bind an existing parameter to the list box:

Click the Parameters tab.

The Properties and settings dialog box opens.
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Close the Properties and settings dialog box.

Close this dialog since you are populating the list box with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the list box object, and release the mouse to complete the binding.

To unbind the parameter from the drop-down list, select the arrow head on the line,
so that the line is bold, right-click, and select Break binding.

5. Bind the list box to a parameter.

Binding the drop-down list to a parameter will populate the parameter with a list of
values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the list of values for the list box control. You can create a list of Static or
Dynamic values.

Close the Properties and settings dialog box to create the list box with the list of
values.

Bind the list box to a parameter. Select the center of the list box, left-click and drag
the list box to the center of the parameter object, and release the mouse to complete
the binding.
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List Box Properties in the Properties WindowReference:

When a list box is selected, the Properties tab in the Properties window contains options
that control the properties of the selected list box.

Click a property to display a description of the selected property at the bottom of the
Properties window.

How to Reorder the Selected Values in the List BoxProcedure:

When using a list box, you may reorder the selected values in the report.

1. In the Design view of the HTML page, select the list box object, right-click, and select
the Add Move Items control.

An up and down arrow is added next to the list box control.
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2. Run the HTML page.

3. Select values from the list box and run the report.

4. To reorder the selected values, click the up arrow to move the selected value up in the
list box, or click the down arrow to move the selected value down in the list box.

5. Run the report again to view the results with the selected values.

In the following example, CA is the first value in the By State list box. Select the down
arrow to reorder the location of CA in the list box and rerun the report again.

Using a Double List Control

How to:

Add a Double List Control

Reference:

Double List Box Properties in the Properties Window

You may add a double list control for displaying multiselect values. This enables you to view
a list of the available values and add or remove them from one list to another. At run time,
a report is generated based on the values that are added.

Note: When creating a static list of values for a double list control, the add everything value
option is not available.
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How to Add a Double List ControlProcedure:

1. Add a double list control by doing one of the following:

From the Components toolbar, click the Double List Control button.

or

From the Insert menu, select Controls, then click Double List Control.

The cursor changes to a crosshair.

2. Drag the crosshair to create a double list control, and adjust it to the size you want.

A double list control is created in the layout and assigned the name
customselect(n)_selectfrom and customselect(n)_selectto, where n is a number.

3. You may edit the default description for the double list control by double-clicking Enter
text, and typing the description of your choice.

4. Optionally, change the double list control properties by adjusting the properties displayed
in the Properties tab of the Properties window. For details, see Double List Box Properties
in the Properties Window on page 153.

5. Bind an existing parameter to the double list control.

Binding a parameter to a double list control creates an incoming parameter. An incoming
parameter is a parameter that is bound to a control. The parameter value will populate
the double list control with values. If binding a parameter to a double list control, the
value can be single or multiselect.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the double list control with a parameter
value.
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Select the center of the parameter name object, left-click and drag the parameter to
the center of the double list control object, and release the mouse to complete the
binding.

To unbind the parameter from the double list control, select the arrow head on the
line, so that the line is bold, right-click, and select Break binding.

6. Bind the double list control to a parameter.

Binding the double list control to a parameter will populate the parameter with a list of
values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the list of values for the double list control. You can create a list of Static or
Dynamic values.

Close the Properties and settings dialog box to create the double list control with
the list of values.

Bind the double list control to a parameter. Select the center of the double list control,
left-click and drag the double list control to the center of the parameter object, and
release the mouse to complete the binding.

Note: You can change the default double list control to other types of controls by right-
clicking the control object on the Parameters tab or the Design tab and selecting Set
Control Type.

The options are Calendar, Check box, Drop down list, Hidden, List box, Radio button,
Text area, Text box, Single source Tree control, and Multi source Tree control.

7. Run the HTML page and select values by using the right and left arrows to add or remove
values to the selected column.
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The selected values appear in the second column. The output is generated based on
the selected values in the second column. In the following example, Action and Comedy
are the selected values for the report.

8. Optionally, you may reorder the selected values in the report.

The up and down arrows reorder the selected values that appear in the second column
of the double list control.

Click the up arrow to move the selected value up in the second column of the double
list control, or click the down arrow to move the selected value down in the double list
control.
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Double List Box Properties in the Properties WindowReference:

When a double list box is selected, the Properties tab in the Properties window contains
properties of double list controls.

Keep Selected Value. When Yes is selected, this option will accumulate values you search
for in the right-side box. When you search for another value, the previously searched values
will not be deleted. No is selected by default.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Paging Control in HTML Composer

How to:

Add a Paging Control

You may add a paging control to a List Box, Drop Down List, and the first control of a Double
List Control, which enables you to page through a large list of values before selecting a
value. The Add 'Paging' control option is available through the right-click context menu on
the Design tab of HTML Composer when an input control is selected.

How to Add a Paging ControlProcedure:

The Add 'Paging' control option enables you to page through a large list of values for a List
Box, Drop Down List, and the first control of a Double List Control, before selecting a value.
For example, suppose that you have a list box showing 50 values. Adding the paging control
enables you to display these values as pages of values, as well as go directly to the first,
previous, next, and last pages to select the value.

1. Select the input control on the Design tab of HTML Composer, right-click, and select
Add 'Paging' control.

Note: The paging control is only valid for a List Box, Drop Down List, and the first control
of a Double List Control.
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The following image shows the Add 'Paging' control option in HTML Composer.
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The paging control is added below the input control on the canvas, as shown in the
following image.

Note: If the paging control is not visible, you may need to resize the control and input
control objects on the canvas.

2. Optionally, change the Number or Range property for the paging control in the Properties
tab of the Properties window.

The default Number or Range property is 1-50. This specifies the number or page range
of values to show, per page, for the input control and the starting item number. For
example, the input control starts at the first value and displays a range of 50 values
per page.

Note: The paging control properties are available from the Properties tab of the Properties
window when the paging control is selected. The paging control appears as navigator(n)
in the Properties window drop-down list.
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The following image shows the Number or Range property for the paging control in HTML
Composer.

3. Run the HTML page.

4. Use the arrow buttons to page through the values to be displayed for the input control.
You may select First, Previous, Next, or Last.

Note: You may also type in a page number or range in the paging control at run time,
as described in the Number or Range property in step 2. This specifies the number or
range of values, per page, for the input control.
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The input control shows the values for the page selected in the paging control.

5. Select a value from the input control.

6. Click the Run button to refresh the report, showing the value selected in the input control.

In the following example, the paging control shows 101-200 of 1542. This indicates that
there are 99 values available to select from on this page, as shown in the list box. The
list box shows the value of 180 as the selected unit. Running the report shows the
results with Unit Sales of 180.
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Adding a Search Control in HTML Composer

How to:

Add a Search Control

You may add a search control to a List Box, Drop Down List, and the first control of a Double
List Control, which enables you to search for a value in a control, before selecting a value.
The Add 'Search' control option is available through the right-click context menu on the
Design tab of HTML Composer when an input control is selected.

How to Add a Search ControlProcedure:

The Add 'Search' control option enables you to search for a value in a control for a List Box,
Drop Down List, and the first control of a Double List Control. For example, suppose that
you have a list box showing 30 items. Adding the search control adds an additional input
field to your output page. Type the value you are looking for and click the search button to
find the value in your input control.

1. Select the input control on the Design tab of HTML Composer, right-click, and select
Add 'Search' control.

Note: The search control is only valid for a List Box, Drop Down List, and the first control
of a Double List Control.

The following image shows the Add 'Search' control option in HTML Composer.
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The search control is added above the input control on the canvas, as shown in the
following image.

Note: If the search control is not visible, you may need to resize the control and input
control objects on the canvas.

2. Run the HTML page.

3. Type the value to be displayed for the input control and click the search button.

Pressing the Enter key will not execute the search. You must click the search button.

The input control shows a suggested list of matched values.

4. Select a value from the input control.

5. Click the Run button to refresh the report showing the value selected in the input control.
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In the following example, the search control shows 93 as the search value. This indicates
searching the list box records for a value matching 93. The list box shows the value of
93 as the selected unit. Running the report shows the results with Unit Sales of 93.

Using Global Search and Paging

How to:

Enable Global Search and Paging

You can use the global search and paging option on the BODY object to have one search
and paging control that can be used with each input control on the page.
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How to Enable Global Search and PagingProcedure:

1. Click the Global search/paging property in the Properties tab of the Properties window
for the BODY object, as shown in the following image.

2. Select Yes from the drop-down menu.
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At run time, the Search/Paging window opens in the Home position, as shown in the
following image.
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When you click an input control, because the Auto-link to selected control option is on
by default, the Search/Paging window appears under the input control, as shown in the
following image. By default, the window shows all values on one page (for example 1-4
of 4).

The label for the input control is displayed showing that it is linked to that input control.
If no label is associated with the input control, the window will show the unique identifier
for the input control, for example, combobox1.

3. If you want multiple pages, type a range in the Search/Paging field in the format 1-2 of
4, as shown in the following image and press the Enter key.
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4. Click the Show settings  button on the Global Search and Paging window to expand
the window and show the search and paging options, as shown in the following image.

The Search/Paging options are:

Match Case. Search value must match the value in the input control exactly.

Match Whole Word Only. Search value word must exist in the string.

Auto-link to selected control. Search/Paging window appears under the selected input
control. Auto-link is on by default.

Keep selected values. This option only affects a double-list. When checked, this option
will accumulate values you search for in the right-side box. When you search for another
value, the previously searched values will not be deleted.

Note:

The Global control option overrides individual control options. If Keep selected values
is selected for Global searching/paging, that will override whether the double-list has
it, regardless of whether it is set for the control itself.

You can click the up arrow  button on the expanded window to collapse the options.

You can click the House icon on the Search/Paging window to move the window back
to the Home position.
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How to Use Search and Paging FeaturesProcedure:

You can use the following buttons on the Search/Paging window to navigate through the
pages.

DescriptionButton

First. Shows the first page of values.

Previous. Shows the previous page of values.

Search. Initiates the search of values based on the text box input.

Next. Shows the next page of values.

Last. Shows the last page of values.

Reset All. Resets the paging back to the original.

Show Settings. Expands the Global/Paging window and shows the
options.

Once expanded, use the  button to collapse the settings display.
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Using Check Boxes

How to:

Add Check Boxes

Reference:

Check Box Properties in the Properties Window

Check boxes enable you to select a single value from a list of supplied values. Note that if
there are multiple check box input controls that are grouped together, you may select the
Multiple properties for each control. Multiple ensures that you can select a single value from
each check box control.

Check box list values can be dynamic or static.

How to Add Check BoxesProcedure:

1. Add check boxes by doing one of the following:

Click the Check box button from the Components toolbar.

or

From the Insert menu, select Controls, then click Check Box.

2. Drag the crosshair to create a check box list and adjust it to the size you want.

A check box is created in the layout and assigned the name checkbox(n), where n is a
number.

3. Optionally, change the properties of the check box list by adjusting the properties
displayed in the Properties tab of the Properties window. For details, see Check Box
Properties in the Properties Window on page 169.

4. Bind an existing parameter to the check box.

Binding a parameter to a check box creates an incoming parameter. An incoming
parameter is a parameter that is bound to a control. The parameter value will populate
the check box with values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the check box with a parameter value.
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Select the center of the parameter name object, left-click and drag the parameter to
the center of the check box object, and release the mouse to complete the binding.

To unbind the parameter from the check box, select the arrow head on the line, so
that the line is bold, right-click, and select Break binding.

5. Bind the check box to a parameter.

Binding the check box to a parameter will populate the parameter with a list of values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the list of values for the check box. You can create a list of Static or Dynamic
values.

Optionally, select Add display image to display images, in addition to the text next
to the check box.

You can select the image by clicking the ellipsis button in the Display column of the
Properties and settings dialog box.

To use dynamic image values, there must be a field in the data source that contains
the image file name. The physical image file must exist in the current application if
you are working in Local Projects.

If a report on the HTML page is coded to use the User Output format (Parameter
name WFFMT), the user can select a check box control from the New Parameters
dialog box. The tool will automatically associate the output type image, included with
the product, to each check box.

Close the Properties and settings dialog box to create the check box with the list of
values.

Bind the check box to a parameter. Select the center of the check box, left-click and
drag the check box to the center of the parameter object, and release the mouse to
complete the binding.
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Check Box Properties in the Properties WindowReference:

When a check box is selected, the Properties tab in the Properties window contains properties
of the selected check box.

Click a property to display a description of the selected property at the bottom of the
Properties window.

Using Radio Buttons

How to:

Add Radio Buttons

Reference:

Radio Buttons Properties in the Properties Window

Radio buttons enable you to select a single value from a list of supplied values. Radio button
values can be static or dynamic.
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How to Add Radio ButtonsProcedure:

1. Add radio buttons by doing one of the following:

Click the Radio button from the Components toolbar.

or

From the Insert menu, select Controls, then click Radio Button.

The cursor changes to a crosshair.

2. Drag the crosshair to create a radio buttons list and adjust it to the size you want.

A radio button placeholder is created in the layout and assigned the name radio(n),
where n is a number.

3. Optionally, change the properties of the radio buttons by adjusting the properties
displayed in the Properties tab of the Properties window. For details, see Radio Buttons
Properties in the Properties Window on page 172.

4. Bind an existing parameter to the radio button.

Binding a parameter to a radio button creates an incoming parameter. An incoming
parameter is a parameter that is bound to a control. The parameter value will populate
the radio button with values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Note: Close this dialog since you are populating the radio button with a parameter
value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the radio button object, and release the mouse to complete the binding.

To unbind the parameter from the radio button, select the arrow head on the line,
so that the line is bold, right-click, and select Break binding.

5. Bind the radio button to a parameter.

Binding the radio button to a parameter will populate the parameter with a list of values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the list of values for the radio button. You can create a list of Static or Dynamic
values.
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Optionally, select Add display image to display images in addition to the text next to
the radio button.

You can select the image by clicking the ellipsis button in the Display column of the
Properties and settings dialog box.

To use dynamic image values, there must be a field in the data source that contains
the image file name.  The physical image must reside in the domain Other folder.
This field name must be specified as the Display field in the Properties and settings
dialog box.

If a report on the HTML page is coded to use the User Output format (Parameter
name WFFMT), the user can select a radio button control from the New Parameters
dialog box. The tool will automatically associate the output type image included with
the product to each radio button, as shown in the following image.

Close the Properties and settings dialog box to create the radio button with the list
of values.

Bind the radio button to a parameter: Select the center of the radio button, left-click
and drag the radio button to the center of the parameter object, and release the
mouse to complete the binding.
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Radio Buttons Properties in the Properties WindowReference:

When a radio button is selected, the Properties tab in the Properties window contains options
that control the properties of your radio buttons.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Using Tree Controls

How to:

Add a Tree Control to an HTML Page Using an Existing Procedure

Populate a Multi Source Tree Control

Add a Tree Control to an HTML Page Using Static Values

Create a New Tree Control From the New Parameters Dialog Box

Reference:

Usage Notes For Chaining Tree Controls

Tree Control Properties in the Properties Window

By using a tree structure in an HTML report, you can show data from non-hierarchical data
sources.

The behavior of the tree control is integrated with the parameter definition. If a parameter
is defined as a single value and that parameter is bound to a tree control, the tree control
uses option buttons for each node in the hierarchy. If the parameter is defined as Multiselect
OR or Multiselect AND, and that parameter is bound to a tree control, then the tree control
uses check boxes for each node in the hierarchy, enabling you to select multiple nodes.

The following image shows the Tree Control component in HTML Composer.

How to Add a Tree Control to an HTML Page Using an Existing ProcedureProcedure:

You can select an existing procedure to add to the tree control in an HTML page. When you
select a procedure, it should use fields from the parent/child hierarchy and be set up as
follows:

TABLE FILE file
SUM FST.dispfield
BY ParentUniqueField
BY UniqueField
BY datafield
ON TABLE PCHOLD FORMAT XML 
END
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where:

file

Is the name of the data source.

dispfield

Is the field whose values display in the tree control.

ParentUniqueField

Is the field that represents the parent for the parent/child hierarchy (PROPERTY =
PARENT_OF).

UniqueField

Is the field that represents the unique IDs for the hierarchy members (PROPERTY=UID).

datafield

Is the field whose values are passed as the parameter value.

After the procedure is set up, follow these steps:

1. In HTML Composer, insert a tree control from the Components toolbar.

Tip: You may select Single source Tree control or Multi source Tree control. If no type
is selected, Single source Tree control is the default.

The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name treecontrol(n), where n is
a number. Additionally, the Properties and settings dialog box appears for the tree
control.

3. Optionally, you may select the Expanded property from the Properties tab of the Properties
window to show the tree control expanded at run time.

4. Optionally, you may select the Hyperlink property from the Properties tab of the Properties
window to show the tree nodes as hyperlinks, instead of radio buttons at run time.

5. From the Properties and settings dialog box, select Dynamic as the Data type.

6. Select External Procedure and click the browse (...) button adjacent to the first input
field.

The Get source file dialog box opens.

7. Select a procedure and click Open.

The procedure name is added as the external procedure.
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8. Click the Value field browse button to select a field from the hierarchy.

The Value field is the data source field from which the values will be retrieved.

9. Click the Display field browse button to select a field from the hierarchy.

The Display field is the text that represents the parameter value in the tree control.

10. Save and run the page to view the multi-dimensional data source in the tree control.

How to Populate a Multi Source Tree ControlProcedure:

You can show a tree structure for a non-hierarchical data source by using a tree control. By
identifying the number of layers for the tree control, you are able to populate each layer of
the tree control with its own procedure. Setting the number of layers creates a tree structure
by which each layer is its own subcontrol, chained together with no conditions.

This procedure describes how to add parameters for a tree control, where the number of
layers property is set.

1. In HTML Composer, insert a tree control by doing one of the following:

Click Multi source Tree control from the Tree control drop-down list, located on the
Components toolbar, as shown in the following image:

or

From the Insert menu, select Controls, then click Multi source Tree control.

The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name treecontrol(n), where n is
a number. Additionally, the Properties and settings dialog box appears for the tree
control.

3. From the Properties tab of the Properties window, type in the Number of layers for the
tree control, and press the Enter key.
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This enables you to specify the number of layers to populate. The following image shows
the Number of layers property with three (3) layers.

4. Optionally, you may select the Expanded property from the Properties tab of the Properties
window to show the tree control expanded at run time.

5. Optionally, you may select the Hyperlink property from the Properties tab of the Properties
window to show the tree nodes as hyperlinks, instead of radio buttons at run time.

6. With the tree control selected, click the Parameters tab.

The tree control object shows the set number of layers. For example, the following image
shows a tree control with three layers on the Parameters tab.
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7. Select each layer of the tree control and create the properties and settings for its data
population.

When creating a Multi source Tree control, the static data type is not available. If creating
static values for the tree control, you must create a single source tree control. To create
a static list of values, see How to Add a Tree Control to an HTML Page Using Static Values
on page 182.

For example, if you have a tree control with three layers:

Select the first layer of the tree control and create a dynamic embedded procedure
for the REGION field of the GGSALES data source.
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Select the second layer of the tree control and create a dynamic embedded procedure
for the ST field of the GGSALES data source.
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Select the third layer of the tree control and create a dynamic embedded procedure
for the CITY field of the GGSALES data source.

8. Optionally, to add an additional layer for the tree control, right-click the tree control object
on the Parameters tab and select Add layer.
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Note: The Add layer option only appears for a Multi source tree control object.

9. Click the added layer to view the properties and settings for that layer.
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10. Switch to the Design tab of HTML Composer to preview the populated tree control.

Note that the Properties window drop-down list for the tree control shows each layer of
input values.

11. Save and run the page.

Note: If a user selects a lower level node in one layer and a higher level node in another
layer, when the procedure is executed, only the lowest level selections will take effect.
For example, you have 3 layers: COUNTRY, CAR, and MODEL. Under ENGLAND, TRIUMPH,
you select TR7. Under FRANCE, you select PEUGEOT. At run-time you will only receive
the records for TR7 because you did not select a MODEL under the FRANCE node.
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The tree control populates each layer with values. For example, the following image
shows the REGION, ST, and CITY fields as a hierarchy of the GGSALES data source in
the tree control.

Note: A value must be selected for each layer before you can click the Save Selection
button.

If a selected value is specified for a field that is not in Layer1, then corresponding
selected values must also be specified for the preceding layers.

Only the first and second layers load at run time. If a selected value is specified for a
field in Layer1, only values from the first two layers will be selected.

How to Add a Tree Control to an HTML Page Using Static ValuesProcedure:

This procedure describes how to add static data type parameters for a tree control, where
the Number of layers property for the tree control is not set. This enables you to add a static
list of values.

1. In HTML Composer, insert a tree control by doing one of the following:

Click Single source Tree control from the Tree control drop-down list, located on the
Components toolbar.
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or

From the Insert menu, select Controls, then click Single source Tree control.

The cursor changes to a crosshair.

2. Drag the crosshair to create a tree control, and adjust it to the size you want.

A tree control is created in the layout and assigned the name treecontrol(n), where n is
a number. Additionally, the Properties and settings dialog box appears for the tree
control.

3. From the Properties and settings dialog box, select Static as the Data type.

Static is selected by default. You may select an item, delete it, or add a subitem.

4. Create the parameter values for the control:

Click the add value button to add a list of values. The values are added in a sequential
hierarchical structure. The last value added appears in the Value and Display Value
fields.
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To edit the value, manually type the desired value in the Value and Display Value
fields.

Select Append child item from the Static values drop-down list to append a value at
the level currently selected, and create a new value as the child of the selected value.
The following image shows an example. Note the number of the value.

Select Insert before from the Static values drop-down list to insert a value before the
selected value, as shown in the following example. Note the number of the value.
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Select Insert after from the Static values drop-down list to insert a value after the
selected value, as shown in the following example. Note the number of the value.

Repeat these steps until the list contains all of the values you want to include.

Optionally, click the Delete button to eliminate any values.

The following image shows the Properties and settings dialog box and the Static data
type options for a tree control.

5. Check the Selected check box to show the entry in the Value field as the default value.

6. Check the Send display value check box to send the display value, rather than the actual
data, to the parameter.

7. Save and run the page to populate the tree control with static values.
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How to Create a New Tree Control From the New Parameters Dialog BoxProcedure:

When a report contains one or more new amper variable parameters created in InfoAssist,
the New Parameters dialog box appears when you save the report and return to HTML
Composer. You can assign a new Single source or Multi source Tree control from the HTML
page to the parameter from the New Parameters dialog box.

For each parameter, you will find Name and Control Type fields, a Create control check box,
and options to set the Control Type to a Single source or Multi source Tree control.

1. From the Design tab of HTML Composer, import a report that contains a parameter.

When importing a report with parameters, the New Parameters dialog box appears
prompting you to create the control type.

2. Select the new tree control from the New Parameters dialog box.

The following image shows the ST parameters with Single source Tree control being
selected as the new control type for the parameter.

The Control Type column refreshes, showing the selected control.

3. Click OK to close the New Parameters dialog box.
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The report is added and the associated parameters are bound to the tree control, as
shown on the Parameters tab. As for any other type of input control, you can edit the
Properties and settings, chain controls, change the control type, and so on.

Usage Notes For Chaining Tree ControlsReference:

The following usage notes apply when chaining tree controls. You may chain controls from
the New Parameters dialog box and from the Parameters tab.

When the Multi source Tree control is a link in the chain, the New Parameters dialog box
enables you to share parameters with the same multi source control.
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For example, the following image shows the New Parameters dialog box that appears
when the first link in the chain, REGION, is a Multi source Tree control. When the Chain
control column is checked for the parameters, the remaining parameters, ST and CITY,
can share the tree control with the REGION parameter. Note that when parameters are
shared with the Multi source Tree control, the Create control column is unselected.

The result of sharing the new control with a Multi source Tree control appears as follows
from the Parameters tab. Note how the tree control shows multiple layers, chaining
REGION, ST, and CITY.

You can chain a Multi source Tree control to a Single source Tree control.
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For example, the following image shows the first layer of the Multi source Tree control
populated with Account_Type from Account Properties. The second layer is populated
with Accounts. The Multi source Tree is chained to the Single source Tree which is
populated with Account_Number from Account Properties.

You can chain a Single source Tree control to another Single source Tree control.
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For example, the following image shows an example of a Single source Tree control
populated with data. Treecontrol1 is populated with Accounts Member Caption and
treecontrol2 is populated with Account Type.

You can chain a Multi source Tree control to another Multi source Tree control.
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For example, the following image shows the New Parameters dialog box that shows two
Multi source Tree controls. The first tree control contains REGION, ST, and CITY. Note
that when parameters are shared with the Multi source Tree control, the Create control
column is unselected. The second tree control contains CATEGORY and PRODUCT. The
Chain control column is selected for all parameters, indicating that all the controls will
be chained.
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The result appears as follows from the Parameters tab. Note the first tree control,
treecontrol1, is a Multi source Tree control with three layers, containing REGION, ST, and
CITY. The second tree control, treecontrol2, is a Multi source Tree control containing two
layers, CATEGORY and PRODUCT. Treecontrol1 is chained to treecontrol2.

You can chain a tree control to another non-tree control, such as Drop down list or List
box.

192 IBM

Creating and Using Parameters in HTML Composer



For example, the following image shows the New Parameters dialog box that shows a
drop-down list and a Multi source Tree control. The drop-down list contains the CATEGORY
parameter. The Multi source Tree control contains the REGION, ST, and CITY parameters.
Note that when parameters are shared with the Multi source Tree control, the Create
control column is unselected. The Chain control column is selected for all parameters,
indicating that all the controls will be chained.
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The result appears as follows from the Parameters tab. The drop-down list, combobox1,
contains the CATEGORY parameters. treecontrol1 is a Multi source Tree control with
three layers, containing REGION, ST, and CITY. Combobox1 is chained to treecontrol1.

Chaining cannot be done with only field names.

Dynamic population of controls with field names need to use SYSCOLUMN calls.
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Tree Control Properties in the Properties WindowReference:

When a tree control is selected, the Properties tab in the Properties window contains options
that control the properties of tree controls.

Click a property to display a description of the selected property at the bottom of the
Properties window.

Select all children. The Select all children option, when set to Yes, makes it so that when
a parent is selected, all children are selected and when a parent is unselected, all children
are unselected. No is selected by default.

Note: The Number of layers property is not available in a single tree source property window.
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Using a Slider Control

How to:

Add a Slider Control

Change the Default Slider Bar

Reference:

Slider Control Properties in the Properties Window

You may add a slider control for numeric range values in a report or graph. This enables you
to use a slider bar to select from a range of values.

Note: When using a Slider control in a RIA page, you can drag the slider to any value. For
example, if a slider control is populated using a field whose only valid values are 2, 4, and
5, you can drag the slider to 1 and 3.

How to Add a Slider ControlProcedure:

1. Add a slider control by doing one of the following:

From the Components toolbar, click the Slider button. Next, select the slider direction
(Horizontal or Vertical), then select the slider type (Simple, Color Bar and Arrows or
Color Bar, Arrows Edit).

or

From the Insert menu, select Controls, then select Slider. Next, select the slider
direction (Horizontal or Vertical), then select the slider type (Simple, Color Bar and
Arrows or Color Bar, Arrows Edit).

The cursor changes to a crosshair.

2. Drag the crosshair to create a slider control, and adjust it to the size you want.

A slider control is created in the layout and assigned the name slider(n), where n is a
number.

Note: The slider control is determined by the default slider control type selected from
the HTML Page tab, located in the Developer Studio Options dialog box. For details about
changing the slider bar, see How to Change the Default Slider Bar on page 198.

3. Optionally, change the slider control properties by adjusting the properties displayed in
the Properties tab of the Properties window. For details, see Slider Control Properties in
the Properties Window on page 199.

4. Bind an existing parameter to the slider control.
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Binding a parameter to a slider control creates an incoming parameter. An incoming
parameter is a parameter that is bound to a control. The parameter value will populate
the slider control with values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the slider control with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the slider control object, and release the mouse to complete the binding.

To unbind the parameter from the slider control, select the arrow head on the line,
so that the line is bold, right-click, and select Break binding.

5. Bind the slider control to a parameter.

Binding the slider control to a parameter will populate the parameter with a range of
values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the range of values for the slider control. You can create a list of Static or
Dynamic range of values.

Note: If creating a Static Data type for the slider control, enter the minimum and
maximum values for the range in the Minimum and Maximum input fields. The Step
input field indicates how the numbers increment on the slider bar.

Close the Properties and settings dialog box to create the slider control with the
range of values.

Bind the slider control to a parameter. Select the center of the slider control, left-click
and drag the slider control to the center of the parameter object, and release the
mouse to complete the binding.
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6. Run the HTML page and use the slider bar to slide the values up or down. You may also
use the end arrows to increase or decrease the numbers in the range. The output is
generated based on the selected number from the slider bar.

How to Change the Default Slider BarProcedure:

The default slider type is determined from the HTML Page tab, located in the Developer
Studio Options dialog box.

1. To change the default slider type, select Options from the Window menu.

The Developer Studio Options dialog box opens.

2. Select the HTML Page tab.

3. Click the Form Settings button to open the Form Settings dialog box.

4. Use the drop-down list to change the default slider control type. You may select from:

Horizontal or Vertical Slider Simple bar. The slider bar has no end arrows, just a bar
with the slider.

Horizontal or Vertical Slider with Color Bar and Arrows. Arrows appear at each end
of the slider bar.
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Horizontal or Vertical Slider with Color Bar, Arrows, and Edit. Arrows and an edit box
appear at the end of the slider bar, showing the current value.

Once a slider control is inserted into HTML Composer, changing these options will not
affect the existing sliders. The option is only applied to new slider controls. To change
the existing slider bar type, delete the slider object and insert a new slider control.

Slider Control Properties in the Properties WindowReference:

When a slider control is selected, the Properties tab in the Properties window contains
options that control the properties of the slider control.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Adding a Dynamic Calendar

How to:

Set Calendar Properties

Reference:

Calendar Properties in the Properties Window

Date parameters can utilize a built-in calendar control that enables you to select the desired
date or range of dates in a pop-up dynamic calendar. A procedure that is added to or
referenced in HTML Composer and contains date parameters will have a Calendar control
type available in the Properties tab of the Properties window.

When the Calendar control type is selected, a text box with a calendar icon will display in
the Design view of the layout. The text box is the only control available for the calendar, and
the icon will always display to the right of the text box. The icon cannot be positioned
independently from the text box.

Note that when programmatically returning a date to the calendar, the date must be in a
Web Query date format that specifies the complete date from the list of supported data
types in Calendar Properties.

How to Set Calendar PropertiesProcedure:

1. Add a calendar by doing one of the following:

Click the Calendar button from the Components toolbar.

or

From the Insert menu, select Controls, then click Calendar.

The cursor changes to a crosshair.

2. Drag the crosshair to create a calendar and adjust it to the size you want.

A calendar placeholder is created in the layout and assigned the name calendar(n),
where n is a number.

3. Optionally, change the calendar properties by adjusting the properties displayed in the
Properties tab of the Properties window. For details, see Calendar Properties in the
Properties Window on page 206.

4. Bind an existing parameter to the calendar.
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Binding a parameter to a calendar creates an incoming parameter. An incoming parameter
is a parameter that is bound to a control. If binding a parameter to a calendar, the
parameter value must be in a Web Query date format that specifies the complete date
from the list of supported data types in Calendar Properties. The parameter value will
populate the calendar with date values.

Click the Parameters tab.

The Properties and settings dialog box opens.

Close the Properties and settings dialog box.

Close this dialog since you are populating the calendar with a parameter value.

Select the center of the parameter name object, left-click and drag the parameter to
the center of the calendar object, and release the mouse to complete the binding.

To unbind the parameter from the calendar, select the arrow head on the line, so
that the line is bold, right-click, and select Break binding.

5. Bind the calendar to a parameter.

Binding the calendar to a parameter will populate the parameter with a date value.

Click the Parameters tab.

The Properties and settings dialog box opens, showing the calendar setup options.
The calendar setup options enable you to set the range of dates available to the
user at run time. Available dates will be represented as an active hyperlink (blue and
underlined) and unavailable dates will be static (black without underlines).
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Note: The Properties and settings dialog box for a calendar will contain different
options depending on the selected data type.

Create the values for the calendar. You can create Static or Dynamic values.

When the Current/Start date option is checked, the current date will be used in the
calendar control at run time.

The Date Range options for setting up the calendar include:

Static. This option will set a static date range in which the developer will select
a start date and an end date using a pop-up calendar icon, or by clicking the
month, day, or year from the controls.
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The pop-up calendar  icon appears in the From and To sections when the
Static Date Range is selected. If you click the pop-up calendar icon, a pop-up
calendar appears and shows the current date selected and circled in red by default.
As you scroll through the calendar with the left/right arrows, the currently selected
day will remain highlighted for each month. Clicking a date will add that date to
the control. Dates can be selected by scrolling left to right, entering the month,
day, and year as text, or by selecting the month, day, and year from the drop-down
list and spin boxes.

Relative. This option allows you to set a specific number of days, months, and
years relative to the current date. The current date (at run time) will always be
the reference or starting point and the calendar will show a number of days,
months, and years relative to the current date. The range could be all in the past
(for example, five years prior to the current date) or all in the future (for example,
five years in the future). This is selected as the default Date Range.

Dynamic. This option allows you to point to a procedure that returns a range of
dates. Clicking the Select custom procedure browse (...) button allows the developer
to choose a preexisting procedure located in the current APP (data server) or
Domain (MR). The procedure must return two date values on the same data line
in XML format. The date values must be returned in a format that returns two
digits for the month and day, and four digits for the year, for example, MM/DD/YY.
For an example of returning a range of dates from a procedure, please see the
example shown later in this section.

Close the Properties and settings dialog box to create the calendar with the range
of date values.

Bind the calendar to a parameter. Select the center of the calendar, left-click and
drag the calendar to the center of the parameter object, and release the mouse to
complete the binding.

Date FormatsReference:

The date format can be displayed differently by selecting one of the available formats from
the Date format in data source drop-down list in the calendar controls Property and settings
dialog box. The format you select must match the format in the data source or the virtual
field, if that is the date field you are using. By default, it will match the format in the data
source.

The following date formats are available:
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Date FormatDisplay Date

(YMD)11/01/15

(DMY)15/01/11

(DMYY)15/01/2011

(MDY)01/15/11

(MDYY)1/15/2011

(YYMD)2011/01/15

(trMYY)January, 2011

(trMDYY)January 15, 2011

(tMDYY)Jan 15, 2011

(tDMYY)15 Jan, 2011

(wrMtrDYY)Wednesday, January 15, 2011

(YQ)11 Q1

(Y.M.D)11.01.15

(Y-M)11-01

(YBMBD)11 01 15

(YYM)2011/01

(MY)01/11

(YYQ)2011 Q1

(QYY)Q1 2011

(QY)Q1 11

(M)01

(Mt)Jan
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Date FormatDisplay Date

(Mtr)January

(Q)Q1

(YY)2011

(Y)11

(D)15

(W)1

(Wr)Wednesday

(wMtDYY)Wed, Jan 15, 2011

(wtDMYY)Wed, 15 Jan, 2011

(trDMYY)15 January, 2011

(wrtrDMYY)Wednesday, 15 January, 2011

Note: When using a format that is missing a component (such as the day in the MY format),
the missing component will be taken from the current days date.
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Calendar Properties in the Properties WindowReference:

When a calendar is selected in HTML Composer, the Properties tab in the Properties window
contains the properties of the selected calendar.

Click a property to display a description of the selected property at the bottom of the
Properties window.
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Using a Hidden Parameter Value

How to:

Add a Hidden Control

A hidden input control allows parameter values to be used in a control without the user
seeing them. When a hidden control is used, the current input control assigned to the
parameter will not be visible. The value of the parameter can be entered in the Properties
and settings dialog box of the Parameters tab, or supplied through chaining.

How to Add a Hidden ControlProcedure:

1. Add a hidden control by doing one of the following:

Click the Hidden control button from the Components toolbar.

or

From the Insert menu, select Controls, then click Hidden.

The cursor changes to a crosshair.

2. Drag the crosshair to create a hidden control and adjust it to the size you want.

A hidden control is created and assigned the name inputhidden(n), where n is a number.

A hidden control is not visible in the Design view of your layout. It is available as a control
object on the Parameters tab.

3. Optionally, change the hidden control properties by adjusting the properties displayed
in the Properties tab of the Properties window.

Select inputhiddenn from the Properties drop-down list. The Properties window contains
a hierarchical drop-down list of objects that are currently in the layout.

4. Bind the hidden control to a parameter.

Binding the hidden control to a parameter will hide the parameter value when you run
the HTML page.

Click the Parameters tab.

The Properties and settings dialog box opens.

Create the list of values for the hidden control. You can create a Static or Dynamic
value.

Note: If you are not seeing the value, you should set the list to evaluate to one value.
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Close the Properties and settings dialog box to create the hidden control with the
list of values.

Bind the hidden control to a parameter. Select the center of the hidden control,
left-click and drag the hidden control to the center of the parameter object, and
release the mouse to complete the binding.

5. To change an existing input control to a hidden control:

Select the input control on the Parameters tab.

Right-click and select Hidden from the Set Control Type context menu.

The input control is hidden on the control in the Design view and when you run the HTML
page.

6. To show a hidden control in the control:

Select the hidden control object from the Parameters tab.

Right-click and select the desired control from the Set Control Type context menu.

Tip: You may have to reposition the input control on the Design tab of the layout when
changing control types.

Creating Hyperlink Actions With Additional Parameters

How to:

Create a Hyperlink Action With Additional Parameters

When you manually add a new parameter on the Parameters tab, you may pass the parameter
variable to a hyperlink action. The additional parameters appear on the Hyperlink Properties
dialog box when you create a new action.

The Hyperlink Properties dialog box is available when you create a Hyperlink, Push button,
Frame, Image, and Submit button.

Note: When using Google Chrome™ and when a hyperlink action causes a report to be run
in a new window, the report will run in a new tab instead of a new window.

How to Create a Hyperlink Action With Additional ParametersProcedure:

1. Create a new parameter:

Right-click anywhere on the Parameters tab and select Add parameter.

The Properties and Settings dialog box opens.
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Enter the name for the parameter in the Name field, or keep the default name.

Optionally, you may use the Format field to define the format of the parameter, such
as A20 or D12.2.

If this field is left blank, it automatically applies the Alphanumeric format to the value
field.

Enter the parameter value information. Options are Single select, Multiselect OR, and
Multiselect AND.

These are static parameter options.

Close the Properties and settings dialog box to create an unbound parameter.

To bind the new parameter to a control, select the Design view and create an input
control. For example, insert a list box, drop-down list box, and so on.

Click the Parameters tab.

The Properties and settings dialog box appears for the control.

Close the Properties and settings dialog box.

Select the center of the parameter name object, left-click, and drag the parameter
to the center of the control object.

This makes it an incoming parameter that will populate the control. If the control will
populate the parameter, select the center of the control object, left-click and drag
the control object to the center of the parameter object.

Release the mouse to complete the binding.

The following image is an example of an incoming parameter.
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To modify the parameter value, right-click the parameter on the Parameters tab and
select Properties and settings.

Tip: You may also use the Undo and Redo buttons located on the Standard toolbar.
Note that undo/redo treats the entire Properties and settings dialog as one action.

2. From the Design view, create and open the Hyperlink Properties dialog box for the input
control to create the hyperlink action. For example, insert and right-click the Push Button
object and select Create hyperlink.

The Hyperlink Properties dialog box opens for the selected object.

3. Click the New button to create a new action.

The Additional parameters button appears on the Hyperlink Properties dialog box.

The Additional parameters button only appears if parameters were created from the
Parameters tab of HTML Composer.

4. Select the Action, Source, Target Type, and Target/Template Name for the hyperlink.

5. Click the Additional parameters button and select the parameter name(s) to pass in this
hyperlink.

6. Click OK to close the Hyperlink Properties dialog box.

If you are linking hyperlink properties to another page or procedure, HTML Composer
parses the other file for unresolved parameters and opens the New Parameters dialog
box.
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When you run the report and click the hyperlink, the action passes the parameter value to
the entity specified in the Source column of the Hyperlink Properties dialog box.

Binding a Button, Hyperlink, or Image to Populate a Control

How to:

Bind a Button to Populate a Control

You may bind a button, hyperlink, or image to a control on the Parameters tab in HTML
Composer. This enables you to dynamically repopulate the control with new values at run
time by clicking the button, hyperlink, or image.

For example, the following image shows a report with a custom list of static values for the
State field in a list box control. Clicking the button repopulates the list box control with a
dynamic list of state values, enabling you to select a state and run the report.
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How to Bind a Button to Populate a ControlProcedure:

Using information from the sample data source GGSALES, create a report with a state
parameter. A list box control shows a custom list of selected state values that you have
created. A push button, bound to the list box, repopulates the control and shows a dynamic
list of state values from the data source at run time. This enables you to selectively populate
the list box with static or dynamic values before running the report.

1. Create the HTML page.

Tip: The Gotham Grinds Sales data source (ggsales.mas) is available from the ibisamp
Applications on the localhost folder. You may copy this source file to the project directory
of your choice.

a. Select the HTML Files folder from your project in Developer Workbench.

b. Right-click and select New/HTML File.

The Add HTML File dialog box opens.

c. Type binding_button in the File name text box and click Open.

HTML Composer opens.

2. Create the Gotham Grinds sales report.

a. Select New Report from the Insert menu.

The cursor changes into a crosshair.

b. Drag the crosshair to create a reporting object and adjust it to the size you want.

c. Double-click the report placeholder.

The Open dialog box appears.

d. Select the ggsales Master File and click Open.

InfoAssist opens showing the field names for the ggsales data source.

e. Select By from the Columns toolbar.

Double-click the following field names: CATEGORY, PRODUCT, REGION, ST, CITY

f. Insert your cursor after the City field in the InfoAssist canvas, and select Sum from
the Columns toolbar.

g. Double-click DOLLARS to add it to the report.

3. Create a parameter for the ST field. This parameter will be populated from a static list
when you initially run the report on the HTML page.
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Click the Where/If button from the Columns toolbar.

The Report Options dialog box opens at the Where tab.

a.

b. Click Assist.

The Expression Builder opens.

c. Create a parameter for ST from the Expression Builder:

From the Fields list, double-click ST.

From the Logical Relations drop-down list, select equals.

In the Compare Type box, select Parameter.

Double-click the Compare Value box to open the Variable Editor.

Keep the default Name as ST.

Type By State in the Prompt field.

Keep the default Static list from the Accept List section.

Type the following states as the Display and Return Values, respectively:

California, CA, Georgia, GA, Illinois, IL, New York, NY.

Click OK to close the Variable Editor.

d. Click OK to close the Expression Builder.

e. Click OK to close the Report Options dialog box.

f. Select Close from the File menu to close InfoAssist.

g. When you are prompted to save your changes, click Yes.

You are returned to HTML Composer and the New Parameters dialog box appears.

h. Select List box from the Control Type ellipsis button and click OK to automatically
add the state parameter control to the HTML page.

4. Insert a button, hyperlink, or image object.

Adding a button, hyperlink, or image to the layout enables you to execute a request at
run time. For this example, insert a push button.

a. From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.

b. Drag the crosshair to create a push button and adjust it to the size you want.

IBM DB2 Web Query for IBM i 213

1. Using the HTML Composer



A push button is created in the layout and assigned the name button(n), where n is
a number.

c. Optionally, you may rename the text of the button by typing text in the Value property
field in the Properties window.

5. Add the button object to the Parameters tab.

a. Click the Parameters tab.

The Properties and settings dialog box opens, showing a Legend of the available
controls for the values on the HTML page.

b. From the Thumbnails tab, select the button object.

c. Left-click and drag the object onto the Parameters tab.

d. Release the mouse to move the object onto the Parameters tab.

The button object appears on the Parameters tab and the Properties and settings
for the button appear.

6. Bind the button object to the list box control.

Binding the button, hyperlink, or image to a control enables you to populate the control
with alternative code.

a. Select the center of the button object, left-click and drag the object to the center of
the list box control object, and release the mouse to complete the binding. A line
indicates the direction of the bind.

7. Create the properties and settings for the bound object.

a. Click the arrow head in the link of the chain between the button and list box control.

The Properties and settings dialog box enables you to create alternative code to
populate the list box at run time.

b. Create dynamic values for the state parameter.

Select Dynamic as the Data type.
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Keep the default Embedded procedure selected.

Click the browse button and double-click ggsales.mas from the Get source file
dialog box.

From the Value field, click the browse button and double-click ST.

The GGSALES data source is added as the Value and Display field, as shown in
the following image.

Close the Properties and settings dialog box.

8. Save and run the HTML page.
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Using the default list of static state fields, run the report.
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9. Click the push button to repopulate the list box with the dynamic state values from the
GGSALES data source. Note how the list of state values changed.

10. Select a state value from the list box and run the report.

Tip: Click the Refresh button to repopulate the list box with the default static values.

How to Use Controls to Populate Another Control Based on Selected ValuesProcedure:

In this procedure, you will create multiple list box controls that will all have parameters bound
to them. When the appropriate combination of these four parameters is selected, the fifth
list box control will be populated with the related information.

1. Create a procedure, using the car Master File, named countrycars.fex.

2. In the procedure:

a. Insert two COUNTRY fields, Sum FST.COUNTRY BY COUNTRY.

This ensures that you get each value of country one time and in sorted order.

b. Create selection tests comparing CAR to &Parameter1, MODEL to &Parameter2,
DEALER_COST to &Parameter3, and RETAIL_COST to &Parameter4.

c. Set the output format for this procedure to XML.

3. Save and close the procedure.

4. Create a new HTML file named cars.htm.

5. In the HTML file, create a new, Single Layer Form.
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6. Delete the Submit Form button, as shown in the following image.

7. Create four list boxes inside the form and one list box outside the form, as shown in
the following image.

8. In the Properties and Settings dialog box, change Selection Required to Yes for all four
list boxes inside the frame.

9. Insert labels for each list box. Name the four inside the form, Parameter1, Parameter2,
Parameter3, and Parameter4. Name the list box on the outside Result.

10. Select the Parameters tab at the bottom of the HTML Composer window.

11. Add four parameters to the file, as shown in the following image.
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12. Bind listbox1 to Parameter1, listbox2 to Parameter2, listbox3 to Parameter3, and listbox4
to Parameter4, as shown in the following image.

13. Bind listbox1, listbox2, listbox3, and listbox4 to listbox5, as shown in the following
image.

14. Edit the properties of listbox1, listbox2, listbox3, and listbox4.

a. Select the Dynamic Data type option for all four list boxes.

b. Select Embedded procedure for all four list boxes.

c. Click the procedure ellipsis button (...) and select car.mas for all four list boxes.

d. Set the Value field for listbox1 to CAR; for listbox2, MODEL; for listbox3,
DEALER_COST; and for listbox4, RETAIL_COST.

15. Edit the properties of listbox5.

a. Select the Dynamic Data type option.

b. Select External procedure.
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c. Click the procedure ellipsis button (...) and select countrycars.fex.

d. If it is not set already, set the Value field for listbox5 to COUNTRY.

16. Edit the binding properties for each of the bindings between listbox1, listbox2, listbox3,
and listbox4 to listbox5.

a. Select the Dynamic Data type option.

b. Select External Procedure.

c. Click the procedure ellipsis button (...) and select countrycars.fex for all four bindings.

The Value field and Display field are assigned the COUNTRY field upon the selection
of the procedure.

d. Change Resolves Parameter to the appropriate parameter for that list box.

For example, listbox1 is bound to Parameter1. Therefore, you should select
Parameter1 for the Resolves Parameter field.

17. Save and run the report.

A new web browser window opens with four populated list boxes and one empty list box.

18. For Parameter1, select ALFA ROMEO. For Parameter2, select 2000 4 DOOR BERLINA.
For Parameter3, select 4,915. And for Parameter4, select 5,925.

Listbox5 is populated with the value, ITALY, as shown in the following image.

Note: Only when the appropriate combination of values are selected does the result
display. If you were to choose 5,610 for Parameter4, no result would be displayed.
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Supplying Parameter Values to External Reports

How to:

Supply Parameter Values to External Reports With a Push Button

Supply Parameter Values to an External Report With an Image

Supply Parameter Values to an External Report With a Hyperlink

Supply a Parameter Value to a Report Using a URL

Pass a Parameter From One Page to Another

You can supply parameters to external reports the same way you apply them to reports
created with InfoAssist. The HTML page can also contain multiple reports associated with
a common set of parameters. Launch mechanisms such as a push button, hyperlink, or
image can be associated to external reports that contain different sets of parameters. You
can also update and target parameters for an external report to a frame or window directly
within your HTML page.

Before you can supply parameter values to an external report, you must create a hyperlink
to the report and associate a launch mechanism to it. After you associate a launch
mechanism, such as a push button, hyperlink, or image, to the external report, the report
layout is populated with the parameters.

How to Supply Parameter Values to External Reports With a Push ButtonProcedure:

In this procedure, you will create a push button to launch an external report and target the
output to a window.

1. From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.

2. Drag the crosshair to create a push button and adjust it to the size you want.

3. Right-click the button and select Create hyperlink.

The Hyperlink Properties dialog box opens.

4. Specify the text you want to display as the hyperlink in the Display Text input field.

5. To set the action of the hyperlink to execute an external report, select the New button,
then select External procedure from the Action drop-down list.

6. Enter the external report procedure name in the Source field, or click the browse (...)
button to browse to the procedure.

IBM DB2 Web Query for IBM i 221

1. Using the HTML Composer



7. Optionally, direct the output to a specific location by selecting Window or Frame in the
Target Type field.

8. Specify the Target/Template Name for the target frame or window.

9. Click OK.

The parameters for the report are automatically added to objects in the layout and
displayed in the Parameters tab.

10. From the File menu, click Run.

11. Click the push button to view the external report.

The report opens in a separate window as you specified in the Hyperlink Properties
dialog box for that push button.

How to Supply Parameter Values to an External Report With an ImageProcedure:

In this procedure, you will insert an image that will launch an external report when you click
it. You will target the output to a window.

1. From the Insert menu, select Components, then click Image.

The cursor changes into a crosshair.
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2. Drag the crosshair to position the image.

The Get source file dialog box opens.

3. Navigate to the image using the Look in drop-down list, select the image, and click Open.

4. Adjust the image to the desired size and location.

5. Right-click the image and select Create hyperlink.

The Hyperlink Properties dialog box opens.

6. To set the action of the hyperlink to execute an external report, select the New button,
then select External procedure from the Action drop-down list.

7. Enter the external report procedure name in the Source field, or click the browse (...)
button to browse to the procedure.

8. Direct the output to a window by selecting Window in the Target Type field.

9. Specify the Target/Template Name for the target frame or window.

10. Click OK.

The parameters for the report are automatically added to objects in the layout and
displayed in the Parameters tab.

11. From the File menu, click Run.

12. Click the image to view the external report.
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The report opens in the window you specified in the Hyperlink Properties dialog box for
that hyperlink.

How to Supply Parameter Values to an External Report With a HyperlinkProcedure:

In this procedure, you will create a frame and target report output from an external report
to it. You will also create a hyperlink to launch the external report.

1. From the Insert menu, select Components, then click Frame. Drag the crosshair to create
a frame and adjust it to the size you want. Enter a name for the frame by double-clicking
the Name field in the Properties tab of the Properties window.

2. From the Insert menu, select Components, then click Hyperlink. Drag the crosshair to
create a hyperlink and adjust it to the size you want.

The Hyperlink Properties dialog box opens.

3. Specify the text you want to display as the hyperlink in the Display Text input field.

4. To set the action of the hyperlink to execute an external report, select the New button,
then select External procedure from the Action drop-down list.

5. Enter the external report procedure name in the Source field, or click the browse (...)
button to browse to the procedure.

6. Direct the output to the frame you inserted by selecting Frame in the Target Type field.

7. Select the name of the frame you created from the Target/Template Name drop-down
list.
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8. Click OK.

The parameters for the report are automatically added to objects in the layout and
displayed in the Parameters tab.

9. From the File menu, click Run.

10. Click the hyperlink to view the external report.

The report opens in the frame you specified in the Hyperlink Properties dialog box for
that hyperlink.

Supplying Parameter Values to Multiple External ReportsExample:

In this example, you will add two reports to a layout. You will associate a push button to
one report and target the output to a window. You will associate a hyperlink to the second
report and target the output to a frame.

1. From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.

2. Drag the crosshair to create a push button and adjust it to the size you want.

A push button is created in the layout and assigned the name button(n), where n is a
number.

3. Right-click the button, and select Create hyperlink.

The Hyperlink Properties dialog box opens.
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4. Type Run report in the Display Text input field.

5. Set the action of the hyperlink to execute a report by clicking the New button and selecting
External procedure from the Action drop-down list.

6. Enter the external report procedure name in the Source field, or click the browse (...)
button to browse to the procedure.

7. In the Target Type field, select Window from the drop-down list.

8. In the Target/Template Name field, select New window frame from the drop-down list.

9. Click OK.

The parameters for the first report are automatically added to objects in the layout and
displayed in the Parameters tab.

10. From the Insert menu, select Components, then click Frame. Drag the crosshair to create
a frame and adjust it to the size you want.

11. Double-click the Name field in the Properties tab of the Properties window and enter
frame1.

12. From the Insert menu, select Components, then click Hyperlink. Drag the crosshair to
create a hyperlink and adjust it to the size you want.

The Hyperlink Properties dialog box opens.

13. Type Run report 2 in the Display Text input field.

14. Set the action of the hyperlink to execute a report by clicking the New button and selecting
External procedure from the Action drop-down list.

15. Enter the external report procedure name in the Source field, or click the browse (...)
button to browse to the procedure.

16. In the Target Type field, select Frame from the drop-down list.

17. In the Target/Template Name field, select the name of the frame you created (frame1).

18. Click OK.

19. From the File menu, select Run.

20. Click the push button to view the first external report.
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The report opens in a separate window as specified in the Hyperlink Properties dialog
box for that push button.
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21. Click the hyperlink to view the second external report. The report opens in the frame you
specified in the Hyperlink Properties dialog box for that hyperlink.

How to Supply a Parameter Value to a Report Using a URLProcedure:

In this procedure, you will create a report within an HTML page where you can pass a
parameter to the report, directly from a URL.

1. Using InfoAssist in the Data Servers area of Developer Workbench, create a procedure
using the car Master File.

a. Print the COUNTRY, CAR, DEALER_COST, and RETAIL_COST fields.

b. Assign the COUNTRY field to a parameter named Parameter1.

2. Save and close the procedure.

3. Create a new HTML file named pass_on_url.htm.

4. In the HTML file, create a new report.

5. Right-click the report frame and select Reference existing procedure.

The Get source file dialog box opens.

6. Select the procedure you created in step 1.
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The New Parameters dialog box opens, as shown in the following image.

7. Click Cancel.

The page now has a report that requires a parameter but has no parameter value
supplied.

8. Click Save, to save the HTML file.

9. Type the following into the address bar of a new web browser window:

http://localhost:8080/approot/appname/pass_on_url.htm?Parameter1=ITALY

where:

appname

Is the name of the application that contains the HTML page.

Parameter1=ITALY

Sets Parameter1, which had no previous value, to ITALY.

10. Press the Enter key.
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The report runs for the value of ITALY, as shown in the following image.

How to Pass a Parameter From One Page to AnotherProcedure:

In this procedure, you will create an HTML file that contains a list box and a button. The
HTML file can pass a parameter from one webpage to another.

Note: You will use the file, pass_on_url.htm, created in the procedure How to Supply a
Parameter Value to a Report Using a URL on page 228. This is the webpage to which the
parameter will be sent.

1. Create a new HTML file named pass_on_page.htm.

2. In the HTML file, create a List Box, as described in How to Add a List Box on page 146.

3. Select the Parameters tab at the bottom of the HTML Composer window.

4. Right-click and select Add parameter.

A new parameter is added to the HTML file. This parameter is named Parameter1 by
default, as shown in the following image.

5. Click the newly created Parameter1 and in the Properties and settings dialog box, type
A10 in the Format field.

A10 is the format of COUNTRY, the field used in pass_on_url.htm.
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6. Bind listbox1 to Parameter1, as shown in the following image.

7. Select listbox1 and perform the following actions.

a. In the Properties and settings dialog box, select the Dynamic option.

b. Click the procedure ellipsis button (...) and select car.mas.

c. Click the ellipsis button (...) for the Value field. Populate listbox1 with the COUNTRY
field.
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The Properties and settings dialog box for listbox1 will look similar to the following image.

8. Select the Design tab at the bottom of the HTML Composer window.

9. In the HTML file, create a new Push Button.

10. Right-click the button and select Create Hyperlink.
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The Hyperlink Properties dialog box opens, as shown in the following image.

11. Create a new hyperlink with the following properties.

Action set to HTML File.

Source set to the file, pass_on_url.html, which was created in the previous procedure.

Target Type set to Window.

Target/Template Name set to New window.
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The new hyperlink settings are shown in the following image.

12. While still in the Hyperlink Properties dialog box, click Additional parameters.

A small window opens, containing only Parameter1, as shown in the following image.

13. Double-click Parameter1.

The window closes.
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This step tells HTML Composer that Parameter1 should be passed on the hyperlink.

14. Click OK in the Hyperlink Properties dialog box.

15. Run the page.

16. Select ENGLAND from the list box and click the button, as shown in the following image.

The report runs, showing the records for ENGLAND, as shown in the following image.

The value was passed from the first page to the second page.

Styling Your Layout

In this section:

Adding a CSS or Script to the Layout

Setting HTML Page Properties

Customizing the Layout

When you create an HTML page in HTML Composer, the objects in the layout will display in
your browser using the default browser styles. You can customize the appearance of your
HTML page by adding a theme or template. You can also use the predefined templates
available through the Template selector. The theme property is available from the Properties
window of the DOCUMENT object.
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Adding a CSS or Script to the Layout

How to:

Add a CSS or Script to the Layout

Cascading Style Sheets (CSS) or scripts can be added to your layout to determine the look
of the webpage. This is a good way to quickly apply corporate styling to your layout or to
assign global styling to a layout. It is also an easy method of assigning default styling to all
elements in the entire layout with one action. Styling included in a CSS or script will display
only in Preview mode.

Note:

If you modify a Cascading Style Sheet that is already added to your layout, you can refresh
the layout to display your changed by pressing the F5 key.

HTML Composer assigns internal CSS class names to all objects. These class names
are used in all of the packaged themes. It is recommended that you use these class
names when creating your own CSS files so that objects are styled correctly. In order for
user CSS files to be honored, you must assign a theme to a page. Once a theme has
been assigned the user CSS files will override that theme. If the user specifies the <Not
Set> value for the DOCUMENT object Theme property, the CSS classes will not be honored
and no styling will occur.

How to Add a CSS or Script to the LayoutProcedure:

1. From the Insert menu, select CSS/Scripts.

The Insert Web Files dialog box opens.

2. Click the New button and navigate to the directory, in which your CSS or script resides.
Select the file, and click Open.

Note: You may also specify a fully-qualified URL or a relative URL that points to a
stylesheet file or script file by entering it in the File name area. A fully-qualified URL must
start with http:// or https://. A relative URL must start with a known context root that
DB2 Web Query uses, such as /approot/appname/scriptname.js.

3. Add additional files if desired. Click OK to add the specified files.
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Setting HTML Page Properties

Reference:

HTML Page Properties in the Properties Window

You can set properties for the HTML page you create in HTML Composer in the Properties
tab of the Properties window.

Properties set for the HTML page will be inherited by most objects added to the layout. Once
a style has been changed for an object in the layout, it cannot be styled with a template or
theme. It is recommended that global styling of HTML page be set before properties are set
for individual objects.
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HTML Page Properties in the Properties WindowReference:

When the background of a report is selected, the Properties tab in the Properties window
contains options that control the body of the HTML page.

Click a property to display a description of the selected property at the bottom of the
Properties window.

Customizing the Layout
All changes to your layout can be made in the Design view of HTML Composer or HTML
editor. The changes made to a layout in an editor will be preserved when you reenter HTML
Composer.
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Specifying Browser Defaults With the Style Composer

How to:

Access the Style Composer

Reference:

Specifying Font Styles Using the Style Composer

Specifying Background Properties Using the Style Composer

Specifying Text Styles Using the Style Composer

Specifying Position Mode Using the Style Composer

Specifying Layout Styles Using the Style Composer

Specifying Edge Styles Using the Style Composer

Specifying List Styles Using the Style Composer

Specifying Interface Effects Using the Style Composer

You can use the Style Composer to control default settings for font, background properties,
position mode, flow control, margins, list styles, and visual effects.

Note: On the following pages, the images of the Style Composer windows show many blank
fields. You may actually see the words Not Set populated in these blank fields when viewing
these Style Composer windows in Developer Workbench.

How to Access the Style ComposerProcedure:

To access the Style Composer, complete the following steps.

1. Right-click the background of an HTML page in HTML Composer.

2. From the context menu, select Style.
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The Style Composer window opens.

Specifying Font Styles Using the Style ComposerReference:

To specify the font styles that will be used in the browser for your HTML report, make your
selections in the Font window of the Style Composer.

The Font window of the Style Composer is comprised of the following elements:

Font name

Determines the font displayed in a browser.

You can specify: Family (launches the Font Picker dialog box) or System Font.

240 IBM

Creating and Using Parameters in HTML Composer



Font attributes

Determines the attributes of the font displayed in a browser.

The options include: Color, Italics, Small Caps.

Size

Determines the size of the font displayed in a browser.

The options include: Specific, Absolute, Relative.

Bold

Determines whether the font is displayed as bold in a browser.

The options include: Absolute, Relative.

Effects

Determines whether the font effects are displayed in a browser.

The options include: None, Underline, Strikethrough, Overline, Capitalization.
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Specifying Background Properties Using the Style ComposerReference:

To specify the background styles that will be used in the browser for your HTML report, make
your selections in the Background window of the Style Composer.

The Background window of the Style Composer is comprised of the following elements:

Background color

Determines the background color of the HTML page.

You can specify: Color, Transparent.

Background image

Determines the properties of the background image displayed in a browser.

The options include: Image, Tiling, Scrolling, Position (Horizontal and Vertical), Do not use
background image.
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Note: When using a background image with scrolling enabled, you must specify the
horizontal and vertical positions. If you do not specify these positions, your background
image will not show. The horizontal and vertical positions are relative to window and not
the individual element.

Specifying Text Styles Using the Style ComposerReference:

To specify the text styles that will be used in the browser for your HTML report, make your
selections in the Text window of the Style Composer.

The Text window of the Style Composer is comprised of the following elements:

Alignment

Determines the alignment of a text.

You can specify: Horizontal, Vertical, Justification.
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Spacing between

Determines the spacing.

You can specify spacing between the following text elements: Letters, Lines.

Text flow

Determines the flow of the text.

You can specify: Indentation, Text direction.

Specifying Position Mode Using the Style ComposerReference:

To specify the position mode that will be used in the browser for your HTML report, make
your selections in the Position window of the Style Composer.
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The Position window of the Style Composer is comprised of the following elements:

Position Mode

From which you can specify: Position in normal flow, Offset from normal flow, Absolutely
position.

Height/Width

When Absolutely Position is selected, you can specify position indicators in the
measurements.

You may specify: Top, Left, Z-Index.

Note: Z-Index is optional. It sets or retrieves the stacking order for absolute or relatively
positioned objects.
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Specifying Layout Styles Using the Style ComposerReference:

To specify the layout styles that will be used in the browser for your HTML report, make your
selections in the Layout window of the Style Composer.

The Layout window of the Style Composer is comprised of the following elements:

Flow control

From which you can specify: Visibility, Allow text to flow, Display, Allow floating objects.

Content

From which you can specify: Overflow.

Clipping

From which you can specify whether or not to clip the layout from the following positions:
Top, Bottom, Left, Right.
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Printing page breaks

From which you can specify: Before, After.

Specifying Edge Styles Using the Style ComposerReference:

To specify the margins, padding, and border styles that will be used in the browser for your
HTML report, make your selections in the Edges window of the Style Composer, which is
shown in the following image.

The Edges window of the Style Composer is comprised of the following elements:

Margins

From which you can specify: Top, Bottom Left, Right margins.

Padding

From which you can specify: Top, Bottom, Left, Right padding.
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Borders

From which you can specify: Select the edge to be changed, Style, Width, Color.

Note: Borders are displayed as a single line in the Style Composer preview window, regardless
of whether you select a single line or double line border. Borders are accurately displayed
in the Style Composer Design view and in the HTML output of an application.

Specifying List Styles Using the Style ComposerReference:

To specify the list styles that will be used in the browser for your HTML report, make your
selections in the Lists window of the Style Composer.

The Lists window of the Style Composer is comprised of the following elements:

Lists

From which you can specify: Bulleted, Unbulleted.
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Bullets

From which you can specify: Style, Position, Custom bullet.

Specifying Interface Effects Using the Style ComposerReference:

To specify the interface styles and visual effects that will be used in the browser for your
HTML report, make your selections in the Other window of the Style Composer.

The Other window of the Style Composer is comprised of the following elements:

User interface

From which you can specify: Cursor.

Tables

From which you can specify: Borders, Layout.
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Laying Out Objects With HTML Composer

In this section:

Setting Relationships Between Objects

You can change the size and position of objects in your layout in the following ways:

Set relationships between objects. This is done by setting relationships between objects
and a controlling, or dominant, object. The controlling object is the last object selected.
For details, see Setting Relationships Between Objects on page 250.

Click and drag with your mouse.

Copy and paste objects.

Setting Relationships Between Objects

How to:

Set Object Size

Set the Distance Between Objects

Break Relationships

Group Objects on the HTML Page

Reference:

Positioning Toolbar

Utilities Toolbar

You can set relationships between underlying objects and a controlling, or dominant, object.
The controlling object is the last object or placeholder selected. You can use these
relationships to set properties of the selected objects according to the controlling object.
Any object on the HTML page layout can be the controlling object.

You can set the following types of relationships:

Relationships that maintain a distance between objects. This is useful since a report or
graph may take up more or less room when your procedure is run than is accounted for
in the layout. When setting relationships between objects in this way, you should select
the corners of the objects that are closest to each other. This will ensure that the reports
do not overlap if either report takes up more room than anticipated.
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Relationships that affect the positioning of objects. This allows you to ensure that objects
remain aligned regardless of a change in size or position of one of the objects and that
objects remain the same size even when the size of an object is changed.

How to Set Object SizeProcedure:

1. Highlight multiple objects with your mouse by holding the Shift key to select items
contiguously, or the Ctrl key to select items non-contiguously. The controlling object is
the last object selected.

The size buttons on the positioning toolbar are active.

2. Click the button in the positioning toolbar that corresponds to what you want:

Make same width sets the width of the highlighted objects to the width of the
controlling object.

Make same height sets the height of the highlighted objects to the current height of
the controlling object.

Make same size sets the height and width of the highlighted objects to the height
and width of the controlling object.

All selected objects change in size according to the size of the controlling object. If an image
becomes distorted when you resize it, you can restore its original size. Right-click the image,
and select Restore size. Images are not distorted when clicking and dragging their borders.
This maintains their native aspect ratio.

How to Set the Distance Between ObjectsProcedure:

1. Highlight multiple elements with your mouse holding the Shift key to select items
contiguously, or the Ctrl key to select items non-contiguously. The controlling object is
the last object selected.

2. Click the button in the positioning toolbar that corresponds to the relationship you want.
The position of the selected object will be set according to the controlling object, which
is the last object selected. The options are:

Relate Top_Left maintains the distance between the top-left corner of the controlling
object and the top-left corners of the highlighted objects.

Relate Top_Right maintains the distance between the top-right corner of the controlling
object and the top-left corners of the highlighted objects.

Relate Bottom_Right maintains the distance between the bottom-right corner of the
controlling object and the top-left corners of the highlighted objects.
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Relate Bottom_Left maintains the distance between the bottom-left corner of the
controlling object and the top-left corners of the highlighted objects.

For details on the buttons in the positioning toolbar, see Positioning Toolbar on page
252.

How to Break RelationshipsProcedure:

Click Break a relationship  from the Positioning toolbar.

How to Group Objects on the HTML PageProcedure:

You may group objects together on an HTML page by inserting a group box, panel, or form.
You can copy and paste components (such as images, push buttons, and so on) between
the HTML page and the grouping object while maintaining the association to the grouping
object or the page.

1. Insert a grouping object on the HTML page, and select Form or Panel from the
Components submenu of the Insert menu or Group Box from the Controls sub-menu of
the Insert menu.

The cursor changes into a crosshair.

2. Drag the crosshair to create the grouping object on the HTML page.

3. Right-click the component(s) to be copied and select Copy.

4. Right-click the grouping object and select Paste.

The component is copied into the grouping object as a new object. For example, button1
copied from the HTML page appears as button2 in the grouping object. The original,
button1 is still associated with the HTML page, whereas button2 is associated with the
grouping object.

5. To delete a grouping object, right-click the grouping object and select Delete.

When deleting a grouping object, the associated components are also deleted.

Positioning ToolbarReference:

The positioning toolbar contains the buttons listed in the following table.

For buttons that use relationships, the relationship is controlled by the controlling object,
or dominant object, which is the last object or placeholder selected. These buttons are only
highlighted when more than one object is selected.
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DescriptionButton

Toggles the grid on and off. Use the grid to assist in lining up objects
in the layout. This button is recessed when the grids are enabled.

Toggle visibility shows hidden objects.

The hidden visibility option is set in the Layout section of the Style
Composer.

Specifies Tab Order.

Aligns the left edge of the highlighted object with the left edge of the
controlling object.

Aligns the right edge of the highlighted object with the right edge of the
controlling object.

Aligns the top edge of the highlighted object with the top edge of the
controlling object.

Aligns the bottom edge of the highlighted object with the bottom edge
of the controlling object.

Aligns objects at the horizontal center point of the canvas in Design
view.

Aligns objects at their vertical center (or middle) point of the canvas in
Design view.

IBM DB2 Web Query for IBM i 253

1. Using the HTML Composer



DescriptionButton

Sets the width of the highlighted objects to the width of the controlling
object.

Sets the height of the highlighted objects to the current height of the
controlling object.

Sets the height and width of the highlighted objects to the height and
width of the controlling object.

Maintains the distance between the top-left corner of the controlling
object and top-left corners of the highlighted object.

Maintains the distance between the top-right corner of the controlling
object and the top-left corners of the highlighted object.

Maintains the distance between the bottom-right corner of the
controlling object and the top-left corners of the highlighted object.

Maintains the distance between the bottom-left corner of the controlling
object and the top-left corners of the highlighted object.

Breaks the relationship set between highlighted objects. This button
is only highlighted when selected objects have relationships set.
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DescriptionButton

Toggles the display of arrows illustrating the relationships between
objects. This button is only highlighted when selected objects have
relationships set. This button will stay highlighted when relationships
are displayed. It will not be highlighted when relationships are not
displayed.

Utilities ToolbarReference:

The Utilities toolbar contains the buttons listed in the following table.

DescriptionButton

Adds a control to a chain. Each time a selection is made, all chained
controls will be dynamically updated. For details about chained controls,
see Chaining Controls for Dependencies.

Note: The Add to current chain button is available when controls are
multiselected on the Design tab or Parameters tab. This button is
disabled if you multiselect controls that are already in a chain.

Removes a control from a chain. For details about chained controls,
see Chaining Controls for Dependencies.

Note: The Remove from current chain button is available when controls
are multiselected on the Design tab or Parameters tab. This button is
disabled for the first control in a chain, but enabled for all others.

Synchronizes a report/graph object to an active report when using
active dashboards. For more information, see Creating Active
Dashboards With the HTML Composer.

Shows the synchronized report groups when working with active
dashboards. For more information, see Creating Active Dashboards With
the HTML Composer.
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Controlling the HTML Composer Environment

How to:

Set Page Properties

Select Form Settings From the HTML Page Tab

Reference:

HTML Page Tab

Form Settings Dialog Box

You can set properties for HTML Composer with the HTML Page tab, located in the Developer
Studio Options dialog box. The HTML Page tab enables you to set page properties such as
the location of reports and graphs, the display of a grid in your layouts, the default form
type, and setting the default caching option for the HTML page. The changes that are made
in the HTML Page tab are saved to the registry. This allows a customized environment to be
created for various users.

How to Set Page PropertiesProcedure:

1. Select Options from the Window menu.

The Developer Studio Options dialog box opens.

2. Select the HTML Page tab.

For more information about the HTML Page tab, see HTML Page Tab on page 259.

3. Make your changes, and click OK.

How to Select Form Settings From the HTML Page TabProcedure:

1. Select Options from the Window menu.

The Developer Studio Options dialog box opens.

2. Select the HTML Page tab.

3. Click the Form Settings button.

The Form settings dialog box opens.

4. Select the orientation for the form object in the layout.

5. Use the spin buttons to increase or decrease the distance between the prompt, horizontal
and vertical controls of the form, and the number of columns for the form.
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or

Position the cursor in the input box and type a number.

6. Use the slider control type options to select how the slider bar appears.

Slider bars are available when using numeric range value parameters in your report or
graph.

7. Use the Add schedule button option to add a schedule button for referenced procedures
with parameters if your DB2 Web Query environment is licensed to use Report Broker.
For more information, see Adding Report Broker Schedule Capability to HTML Composer
on page 265.

8. Start each chain on a new line to create multiple chains from the New Parameters dialog
box. Each set of chained parameters appears on new line of the Design tab, regardless
of the grouping option selected from the New Parameters dialog box.

Start each chain on a new line is selected by default.

For example, the following image shows the default behavior where the first chain (Product
Category and Product Type) is shown on one line and the second chain (Product Number,
Plant, Year) start on a new line. This enables you to see the relationship of the chains
within the form.

9. Click OK to close the Form Settings dialog box.

The form settings are applied and shown in the HTML Composer Design view.

10. To reset the default form settings, right-click the form object and select AutoArrange
from the context menu.
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Note: The AutoArrange option is only available when using a multiple layer form type.

The form is auto arranged on the layout, using the default form settings.
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HTML Page TabReference:

The following options are available from the HTML Page tab, located in the Developer Studio
Options dialog box.

Grid Settings

Show Grid 

Displays a grid. If this is not selected, the grid is turned off for all layouts.

Snap to Grid 

Causes objects in the layout to snap to grid lines when being positioned. For detailed
positioning, deselect this option.

Width 

The width of the grid in pixels.
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Height 

The height of the grid in pixels.

Preview Settings

Report and Graph Preview

Previews report and graph data in the Design view. If checked, additional options are
available (Simulated Data or Live Data).

This option is selected by default.

If unchecked, icons are used to represent the area in the Design view for reports and
graphs. This is the fastest method of loading reports since no request are made to the
server.

Simulated Data

Selecting to preview simulated data sends a request to the reporting server that gathers
formatting information from the Master File. The database is not accessed, but rather
mock data is used to visually represent the report.

This option is only available when previewing reports and graphs.

Live Data

Selecting to preview live data sends a request to the reporting server, and to the
database, to get a snapshot of the actual data in the report.

This option is only available when previewing reports and graphs.

Record limit for reports

Enables you to limit the number of records used to gather data for previewing the report
in live data mode. For example, if you set 500 as the record limit for the report, then
500 rows of data are gathered for the report results.

This option is only available if the Live Data option is selected.

Record limit for input controls

Sets the number or records to be shown for the input controls when gathering data for
reports and graphs.

This option is only available if the Live Data option is selected.
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Use Prefix

Selecting Use Prefix will take any Web Query syntax in the input box and apply it to the
components at preview time. For example, SQL SQLORA SET OPTIMIZATION OFF. Since
the settings are saved for all documents, you can select the Use Prefix option to indicate
to the tool whether or not to use the prefix for the specific document.

Form type

Sets the default form type in the parameter grouping options of the New Parameters
dialog box. Form types are None, Single layer, or Multiple layer.

When None is selected, the parameter grouping option shows Do not create a form
on the New Parameters dialog box.

When Single layer is selected, the parameter grouping option shows New single layer
form on the New Parameters dialog box. The single layer form contains all of the
elements within a single group box.

Single layer is the default form type.

When Multiple layer is selected, the parameter grouping option shows New multiple
layer form on the New Parameters dialog box. The multiple layer form contains group
boxes around each element in the form. You may move and resize each element of
the control.

You may override the set form type on the HTML Page tab from the Parameter grouping
options drop-down list of the New Parameters dialog box. For details, see Automatically
Creating Controls From the New Parameters Dialog Box on page 125.

Form settings

Options are available so that you may customize how the forms are populated and
arranged in the document. For details, see Form Settings Dialog Box on page 263.

Show 'New Parameters' dialog

Controls whether or not the New Parameters dialog box shows when adding parameters
in HTML Composer.

The New Parameters dialog box is shown by default.

Show 'Template Selector' dialog

Controls whether or not the Template selector dialog box shows when a new HTML page
is created using HTML Composer.

Activate 'Unlock Template' option

Controls whether to add an unlock icon to the toolbar when a template is in use.
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Default caching option

Controls whether cache run time data is on or off for the HTML page. The default is off.

When adding dynamic parameters to the HTML page, input controls retrieve data using
procedures. You may cache the run time data for input controls by using the cache run
time option on the Properties and settings dialog box in the Parameters tab. This setting
overrides the Default caching option from the HTML Page tab. For more information about
the Parameters tab, see Creating a Dynamic List of Values on page 92.

Auto Arrange Objects

Automatically arranges the objects on the Parameters tab so that they take the least
amount of space without overlapping each other. Auto Arrange is on by default.

If this option is turned off, you may auto arrange objects directly from the Parameters
tab. Right-click anywhere on the Parameters tab and select AutoArrange from the context
menu.

Refresh thumbnails every

Automatically refreshes the content on the Thumbnail tab of the Properties window, every
20 seconds by default. You may change the time interval of the automatic refresh.

Default Theme

You can set the default theme for a new HTML page. The Information Builders theme is
chosen by default.

The following is the list of themes that you can use.

Information Builders

Black

Blue

Green

Orange

Purple

Red

Silver

Teal

Plain

Yellow red

262 IBM

Creating and Using Parameters in HTML Composer



Beige blue

Dramatic blue

Neutral gray

Light blue

Light green

Light purple

Form Settings Dialog BoxReference:

The following options are available from the Form settings dialog box of HTML Composer.

Prompt orientation

Prompt refers to the descriptive text used to label the control/parameter in the output.

To the left of the input

Places the descriptive text used to label the control/parameter to the left of the
input.
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Above the input

Places the descriptive text used to label the control/parameter above the input.

Distance between the prompt and input

Sets the distance between the prompt and input.

Horizontal distance between controls

Sets the horizontal distance between controls.

Vertical distance between controls

Sets the vertical distance between controls.

Number of columns

Determines when the form will wrap and start laying controls out in a new row.

Default slider control

Sets how the slider control appears. Select from the following types of slider bars:

Slider controls are available when using numeric range value parameters in your report
or graph.

Horizontal or Vertical Slider Simple bar. The slider bar has no end arrows, just a bar
with the slider.

Horizontal or Vertical Slider with Color Bar and Arrows. Arrows appear at each end of
the slider bar.

Horizontal or Vertical Slider with Color Bar, Arrows, and Edit. Arrows and an edit box
appear at the end of the slider bar, showing the current value.

Once a slider control is inserted into HTML Composer, changing these options will not
affect the existing sliders. The option is only applied to new slider controls. To change
the existing slider bar type, delete the slider object and insert a new slider control.

Add schedule button

Automatically adds a schedule button for referenced procedures with parameters. This
option is selected by default. For more information about adding schedule capability to
HTML Composer forms, see Adding Report Broker Schedule Capability to HTML Composer
on page 265.

Start each chain on a new line

When creating multiple chains from the New Parameters dialog box, each set of chained
parameters appears on new line of the Design tab, regardless of the grouping option
selected from the New Parameters dialog box.

Start each chain on a new line is selected by default.
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Adding ReportBroker Schedule Capability to HTML Composer

How to:

Add or Disable the Schedule Button for Controls

Add a Schedule Button to a Referenced Existing Procedure With Parameters

Manually Add a Schedule Button

Change the Default Template for the Schedule Page

Reference:

Report Broker Schedule Page

You may create a control that adds a schedule button in HTML Composer. A schedule button
enables you to schedule a report, or graph, using Report Broker. Once you have created the
schedule, you can access the Report Broker to edit and maintain information about the
schedule.

Note: The Schedule option is only available in HTML Composer if your DB2 Web Query
environment is licensed to use Report Broker.

Only procedures referenced in HTML Composer are able to be scheduled.

When referencing an existing procedure with parameters in HTML Composer, the schedule
button is automatically added. You may also manually create schedule buttons for your
report or graph.

How to Add or Disable the Schedule Button for ControlsProcedure:

Controls appear when you reference a report or graph with parameters. HTML Composer
automatically adds a control, Run button, Reset button, and Schedule button for the
parameters in your layout, if your DB2 Web Query environment is licensed to use Report
Broker.

The Form settings dialog box sets when the schedule button appears with the controls.

The Schedule button is selected by default.

To change the default behavior:

1. Select Options from the Window menu.

The Developer Studio Options dialog box opens.

2. Select the HTML Page tab.

3. Click the Form Settings button.
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The Form settings dialog box opens.

4. Deselect the Add schedule button.

Note: If you deselect this option, you have the ability to manually add a schedule button.
For more information, see How to Manually Add a Schedule Button on page 267.

How to Add a Schedule Button to a Referenced Existing Procedure With ParametersProcedure:

This procedure provides instructions on how to automatically add a schedule button to an
HTML page for a referenced procedure in the layout.

1. From HTML Composer, select New Report or New Graph from the Insert menu.

The cursor changes into a crosshair.

2. Drag the crosshair to create a report (or graph) object and adjust it to the size you want.

3. Right-click the object and select Reference existing procedure from the context menu.

The Get source file dialog box opens.

4. Select an existing report or graph with parameters and click Open.

The New Parameters dialog box appears, as shown in the following image.

5. Click OK to add the new parameters and the controls to the HTML page.
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The Run, Reset, and Schedule buttons appear with the parameters on the HTML page.

6. Optionally, select the schedule button on the HTML page to view or edit the properties.
The properties appear in the HTML Composer Properties window.

7. Double-click in the Title properties value field to set the title of the schedule page window.

The default title for the schedule page window is domain\reports\folder\foldername.
You may change this to the text of your choice.

8. Optionally, you may launch the Hyperlink properties for the schedule button to change
the template for the schedule page.

For more information about changing the template for the schedule page, see How to
Change the Default Template for the Schedule Page on page 270.

How to Manually Add a Schedule ButtonProcedure:

This procedure provides instructions on how to manually add a schedule button to a HTML
page. This is useful for adding new, or additional, schedule buttons to a report or graph that
has already been referenced to the HTML page, or if you are referencing a report or graph
without parameters.

1. From HTML Composer, select a control from the Controls or Components submenu of
the Insert menu. You may insert a push button, image, or hyperlink as a schedule button.

a. If inserting a push button as a schedule button:

From the Insert menu, select Controls, then click Push Button.

The cursor changes into a crosshair.
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Drag the crosshair to add the push button object and adjust it to the size you
want.

Right-click the push button object from the HTML page and select Create hyperlink
from the context menu.

The Hyperlink Properties dialog box opens.

You may change the name of the push button in the Display Text field.

b. If inserting an image as a schedule button:

From the Insert menu, select Components, then click Image.

The cursor changes into a crosshair.

Drag the crosshair to add the image object.

The Get source file dialog box opens.

Select an image and click Open.

The image is added to the HTML page. You may adjust the image object to the
size you want.

Right-click the image object from the HTML page and select Create hyperlink from
the context menu.

The Hyperlink Properties dialog box opens.

c. If inserting a hyperlink as the schedule button:

From the Insert menu, select Components, then click Hyperlink.

The cursor changes into a crosshair.

Drag the crosshair to create a hyperlink object and adjust it to the size you want.

The Hyperlink Properties dialog box opens.

You may change the name of the hyperlink in the Display Text field.
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2. From the Hyperlink Properties dialog box, select the New button to add a request to
execute.

Note: The Display Text field on the Hyperlink Properties dialog box is only available when
inserting a push button or hyperlink as a schedule button.

3. Select the Action, Source, and Target/Template Name:

Select Schedule Report from the Action drop-down list.

Select the Source drop-down list to select the source of your Schedule Report.

The Source drop-down will only list the referenced procedures in the layout.

The Target Type option is disabled and defaults to Report Broker when the Schedule
Report action is selected.

The Target/Template Name defaults to Email Library FTP when the Schedule Report
action is selected.
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For more information on changing the template for the schedule page, see How to
Change the Default Template for the Schedule Page on page 270.

4. Click OK to close the Hyperlink Properties dialog box.

The schedule button, image, or hyperlink is added to the HTML page.

5. Optionally, select the schedule object to view or edit the properties. The properties
appear in the Properties window of HTML Composer.

6. Double-click in the Title properties value field to set the title of the schedule page window.

The default title for the schedule page window is domain\reports\folder\foldername.
You may change this to the text of your choice.

How to Change the Default Template for the Schedule PageProcedure:

This procedure provides instructions on how to change the template for the schedule page
by using the Hyperlink Properties dialog box. This is the template that appears when the
schedule page is run from the report output.

1. Right-click a schedule button, image, or hyperlink from the HTML page and select
Hyperlink properties from the context menu
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The Hyperlink Properties dialog box opens.

2. Click OK to close the Hyperlink Properties dialog box.

The selected template appears when the schedule page is run from your report output.
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Report Broker Schedule PageReference:

When you run your report, select the parameters (if applicable), and click the schedule
button. The Report Broker schedule page appears.

Tip: To change the schedule template that appears at run time, use the Hyperlink Properties
dialog box to change the Target/Template Name.

The report and the selected parameters are scheduled to Report Broker. From Report Broker,
the values entered or selected are stored with the schedule information.

You must have the Schedule user privilege to submit the schedule.
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Using JavaScript Code With HTML Composer Pages

In this section:

Function: IbComposer_getAllAmpersValues

Although HTML Composer is fully integrated with JavaScript, it is suggested that you do not
create custom JavaScript that manipulates HTML Composer generated controls, as DB2
Web Query cannot support such custom JavaScript code. Additionally, there is no guarantee
that the JavaScript code will work correctly in future releases.

Note:

Function: IbComposer_getAllAmpersValues

How to:

Get All Parameter Values

The IbComposer_getAllAmpersValues is used to get the current selected values from all the
controls on your page layout. It then takes those values and assembles them as a string
that can be added to the end of a URL call. An example of this would be having a REGION
control and multiselecting MidEast, NorthEast, and NorthWest. It will assemble these
selections as shown below:

&REGION=%27MidEast%27%20OR%20%27NorthEast%27%20OR%20%27NorthWest%27

This function can be used in conjunction with the Business Intelligence Portal, where the
generated string is appended to all Business Intelligence Portal calls that run reports or
charts. This allows the parameter values to affect all portal components, even if new ones
are added or existing ones are removed at runtime.

How to Get All Parameter ValuesSyntax:

IbComposer_getAllAmpersValues([verifySelection]);

where:

verifySelection

Boolean

Is an optional parameter. When true and when the Selection required property for the
control is set to Yes, this returns an empty string for the parameter controls that do not
have a selection made.
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Note: All controls have the Selection required property. This property is set to Yes by
default. If a control has no valid selection made at runtime, a red box appears around
it and the following status bar message displays:

Please make required selections

Retrieving a List of All Parameters Selected in a Report.Example:

function button1_onclick(ctrl)
{
var val = IbComposer_getAllAmpersValues();
alert(val);
OnExecute(ctrl);
}

Specifying an HTML File as a Load Screen

How to:

Specify an HTML File as a Loading Screen

When running an HTML page from HTML Composer, the web browser displays a Loading,
please wait… message, until the page is fully loaded.

You can use the Loading screen property for the BODY object to specify an HTML file of your
own to use as a loading screen.
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How to Specify an HTML File as a Loading ScreenProcedure:

1. Click the Loading screen property in the Properties tab of the Properties window for the
BODY object, as shown in the following image.

2. Select Custom from the Loading screen drop-down menu.
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The Get existing html page dialog box opens, as shown in the following image.

3. Select an HTML file and click Open.

The file is added to the property, as shown in the following image.

When the page runs, the specified loading screen will display until the page is completely
loaded.

276 IBM

Creating and Using Parameters in HTML Composer



Chaining Controls for Dependencies in HTML Composer

In this section:

Automatically Chaining Parameters From the New Parameters Dialog Box

Chaining Controls on the Parameters Tab

Setting the Default Link

Applying Conditions to a Chain

Populating Controls One at a Time

Using the Chain Separator and Line Separator

Describes how to chain controls for dependencies. Chaining populates controls based on
the selected value from the prior control in the chain.

You may chain controls to one another on the Parameters tab and apply conditions to links
in the chain. Chaining will populate controls based on the selected value from the prior
control in the chain. You can chain static and dynamic controls, link or unlink parts of a
chain, and create conditions on links in a chain. Chains are represented by lines connecting
control objects on the Design or Parameters tab. Note that chaining is applicable only for
controls, not parameters.

Note:

Although you may chain controls from the Design tab, you may only create conditions to
links in the chain through the Parameters tab.

By clicking the arrow head in a link of a chain, the Properties and settings dialog box
enables you to modify and set the properties and conditions of the chain.

If using static controls, you must apply conditions for each link in the chain. Conditions
need to be created for each value of the control chained from, and those values must
be mapped to the correct value(s) that will be displayed in the control that it is being
chained to.
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Automatically Chaining Parameters From the New Parameters Dialog Box

How to:

Auto Chain Controls From the New Parameters Dialog Box

Chain Controls From the New Parameters Dialog Box

The auto chain option enables you to automatically chain selected controls from the New
Parameters dialog box. Chaining populates controls based on the selected value from the
prior control in the chain. The auto chain option is useful, since it creates the chain or links
of a chain, automatically.

Note: Automatic chaining creates a basic chain with default functionality that does not
include any conditions. You may create conditions for a chain through the Parameters tab.

When importing or referencing a report with parameters to an HTML page, the controls are
not chained by default. You may choose to include or exclude individual controls in a chain
with the Chain control column from the New Parameters dialog box.

Additionally, when the auto chain option is selected, a separator is added to the parameters
list on the New Parameters dialog box. A separator is used to separate controls into multiple
chains and can be moved up or down in the chain sequence.

How to Auto Chain Controls From the New Parameters Dialog BoxProcedure:

The auto chain option creates the chain, or links of a chain, automatically. When the auto
chain option is selected, a separator is added to the parameters list. A separator is used
to separate controls into multiple chains and can be moved up or down in the chain sequence.

1. In HTML Composer, import or reference a report with parameters to an HTML page.

The New Parameters dialog box opens.

2. Select Auto chain controls in above specified order.

Tip: You may use the up or down arrows to change the order of the selected control
before selecting this option.
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The Chain control option is selected for all controls and a separator is added as the last
object to the list of parameters, as shown in the following image.

3. To create multiple chains, click the separator row and use the up or down arrows to
change the location of the separator in the chain.

IBM DB2 Web Query for IBM i 279

1. Using the HTML Composer



Note: If the default separator is moved up, another separator is added to the end of
the list, as shown in the following image.

4. Click OK to close the New Parameters dialog box and add the control to the HTML page.
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On the Design tab, when creating multiple chains from the New Parameters dialog box,
each set of chained parameters appears on a new line, regardless of the grouping option
selected from the New Parameters dialog box. This behavior is set through the Start
each chain on a new line option, located on the Form Settings dialog box in HTML
Composer. For example, the following image shows the first link in the chain (REGION)
on one line. The second chain (ST and CITY) starts on a new line within the control of
the Design tab. This enables you to see the relationship of the chains within the form.
Start each chain on a new line is selected by default.

On the Parameters tab, chains are represented by lines connecting control objects. For
example, the selected value for the REGION field populates the available values for the
STATE field. The selected value for the STATE field populates the available values for
the CITY field in this chain.

5. If additional filters are added, use the chaining buttons on the Positioning toolbar to
add or remove the selected control to the current chain.

How to Chain Controls From the New Parameters Dialog BoxProcedure:

The Chain control column enables you to include or exclude individual controls in a chain,
from the New Parameters dialog box.

1. In HTML Composer, import or reference a report with parameters to an HTML page.

The New Parameters dialog box opens.
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2. Select the Chain control check box for the controls to be included in the chain.

The controls are chained in the order that they appear on the New Parameters dialog
box. You may use the up or down arrows to change the order of the selected control
before chaining controls.

Note: If a control is excluded from a chain, the chain automatically links only the selected
controls. For example, the following image shows REGION and CITY as links in the chain.

3. Click OK to close the New Parameters dialog box and add the control to the HTML page.
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On the Design tab, when creating multiple chains from the New Parameters dialog box,
each set of chained parameters appears on a new line, regardless of the grouping option
selected from the New Parameters dialog box. This behavior is set through the Start
each chain on a new line option, located on the Form Settings dialog box in HTML
Composer. For example, the following image shows the first link in the chain (REGION)
on one line. The second chain (ST and CITY) starts on a new line within the control of
the Design tab. This enables you to see the relationship of the chains within the form.
Start each chain on a new line is selected by default.

On the parameters tab, chains are represented by lines connecting control objects. For
example, the selected value for the REGION field populates the available values for the
CITY field in this chain.

4. You can use the chaining buttons on the Positioning toolbar to add or remove a selected
control to the current chain.
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Chaining Controls on the Parameters Tab

How to:

Chain Controls on the Parameters Tab

Remove a Link in the Chain

Reverse the Order of Chained Controls

Chaining enables you to associate two or more related values. When you chain controls
together, chained values are filtered as selections are made to each parameter control. For
example, if you chain the PLANT parameter to the STATE parameter, only PLANT values for
the currently selected STATE value will be available, instead of all the plants in the data
source. Each time a selection is made, all chained controls that come after will be dynamically
updated. Chaining also enables you to add, remove, and reverse the order of controls in the
chain.

Values are processed with a caching mechanism that gathers all of the necessary values,
prior to loading the page. This method automatically combines all of the necessary requests
into a single HTTP request and maps the result sets to the appropriate controls, greatly
reducing the load time involved with sending multiple requests for data.

How to Chain Controls on the Parameters TabProcedure:

1. Create an HTML page using input controls to supply parameter values.

For details, see Using Input Controls to Supply Parameter Values on page 133.

2. Click the Parameters tab.

3. Select the center of the control object, left-click and drag the control to the center of
the next control object in the chain. Release the mouse to complete the link.

Repeat this step for each link in the chain.

Tip: Optionally, you may use the Positioning toolbar to add and remove controls to a
chain. Both chaining options (drag and drop and the chaining icons) work in conjunction
with each other. If you create a chain by one method, you can remove the chain by using
the other method, and vice versa. For more information about chaining icons, see
Positioning Toolbar on page 252.

The image below is an example of chained controls. Notice the direction of the arrows.

The Region control starts the first link in the chain, chained to the State control.
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The State control starts the second link in the chain, and is being chained to the
Store_Name control.

Tip: You can also reverse the order of controls in the chain. For details, see How to
Reverse the Order of Chained Controls on page 286.

4. Optionally, apply condition settings to the chain to determine how parameters are
populated.

If using static controls, you must apply conditions for each link in the chain. Conditions
need to be created for each value of the control chained from, and those values must
be mapped to the correct value(s) that will be displayed in the control that it is being
changed to.

For details about conditions, see Applying Conditions to a Chain on page 290.

How to Remove a Link in the ChainProcedure:

To remove a link in the chain on the Parameters tab:

Select the arrow head on the line so that the line is bold.

Right-click and select Break binding.

Repeat this step for each link in the chain that you want to break.
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Tip: Optionally, you may use the Positioning toolbar to add and remove controls to a
chain. Both chaining options (drag and drop and the chaining icons) work in conjunction
with each other. If you create a chain by one method, you can remove the chain by using
the other method, and vice versa. For more information about chaining icons, see
Positioning Toolbar on page 252.

How to Reverse the Order of Chained ControlsProcedure:

To reverse the order of chained controls on the Parameters tab:

1. Select the arrow head on the line so that the line is bold, right-click and select Break
binding.

2. Select the center of the control object, left-click and drag the control to the center of
the next control object in the chain, and release the mouse to complete the link.

Notice the direction of the arrow between the control objects. You may reverse the
direction of the link in the chain or reverse the order of the chain by changing the direction
of each link.

a. If reversing the direction of a link in the chain, click and drag the control object in
the desired order.

For example, in the image below:

The Region control starts the first link in the chain, chained to the State control.

The Store_Name control starts the second link in the chain, also chained to the
State control.
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Note: Conditions are needed in order to make Region disappear from the chain,
and to make Store_Name control State. For details about conditions, see Applying
Conditions to a Chain on page 290.

b. If reversing the order of a chain, click and drag the control objects in the desired
order.

Tip: In some scenarios, when reversing the order of chained values, you may want
to move the controls from the default location on the Parameters tab so that you
can better see the direction of the chain. Moving objects on the Parameters tab will
not affect the Design view of your layout.
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Press the Shift key and select the control object and bound parameter to move
the objects as a set.

Chain the control objects together.

For example, in the following image, the State control starts the first link in the
chain, chained to the Region control. The Region control starts the second link in
the chain, chained to the Store_Name control.

3. Optionally, apply condition settings to the chain to determine how parameters are
populated.

For details about conditions, see Applying Conditions to a Chain on page 290.
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Setting the Default Link
If a control or parameter has two or more incoming bindings, one of those bindings can be
set as the default link. This ensures that population occurs in the control or parameter.
When a control or parameter has multiple incoming bindings, the shortcut menu for each of
those bindings has the Default link option, as shown in the following image.

When a binding is the default link, it will have a check mark next to the Default link option
in the shortcut menu, as shown in the following image.

Note: If only one control is chained to another control, the Default link option is unavailable
from the shortcut menu. If a single control is chained to a single parameter, the Default link
option is shown, but will be used for future development in a later release.

If two controls are chained to a third control, the binding that has Default link selected shows
which control will be used to populate the third control by default. Similarly, if two controls
are bound to a parameter, the Default link option shows which control is used to populate
the parameter.
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If two parameters are bound to a control, the binding that has Default link selected makes
the initial selection in the control.

Applying Conditions to a Chain

How to:

Create a New Condition

Select the Action for a Condition

Select the Values Compare Operator for a Condition

Apply Selected Values With a Multiselect Operator to a Condition

Resolve Parameters for a Condition

Select the Compare Operator for the Parameter

Enable Cache Processing for Chained Values

Reference:

Properties and Settings Dialog Box (Conditions)

A chain contains conditions for each link in the chain. The conditions are linked to the values
being selected in the control object. You may apply multiple conditions to one link. The
properties and settings for the condition describe how the link should behave. The following
options are available:

Apply Actions for the links on the chain.

Apply the Values compare operator for the condition.

Apply Selected values with a Multiselect operator for the condition.

Apply the Resolves parameter values for the condition.

Apply the Parameter’s compare operator for the condition.

If using static controls, you must apply conditions for each link in the chain. Conditions need
to be created for each value of the control chained from, and those values must be mapped
to the correct value(s) that will be displayed in the control that it is being changed to.

Properties and Settings Dialog Box (Conditions)Reference:

The Properties and settings dialog box appears when creating a condition for a chain link
on the Parameters tab. A chain contains conditions for each link in the chain.
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The conditions are linked to the values being selected in the control object. The properties
and settings for the condition inherit the values of the prior bound control and provide
additional condition settings. This section describes the additional condition settings.

The Properties and settings dialog box contains the following fields and options when creating
a condition:

Conditions

The conditions list enables you to create multiple conditions for the link. Default is the
only initial condition.

To create a new condition, click the New icon. Condition(n) is created, where n is the
number, and added to the Conditions drop-down list. You may type in a unique
condition name, choose Selected values, and set the condition settings.

Click the Delete icon to remove the selected condition from the list. Note that the
Default condition name cannot be deleted.

Actions

Select an action for the chain link to control. The options offer variations to populate,
show, hide, execute, and select the values. The list of available options are:

Populate, show. Populates the control and displays it at run time. This is the default
action for all conditions.

Populate, hide. Populates the control and does not display it at run time.
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Populate with alternate, show. Populates the control with alternate values derived
from a procedure, or value list, that is not the default and displays the control at run
time.

Populate with alternate, hide. Populates the control with alternate values derived
from a procedure, or value list, that is not the default and does not display the control
at run time.

Show. Shows the control but does not populate it.

Hide. Hides the control but does not populate it.

Execute. Executes the bound object. For example, if you bind a control to a Submit
button and change the value in the control at run time, the report/graph automatically
executes when you change the value, without having to click the Submit button.

Select. Selects the bound object. For example, if you bind a control to a tab item
and select a value in the control at run time, the bound object (the tab item) is
automatically selected as the active tab on the page.

Values compare operator

Values compare operator provides chaining logic scenarios to include options, such as
Equal, Not Equal, Greater Than, Less Than, and so on. This option sets the condition
for how to populate the control being linked to.

Equal is the default Values compare operator.

Selected values

Selected values enable you to provide the values used in the condition. When creating
a new condition, the Selected values section is activated. You may type selected values
in the input box or click the ellipsis button to select values from the list.

The list of values that appears is based on the values of the prior bound control in the
chain.

When selected values are entered, the Multiselect operator field is activated.

Multiselect operator

The Multiselect operator options are activated when selected values are entered for the
condition. Options are One of or All of. One of is based on one of the values shown in
the Selected values, being selected in the prior control, in the chain. All of is based on
the value of all of the Selected values, being selected in the prior control, in the chain.

One of is the default multiselect operator.
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Resolves parameter (“To: field is required”)

From. The From field specifies where to get the value used in the To field, if the control
being chained from is a map or ActiveX control.

To. The To field is used to dynamically generate the selection list used to populate the
control being chained to. This field displays the parameter whose value will drive the
condition evaluation. The parameter name linked to the prior control in the chain is
displayed by default. The ellipsis button provides a pop-up dialog of the other parameter
values (from the report) to be resolved.

Parameter's compare operator

The Parameter’s compare operator provides chaining logic scenarios to include options,
such as Equal, Not Equal, Greater Than, Less Than, and so on. This sets the compare
operator to populate the control.

Equal is the default Parameter's compare operator.

For details about the Properties and settings dialog box options for Data type values, see
Properties and Settings (Incoming Static Parameter and Unbound Control) on page 78 or
Properties and Settings Dialog Box (Dynamic Values) on page 92.

How to Create a New ConditionProcedure:

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 73.

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain. For details about chaining controls, see Chaining
Controls on the Parameters Tab on page 284.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the
Default condition settings for the link in the chain.

4. Click the New icon to create a multiple condition for the chain.

Condition(n) is created, where n is the number, and added to the Conditions drop-down
list, and the Selected values section is activated. You may type in a unique condition
name.

5. You may type in a unique condition name, choose Selected values, and set the condition
settings for the new condition.
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6. Optionally, you may click the Delete button to remove the selected condition from the
list.

Note: Default, the initial condition, cannot be deleted.

7. Close the Properties and settings dialog box.

How to Select the Action for a ConditionProcedure:

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 73.

2. Drag control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain. For details about chaining controls, see Chaining
Controls on the Parameters Tab on page 284.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the
condition settings for the link in the chain.

4. Select the action for the condition from the Actions drop-down list. For example, to hide
the control being chained to, select Hide.

Populate, show is the default option.

5. Close the Properties and settings dialog box.

When running the HTML page, the action for the chained control is applied.

How to Select the Values Compare Operator for a ConditionProcedure:

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 73.

2. Drag the control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain. For details about chaining controls, see Chaining
Controls on the Parameters Tab on page 284.

3. Click a link in the chain.
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The Properties and settings dialog box opens showing the bound control values and the
condition settings for the link in the chain.

4. Select the chaining logic for the parameter being chained to, in the condition, from the
Values compare operator drop-down list.

Equal is the default option.

5. Close the Properties and settings dialog box.

The compare operator is applied to the value selected.

How to Apply Selected Values With a Multiselect Operator to a ConditionProcedure:

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 73.

2. Drag the control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls of the chain. For details about chaining controls, see Chaining
Controls on the Parameters Tab on page 284.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the
condition settings for the link in the chain.

4. Click the New icon to create a multiple condition for the chain.

Condition(n) is created, where n is the number, and added to the Conditions drop-down
list, and the Selected values section is activated. You may type in a unique condition
name.

5. You may type selected values in the input box or click the ellipsis button to select values
from the list.

The list of values that appears is based on the values of the prior bound control in the
chain.
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Tip: You may also use the pop-up icons to select a field and close the pop-up dialog.
The green icon is OK, the red icon is Cancel, double-clicking a value will select the value
and close the dialog without using any button, and pressing the Esc key will cancel the
dialog without using any button.

When selected values are entered, the Multiselect operator field is activated.

6. Select the chaining logic for the selected values from the Multiselect operator drop-down
list.

One of is based on one of the values shown in the Selected values, being selected
in the prior control, in the chain. This is the default selection.
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All of is based on the value of all of the Selected values, being selected in the prior
control, of the chain.

7. Close the Properties and settings dialog box.

The selected values and multiselect operator are applied to the condition.

Using the All Of Multiselect OperatorExample:

The following example shows how to use the All Of multiselect operator when you perform
conditional chaining. In this example, listbox2 is chained to the multiselect listbox1. The
listbox2 is conditionally chained to be shown if all of the selected values in listbox1 meet
the listed criteria. If all of the selected values do not meet the criteria, listbox2 will be hidden.

1. Create the HTML page.

a. Select the HTML Files folder from your project in the Developer Studio Explorer.

b. Right-click and select New, then HTML File.

The Add HTML File dialog box opens.

c. Type allof_example in the File name text box and click Open.

The Template selector opens.

d. Click No, Thanks to create a blank HTML page without using a template.

HTML Composer opens.
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2. Add a multiselect list box to the canvas, dynamically populated using the Car data source.

a. From the Insert menu, select Controls, then List Box.

The cursor changes into a crosshair.

b. Drag the crosshair to create a list box and adjust it to the size you want.

c. Select Properties and Settings from the View menu.

The Properties and settings dialog box appears.

d. Select the Dynamic radio button for the Data type.

e. Select the ellipsis button from the Embedded procedure field, as shown in the following
image.

f. Select the car Master File from the Get source file dialog box and click Open.

g. Select the ellipsis button from the Value field.

h. Select SEATS from the drop-down menu.

i. Set the Multiple property to Multiple from the Properties pane.
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The listbox1 is now a multiselect list box.

3. Add a second list box to the canvas, dynamically populated using the Car data source.

a. From the Insert menu, select Controls, then List Box.

The cursor changes into a crosshair.

b. Drag the crosshair to create a list box and adjust it to the size you want.

c. Select Properties and Settings from the View menu.

The Properties and settings dialog box appears.

d. Select the Dynamic radio button for the Data type.

e. Select the ellipsis button from the Embedded procedure field.

The Get source file dialog box appears.

f. Select the car Master File and click Open.

g. Select the ellipsis button from the Value field.

h. Select CAR from the drop-down menu.

4. Chain the list boxes.

a. Select listbox1 on the canvas.

Resizing anchors appear around the list box.

b. Hold down the Ctrl key and select listbox2.

Resizing anchors appear around both list boxes.

c. Select Add to current chain from the Utilities toolbar, as shown in the following image.

5. Set conditions for the chain.

a. Click the Parameters tab.

b. Right-click the arrow connecting listbox1 to listbox2 and select Properties and Settings.

The Properties and settings dialog box appears.

c. For the Default condition, set Actions to Hide.

d. Press the New Condition button to create a new condition.
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e. For the new condition, set the properties as follows:

Selected values: 5

Actions: Populate, show

Values compare operator: Less Than

Multiselect operator: All of

6. Run the page.

There is no default selection for listbox1 and by default listbox2 is not displayed when
the page is first run. Select any single value less than 5 fulfills the condition set in step
5 and listbox2 is shown. Selecting 2 and 4 also fulfills the condition, all of the
multiselected values are less than 5 and listbox2 is shown. Selecting 2 and 5, 4 and 5,
or 2, 4, and 5 does not fulfill the condition, all of the multiselected values are not less
than 5 and listbox2 remains hidden.

The following image shows all of the selected values meeting the condition and, as a
result, listbox2 is shown.
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The following image shows all of the selected values failing to meet the condition and,
as a result, listbox2 is hidden.

How to Resolve Parameters for a ConditionProcedure:

It is recommended that you populate the controls first, before chaining. When you populate
the controls first, certain information is obtained, which allows the determination of the best
choice for Resolves parameter. If you chain first and then populate, the information cannot
be obtained, because the chaining is already established. If you chain first, you must manually
set Resolves parameter.

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 73.

2. Drag the control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain. For details about chaining controls, see Chaining
Controls on the Parameters Tab on page 284.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the
condition settings for the link in the chain.

4. Click the Resolves parameter ellipsis button to select a parameter name to resolve. If
a custom procedure that has a filter (or filters) populates the control, the values list
shows the parameters from the filters. If a data source populates the control, the values
list shows all of the fields from the data source shown in the Object Inspector.

The value in the Resolves parameter field should be either:

The field name that limits the values for the next control in the chain, if a data source
populates the control.

The parameter name from the procedure, if a procedure populates the control.

In most cases, this value will be populated by default and will not need to be changed.
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Tip: You may also use the pop-up icons to select a field and close the pop-up dialog.
The green icon is OK, the red icon is Cancel, double-clicking a value will select the value
and close the dialog without using any button, and pressing the Esc key will cancel the
dialog without using any button.

5. Close the Properties and settings dialog box.

The parameter value is resolved in the chain if no filter is specified.

How to Select the Compare Operator for the ParameterProcedure:

An example of when to apply chaining logic is when a form offers two lists of dates so that
you can select a FROM/TO date range. By chaining these parameters together and applying
the Greater than parameter compare operator, this ensures that when a date is selected
for the FROM parameter, only dates that follow the FROM date display in the TO date control,
eliminating the possibility of selecting an invalid date range.

1. Insert a report with parameters in HTML Composer.

For details about creating parameters, see Creating Parameter Values on page 73.

2. Drag the control objects on the Parameters tab to create a chain.

Chains are represented by lines connecting control objects on the Parameters tab.

Chaining controls will populate parameters with values at run time, based on values
selected in prior controls on the chain. For details about chaining controls, see Chaining
Controls on the Parameters Tab on page 284.

3. Click a link in the chain.

The Properties and settings dialog box opens showing the bound control values and the
condition settings for the link in the chain.

4. Select the chaining logic option from the Parameter's compare operator drop-down list.
This sets the compare operator to populate the control.

Equal is the default option.

5. Close the Properties and settings dialog box.

The compare operator is applied to the parameter selected.
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How to Enable Cache Processing for Chained ValuesProcedure:

You may enable cache processing for chained values in two ways:

Enable the caching option for the HTML page and all objects on the page.

Enable cache run time data for a dynamic control or a condition.

A chain contains conditions for each link in the chain. The conditions are linked to the
values being bound to the control object. If you change the options for the condition, it
will also be applied to the control, and vice versa.

Caching options are turned off by default.

1. To enable caching options for all objects on the HTML page:

From the Design tab of HTML Composer, select Options from the Window menu.

The Developer Studio Options dialog box opens.

Select the HTML Page tab.

Select Default caching option.

Click OK to close the Developer Studio Options dialog box.

2. To enable caching options for a dynamic control or condition:

A chain contains conditions for each link in the chain. The conditions are linked to the
values being chained to the control object. If you change the options for the condition,
it will also be applied to the control, and vice versa.

a. For a dynamic control:

Create a dynamic input control to supply parameter values.

For details about creating dynamic values, see Creating a Dynamic List of Values
on page 92.

Select the dynamic control object from the Parameters tab.

The Properties and settings dialog box opens, showing the dynamic control
options.

Select Cache run time data to cache the run time data for the selected input
control.

Note: This setting overrides the Default caching option from the HTML Page tab.

Close the Properties and settings dialog box.

Select the center of the control object, drag the control to the center of the next
control object, and release the mouse to complete the binding of the chain.
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When binding controls, the conditions inherit the values set in the dynamic control
properties and settings.

b. For a dynamic condition:

Click a link on the chain to open the Properties and settings dialog box for the
condition.

Select Cache run time data to cache the run time data for the selected input
control. This option is only available for dynamic controls.

This setting overrides the Default caching option from the HTML Page tab.

When running the HTML page, data for the chained value is cached to improve
performance.

Populating Controls One at a Time

How to:

Populate Controls One at a Time

When building complex pages, you can optimize performance by populating a chain one
control at a time instead of all the controls when the page initially loads. Selecting the Add
'No selection' option enables you to populate controls when necessary.
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How to Populate Controls One at a TimeProcedure:

1. Click the Add 'No Selection' option check box on the Properties and Settings dialog box
for the input control, as shown in the following image. Repeat this step for other input
controls in the chain as desired.

2. Click the Run button.
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The page opens and the first control, for example Region, contains a Make Selection
drop-down list. The other controls, after it, have no values.

3. Select a value from the first control drop-down list (for example, Midwest).

When you make a selection in the first control, the next control, for example, State, will
populate with selection values and the next control, City, has no values.

4. Select a value from the next control drop-down list (for example, IL), as shown in the
following image.

The next control, for example, City, will populate with selection values.

5. Select a value from the next control drop-down list (City), as shown in the following
image.

6. Click the Run button.
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The report appears, as shown in the following image.

Using the Chain Separator and Line Separator

How to:

Use the Chain Separator and Line Separator

The chain separator and line separator options allow for chains and parameters to be grouped
or split depending on which settings are turned on. When used, the two separators do the
following:

Chain separator. When Start each chain on a new line is on, this separator creates new
chain groups on new lines. When Start each chain on a new line is off, this separator starts
a new chain wherever it is placed in the New Parameters dialog box. The controls are
positioned in one row and wrap at the end of the form.
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Note: Start each chain on a new line is turned on by default. This option can be found in the
Form settings dialog box.

Line separator. This separator creates a line break wherever it is placed.

How to Use the Chain Separator and Line SeparatorProcedure:

To use the chain separator and line separator:

1. Create a new procedure that uses the CAR Master File and prints COUNTRY, CAR,
MODEL, BODYTYPE, SEATS, and SALES.

2. Save the procedure, naming it separator_example.fex.

3. Create a new HTML file.

4. Insert a new report.

5. Right-click the report and select Reference existing procedure, as shown in the following
image.

6. Select the previously created procedure, separator_example.fex, and click Open.
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The New Parameter dialog box opens, as shown in the following image.

7. Check the Auto chain controls in above specified order option.

8. Move Line Separator above SALES.

A copy of the line separator is moved up while the original stays in the starting position.
This is so you can add multiple line separators.

9. Move Chain Separator above MODEL.

A copy of the chain separator is moved up while the original stays in the starting position.
This is so you can add multiple chain separators.
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The New Parameters dialog box will look like the following image.

10. Click OK.

The report is added to the HTML page. COUNTRY and CAR are on the first line and make
up one chain. MODEL, BODYTYPE, and SEATS are on the second line, while SALES is
on a separate, third line. MODEL, BODYTYPE, SEATS, and SALES make up a second
chain.

The parameters are shown in the following image.
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Creating Active Technologies Dashboards and
Rich Internet Applications With HTML
Composer

2

Topics:
The HTML Composer enables you to
graphically create Active Technologies
Dashboards and Rich Internet
Application. The HTML Composer is fully
integrated with JavaScript and Cascading
Style Sheets (CSS).

Creating Active Technologies
Dashboards With HTML Composer

Creating a Rich Internet Application
(RIA) With HTML Composer
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Creating Active Technologies Dashboards With HTML Composer

In this section:

Binding Objects to an Active Technologies Report

Configuring Active Technologies Controls in HTML Composer

Refreshing Active Technologies Reports

Exporting the Active Technologies Dashboard

Scheduling and Distributing Active Technologies Dashboards

Usage Notes for Active Technologies Dashboards Created With HTML Composer

An active report is a report that is designed for offline analysis.

HTML Composer has extended the functionality of active reports by providing the features
to build an Active Dashboard: an HTML form with one or more active report procedures and
controls to mimic active report menu options. This allows global modification of multiple
active reports in HTML Layout created pages.

An active report is a self-contained report that is designed for off-line analysis, meaning it
contains all of the data and JavaScript within the HTML output file. A benefit of active reports
is the ability to run these reports off-line.

An Active Dashboard combines multiple active reports into a variety of scenarios that are
coordinated with a common sort field. Active Dashboards can run reports off-line and develop
storyboards with multiple charts and tables that give you a complete view of a business
issue. You can send Active Dashboards as standalone dashboard pages or incorporate them
into corporate Dashboards. A typical Dashboard displays several different scenarios, each
on their own page, that are accessible by selecting the appropriate panel at the top of the
page.

The process of creating active dashboards in HTML Composer consists of:

Adding an active report to HTML Composer.

Binding or synchronizing other active report and active chart objects to the active report
in the layout.

Configuring active controls that mimic active report menu options at run time.

Saving the HTML Layout as a DB2 Web Query procedure (.fex) for scheduling and
distributing Active Dashboards. The Export as Procedure option, available from HTML
Composer, converts the HTML page and embeds the code into a DB2 Web Query
procedure, so these too can be run off-line. The layout is no longer a webpage or HTML
file, but a DB2 Web Query procedure with embedded HTML code.
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Binding Objects to an Active Technologies Report

How to:

Synchronize Report and Chart Objects to Active Technologies Reports

Show Synchronized Active Technologies Report Groups

Select Properties for Synchronized Reports

Delete an Active Technologies Report Object

You can create multiple views of an active report by binding an active report or active chart
object to an active report. Binding or synchronizing is the act of configuring an association
between an active report and an active report or active chart object in HTML Composer.

You can synchronize active report and active chart objects and show the synchronized report
groups in HTML Composer. The synchronize options are available from the Positioning toolbar
in HTML Composer.

You can only synchronize objects to one active report at a time. If you try to synchronize an
object to a second active report, the first synchronization is removed.

How to Synchronize Report and Chart Objects to Active Technologies ReportsProcedure:

1. In HTML Composer, you can add an active report to the layout:

Select New Report from the Insert menu.

Right-click the report object and select Reference existing procedure from the context
menu to add the active report.

2. Add an active report or active chart object to the layout.

Select New Report or New Graph from the Insert menu.

The cursor changes into a crosshair.

Drag the crosshair to create an active report or active chart object and adjust it to
the size you want.
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3. Select the objects to be synchronized.

Select the active report or active chart object as the object to be synchronized.

While pressing and holding the Ctrl key, select the active report as the report that
you want to bind to.

The synchronize buttons on the Positioning toolbar are activated.

In the example below, the active report is the binding object and the chart object is
about to be synchronized to the active report.

The binding object (active report) is indicated by clear boxes around the edges. The
synchronized object (active report or active chart object) is indicated by solid black
boxes around the edges.

4. Click the Synchronize to active report button on the Positioning toolbar.

The active report or active chart object is synchronized and refreshed with data from the
active report.
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There is no separate procedure associated with these active report objects. If you right-
click these items, there are no options to edit the procedure.

How to Show Synchronized Active Technologies Report GroupsProcedure:

Select Show synchronized reports from the Positioning toolbar.

The synchronized groups are shown in the layout.

In the following example, there are two synchronized report groups. The Production Units
Analysis graph is synchronized to the Production Units Analysis active report, and the Sales
by Category graph is synchronized to the Sales by Category active report.

How to Select Properties for Synchronized ReportsProcedure:

You can change the active report object properties by using the Properties tab in the
Properties window.

1. Select the synchronized active report object in the layout and click the Properties tab.

The active report object properties appear.
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2. Select the active report type drop-down list to change the type of active report for the
object.

The options are <Not Set>, Grid, Pivot, Bar, Line, Pie.

3. Optionally, If you select Bar, Line, or Pie as the active report type, additional X-axis and
Y-axis selections are available for the synchronized report.

Select the active report X axis drop-down list.

Select the active report Y axis drop-down list.

If you change the X and Y values for a chart object, the selections are not reflected in
the Design view of HTML Composer. These values are applied at run time.

How to Delete an Active Technologies Report ObjectProcedure:

An active report object can only be populated if it is synchronized with an active report. To
break the synchronization between an active report or active chart with an active report,
delete the object.

1. Select the synchronized active report or active chart object in the layout.

2. Click Delete from the Edit menu.

The active report object is deleted.
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Configuring Active Technologies Controls in HTML Composer

How to:

Add an Active Technologies Control to the Layout

Configure an Active Technologies Control

Reference:

Properties and Settings Dialog Box (Active Technologies Reports)

To add an active control, you need to insert a new control to the layout and configure it as
an active control on the Parameters tab. Selecting active report as the control type creates
an association between the HTML Composer control and an active report, thereby linking
actions to directly affect bound active reports.

Only when there are active reports embedded or referenced in HTML Composer, are active
controls applicable. An active control cannot be associated to any parameters in the layout.
This type of control can only be associated with an active report in the Layout.

Note:

An active report that has a password (ARPASSWORD) set for viewing restrictions is not
supported in an active dashboard created with HTML Composer.

When creating active dashboards in HTML Composer, the combination of using an active
report with the active cache option enabled and using an active control that is a Date
field (such as dates with format MDY and MDYY) results in an error. The active control
date field works correctly if you deselect the active cache option in the active report.

If a control displaying report types appears in an AHTML report in HTML Composer, and
the Pivot report type is selected at run time, the report is incorrectly reduced in size. If
the user selects Pie, Chart, Line, or the default report type of Grid, the frame is not
resized to the original positioning set by the user. Although scroll bars are added, output
cannot be fully viewed.

How to Add an Active Technologies Control to the LayoutProcedure:

Any HTML Composer control can be configured as an active control, but the following controls
are the most applicable: Check box, Drop down list, List box, Radio button, and Push button.
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Add an HTML Composer control that mimics an active report menu option:

1. Select the control type (for example, Drop Down List or List Box) from the Components
or Controls submenu of the Insert menu.

The cursor changes into a crosshair.

2. Drag the crosshair to create a control object and adjust it to the size you want.

The HTML Composer control is added as the active control. You can now configure the control
by using the Parameters tab.

Properties and Settings Dialog Box (Active Technologies Reports)Reference:

The Properties and settings dialog box appears when creating or editing an active report
value on the Parameters tab.

The following image is the Properties and settings dialog box with an active report Data type.
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The Parameters tab contains the following fields and options when active report is selected
as the Data type:

Data type

Determines whether values are obtained from a static or dynamic list,or an active report.

Selecting active report will require you to bind the HTML Composer control to an active
report.

Available active reports

The Available active reports list binds active controls to active reports in the layout. At
run time, when the Refresh for active reports setting is triggered, the active reports
selected in the Available active reports list are modified based on the current state of
each active control it is bound to.

Available active reports lists all active reports currently embedded in HTML Composer.
No active reports are selected by default.

Menu Option Types

The Menu Option Types determine how active reports are modified when the Refresh for
active reports setting is triggered. Menu Option Types configure active controls to sort
columns, filter content, and change the active report presentation. Multiple active controls,
each with different Menu Option Types settings, can be used in combination to modify
the active dashboard.

Menu Option Types presents a list of options to designate which active report menu
option an active control inherits. To set the behavior of the current active control, select
only one Menu Option Types item.

If no option is selected, the active control has no effect on the active dashboard.

List of columns

At run time, the active control lists all common columns found in each bound active
report. When the Refresh for active reports setting is triggered, the data is sorted by the
selected column.

If using AS Names for a field in a report, all common columns must have the same name
across all reports.

Column value

At run time, the active control lists all unique values found in a specified column, common
in each bound active report. When the Refresh for active reports setting is triggered, the
active control filters bound active reports based on the column value selected.

The Add "ALL" Option is activated when the Column value option is selected. This adds
the option to select ALL data source values to the control.

IBM DB2 Web Query for IBM i 319

2. Creating Active Technologies Dashboards and Rich Internet Applications With HTML Composer



List of filters

At run time, the active control lists multiple filtering actions. This type of control does
not affect bound active reports by itself, but only when used in conjunction with active
controls set to Column Value. When the Refresh for active reports setting is triggered,
the active control instructs how to filter bound active reports based on the value selected
in the Column Valued control.

The available list of filters is: Equals, Not equal, Greater than, Greater than or equal to,
Less than, Less than or equal to, Between, Contains, Contains (match case), Omits,
and Omits (match case).

Sort order

At run time, the active control lists two sorting actions, Sort Ascending and Sort
Descending. When the Refresh for active reports setting is triggered, the active control
sorts bound active reports based on the sorting action selected.

By default, the active control sorts the first common column in each of the bound active
reports.

Report type

At run time, the active control lists different active report presentation types; Grid, Pie
Chat, Line Chart, Bar Chart, and Pivot Table. When the Refresh for active reports setting
is triggered, this active control changes bound active reports to the presentation type
selected.

Common Columns

The Common Columns list only appears when the Column value Menu Option Type is
selected. Common Columns lists all common columns found in each bound active report.
Select one field to bind to the active control. At run time, the Column value control lists
all unique values across each bound active reports Common Columns field selected.

The Common Column selection can be overridden at run time when the Column Value
control is chained to the List of columns Menu Option Type.

Refresh for active reports

Enables active controls to automatically modify current views of bound active reports
when you select a new value at run time.

Refresh for active reports is enabled by default when you select an Available active report
from the Parameters window.

For more information about the Refresh for active reports option, see Refreshing Active
Technologies Reports on page 325.
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Selected Value

Enter the values to be selected as the default value whenever the procedure is run. For
more information, see How to Use Selected Values as the Default Value on page 115.

The Selected Value option is only available for active controls when the Column Value
Menu Option Type is selected.

Add "ALL" Option

Adds the option to select ALL data source values to the control. Alternate text can be
substituted for "ALL" using the text field to the right. For more information, see Parameter
Value List Options on page 103.

The Add "ALL" Option is available when the Column value option is selected from the
Menu Option Types.

How to Configure an Active Technologies ControlProcedure:

Once the active control is added to the layout, you can configure it by using the Properties
and settings dialog box on the Parameters tab.

It is important to note that you can only chain List of columns to List of column values.

1. Select the active control in the layout and click the Parameters tab.

The Properties and settings dialog box opens.

2. Select active report as the Data type.

The active report options appear.

3. Bind the active control to an Available active report in the layout:

Select one or more active reports from the list of Available active reports.
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When an active report is selected, Refresh for active reports is enabled by default.

The active reports selected in the Available active reports list are modified based on
the current state of each active control it is bound to. Refresh for active reports refreshes
current views of bound active reports when you select a new value at run time.

For more information about the Refresh for active reports option, see Refreshing Active
Technologies Reports on page 325.

4. Select the Menu Option Types for the active control to sort, filter, list or select columns,
and/or change presentation styles of the bound active report and the associated report
and graph objects synchronized to the active report.

If no option is selected, the active control has no effect on the active dashboard.
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a. Select List of columns from Menu Option Types to list all common columns found
in each bound active report. At run time, the bound active report output is sorted
by the selected column.

For example, the following active control shows a list of all the columns in the bound
active report.

b. Select the Column value option from the Menu Option Types to list all unique values
found in a specified column, common in each bound active report at run time.

Note: You can only chain List of columns to Column value. You cannot chain a
Column value to another Column value.

When the Column value option is selected, the active control panel dynamically
presents Common Columns in each of the selected active reports in the Available
active reports list.

Select one column from the Common Columns list.

You can also use the Selected Value field to enter the values to be selected as the
default value whenever the procedure is run. The Add "ALL" option adds the option
to select ALL common column values to the control at run time.

IBM DB2 Web Query for IBM i 323

2. Creating Active Technologies Dashboards and Rich Internet Applications With HTML Composer



For example, the following active control shows RATING as the selected common
column for the bound active report.

c. Select List of filters from the Menu Option Types to list multiple filtering actions at
run time.

List of filters is used in conjunction with the Column value. Both controls should be
bound to the same active reports. The active control instructs how to filter bound
active reports based on the value selected in the Column value control.

For example, the following active control shows a list of filters in the bound active
report.

d. Select Sort order from the Menu Option Types to list sorting options (Ascending or
Descending) at run time. The active control sorts bound active reports based on the
sorting action selected.

By default, the active control sorts the first common column in each of the bound
active reports.
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For example, the following active control shows list sort order options in the bound
active report.

e. Select the Report types option from the Menu Option Types to list different active
report presentation types at run time. The active control changes bound active
reports to the presentation type selected.

For example, the following active control shows report type options in the bound
active report.

Refreshing Active Technologies Reports

How to:

Refresh Active Technologies Reports in the Active Technologies Control Panel

Refresh Active Technologies Reports With a Push Button or Hyperlink

The Refresh for active reports setting enables active controls to automatically modify current
views of bound active reports when you select a new value. Each bound active report is
modified not only by the new selection in the active control with the Refresh for active reports
setting, but is based on the current state of all active controls in the active dashboard. This
action is triggered at run time when you select a new value in an active control with Refresh
for active reports set.

Enabled (or checked) empowers the active control, only after you make a new selection,
to modify bound active reports.

Disabled (or unchecked) prevents any bound active report from being modified when you
select a new value in the active control.
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In order to update active reports when a value in the active control changes, you must check
the Refresh for active reports check box on the active reports Properties and settings dialog
box.

Refresh for active reports is selected by default.

You may want to disable the Refresh option if there are multiple active controls that require
each control to be set before you refresh your output. If you are using multiple controls, you
can associate the refresh option with a Push Button or Hyperlink, enabling you to refresh
the output once all the controls are selected.

How to Refresh Active Technologies Reports in the Active Technologies Control
Panel

Procedure:

1. From the Parameters tab, select active report as the Control Value.

The active report options appear.

2. Select the Refresh for active reports check box.

When an active report is first selected, Refresh for active reports is enabled by default.

How to Refresh Active Technologies Reports With a Push Button or HyperlinkProcedure:

1. Insert a Push Button or Hyperlink to the layout:

From the Insert menu, select Controls, then click Push Button.

From the Insert menu, select Components, then click Hyperlink.

The cursor changes into a crosshair.

2. Drag the crosshair to add the Push Button or Hyperlink object to the layout and adjust
it to the size you want.

If inserting a Push Button, right-click the push button object and select Create hyperlink
from the context menu.

The Hyperlink Properties dialog box opens.

If inserting a Hyperlink, the Hyperlink Properties dialog box opens.

3. Optionally, you may change the name of the Push Button or Hyperlink in the Display Text
field.

4. From the Hyperlink Properties dialog box, select the New icon to add a request to execute.

5. Select Refresh active reports from the Action drop-down list.

6. Select the Source drop-down list to select which active reports should be refreshed.
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The Source drop-down only lists the embedded or referenced active reports in the layout.

7. Click OK to close the Hyperlink Properties dialog box.

Exporting the Active Technologies Dashboard

How to:

Use Export as Procedure

Reference:

Conversions of Export as Procedure

Limitations of Export as Procedure

A benefit of active reports is the ability to run these reports offline. You can export an HTML
form as a Web Query procedure (.fex) to provide the ability to schedule and distribute active
dashboards, so these too can be run offline.

Export As Procedure converts the HTML page and embeds the code into a Web Query
procedure. The layout is no longer a webpage or HTML file, but a Web Query procedure with
embedded HTML code. The procedure (.fex) is added to the subfolder in your Reports group
folder (Managed Reporting environment).

Once the HTML form is saved as a procedure, it cannot be converted back to HTML Composer.

The Export as procedure is recommended for saving active dashboards only, as many layout
controls and report formats are not supported.
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How to Use Export as ProcedureProcedure:

Once the HTML form is exported as a procedure, it cannot be converted back to HTML
Composer.

1. After creating an active dashboard in HTML Composer, select Export as procedure from
the File menu.

The New Procedure File dialog box opens.

2. Type a File name and click Create.

If the layout contains any parameter controls other than an active control, the Export as
procedure option is unavailable.

Conversions of Export as ProcedureReference:

Export As Procedure converts the HTML page and embeds the code into a Web
Queryprocedure. The layout is no longer a webpage or HTML file, but a Web Query procedure
with embedded HTML code. This conversion requires conversion of each object on the HTML
page.

The purpose of creating a procedure from an HTML form is to provide the ability to run these
forms offline. Because you may not be connected to a DB2 Web Query environment, the
new procedure removes all referenced objects and adds them to the procedure. Layouts
with controls that require multiple requests to the server are not supported.

The following conversions occur when exporting as a procedure:

Referenced procedures get read from and written to, or embedded in, the saved procedure.

The display format of FLEX and APDF reports and chart objects is converted to HTML
format. For example, if the layout has embedded or referenced Excel, PowerPoint, or PDF
documents, these are converted to an HTML-formatted output.

The active reports (AHTML) format is preserved.

A reference to an image file is removed, and the image is embedded in the procedure
as inline HTML code.

This code can become very long and it is recommended that only small images be used
in layouts that will be exported as procedures.
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Limitations of Export as ProcedureReference:

Note the following limitations when applying the Export As Procedure in HTML Composer:

If using Static and Dynamic Parameter controls, the Export as Procedure menu item is
disabled for any layouts with static or dynamic parameter controls. Any scheduled report
supports only one request to the server at run time. These types of controls require
multiple requests to the server, and cannot be supported offline.

If exporting a procedure with background images, background images are not embedded
into the procedure due to size. The procedure keeps the reference. In offline mode, if
this reference cannot be resolved, no image is displayed.

If exporting a procedure and using cascading style sheets, the referenced style sheets
are not embedded into the procedure and the procedure keeps the reference. In offline
mode, if this reference cannot be resolved, no style from the CSS file is applied.

Scheduling and Distributing Active Technologies Dashboards
If an HTML form has been exported as a procedure (.fex), it is now available to be scheduled
with Report Broker.

For information about scheduling, see Adding Report Broker Schedule Capability to HTML
Composer on page 265.

Usage Notes for Active Technologies Dashboards Created With HTML Composer
The following apply when you create an active dashboard with HTML Composer:

HTML Composer enables you to graphically create and run an HTML page that incorporates
reports, charts, forms, and web objects. Certain processing occurs when HTML Composer
generates an active report or chart (format AHTML). An HTML Composer request is
executed after the HTML file is loaded into the browser. The active report or chart is
returned to the browser from the server and the result is appended to the HTML. The key
operations are retrieving the active report or chart content from the server and merging
the content with the HTML page.

HTML Composer displays a progress message that informs you of the processing that
is taking place.

At run time, an active chart embedded in a frame on an active dashboard uses the frame
size specified in the HTML Composer layout when one of the following settings is in
effect: ARGRAPHENGINE=FUSION, ARGRAPHENGINE=JSFUSION, or
ARGRAPHENGINE=JSCHART. With the default setting, ARGRAPHENGINE=DEFAULT, the
active chart does not adjust to the frame size specified.
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Creating a Rich Internet Application (RIA) With HTML Composer

In this section:

RIA Overview

Creating an RIA With HTML Composer

Usage Notes and RIA Example

A Rich Internet Application (RIA) enables you to create an interactive webpage experience
inside a browser. Using RIA, you can generate the exact look and feel of a Windows-based
graphical user interface in your web applications. RIAs provide rich and powerful graphics
and themes. You may set an RIA theme and animation properties for objects in the Design
tab in HTML Composer. Additionally, you may convert an existing page to an RIA or create
a new page as an RIA.

RIA Overview
The process of creating an RIA with HTML Composer consists of:

Enabling an RIA theme from the document properties of the HTML page.

Note: When RIA is enabled, the RIA Components toolbar is added to HTML Composer.
The Window and Accordion Control options are available from the RIA Components toolbar.
These components are additional controls that are available only when an RIA theme is
enabled. The traditional controls, buttons, tabs, and so on, all inherit an RIA look and
feel when an RIA theme is applied.

an RIA Window component enables you to create movable and resizable windows on
your HTML page that function as a container for other objects.

an RIA Accordion Control component enables you to create multiple pages within the
control that you can scroll through, each containing objects.

Setting the animation properties for the objects on the HTML page.

Note: An HTML page created with templates cannot use an RIA theme.
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Creating an RIA With HTML Composer

In this section:

Applying Animation Properties to the RIA

How to:

Apply an RIA Theme

Create an RIA Page

Add an RIA Window Component

Minimize the Size of a Window Control

Add an RIA Accordion Control Component

You may apply an RIA theme to an existing page in HTML Composer. You may also change
RIA themes for a page. RIA themes are only available for pages created without using a
template.

Note: Applying an RIA theme to an existing page overwrites your current HTML page. You
should make a copy of your original HTML file if you do not wish to overwrite it.

How to Apply an RIA ThemeProcedure:

By applying an RIA theme to an existing non-RIA page, you convert the HTML page to an RIA.

Tip: This procedure also applies to changing between RIA themes on a page.

1. Open an existing HTML file in HTML Composer.

2. Select DOCUMENT from the Properties window drop-down list.

The available properties for the document object appear.
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3. Select a theme from the RIA Theme drop-down list.

The RIA theme is applied to all components on the page. You may need to resize some
of your components.

4. Save and run the HTML page to see the RIA.

Note: You cannot revert your page back from RIA. Create a copy of your HTML page if
you do not wish to overwrite it, or close the page without saving.
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The following image shows an RIA theme that was applied to an existing page.

Optionally, you may want to animate objects and add RIA components (windows/accordion
controls) to the existing page to further graphically enhance your page. For details, see
How to Create an RIA Page on page 333.

How to Create an RIA PageProcedure:

This procedure describes how to create an RIA page, add RIA components, and animate
objects on the page.

1. Create a new HTML file with HTML Composer.

2. Select DOCUMENT from the Properties window drop-down list.

The available properties for the document appear.

3. Select a theme from the RIA Theme drop-down list.
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The RIA Components toolbar is added to HTML Composer.

4. Add objects to the layout, such as buttons and images, from the Components toolbar.

5. Optionally, add RIA specific objects to the layout, such as windows and accordions, from
the RIA Components toolbar.

Note: These additional controls are optional to enhance the development of your page
and are not required. Your page is an RIA once you apply an RIA theme. For details about
how to add these components, see How to Add an RIA Window Component on page 335
and How to Add an RIA Accordion Control Component on page 340.

6. Set the animation properties for the objects with the Animation Properties dialog box.

Select an object from the Design tab in HTML Composer.

Click the Animation Properties ellipsis button from the Properties window.

The Animation Properties dialog box opens.

Set the animation properties for the location, size, and/or opacity for the selected
object.

For descriptions of the available animation properties, see Animation Properties Dialog
Box on page 346.

7. Save and run the HTML page to see the RIA.

In the following example, the RIA shows the following:

An HTML page with an image.
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A push button that, when clicked, animates the Sales Report window.

An accordion control that shows a Sales Graph on one page.

A report with controls to supply incoming parameter values on the Sales by Region page.

Click the title of the accordion pages to switch between pages. For step-by-step instructions
on how to create this example, see Usage Notes and RIA Example on page 349.

How to Add an RIA Window ComponentProcedure:

A window component behaves as a parent component, enabling you to add children, such
as a report or graph, within the window. The window object can be animated, moved, or
resized at run time.

1. Select the Window button from the RIA Components toolbar.

The cursor changes into a crosshair.

2. Drag the crosshair to create the window and adjust it to the size you want.

A window component is created in the layout and assigned the name window(n), where
n is a number.
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3. Add an object, as a child, within the window component.

Note: Report, graph, and frame objects are added as children of the RIA component.
The role of a child indicates that they are grouped within the selected component and
function inside of that component.

To add objects as a child of a window component:

Select an object from the Components toolbar from the Design tab in HTML Composer.

Drag the selected object component from the toolbar inside of the RIA component.

Tip: If you have other objects on your Design canvas, you may press and hold the
Alt key, left-click, and drag that object onto an RIA parent component.

Release the mouse and resize the object inside your component.

For example, to create a report that runs within a window, drag a report from the
Components toolbar into the window object on the Design tab, release the mouse, and
resize the report object within the window component. Note that all the report options
and properties are available from the right-click context menu of the report, within the
window component.

4. You can automatically resize a report, graph, or frame to take up the entire window or
accordion page by selecting True for the Auto Fit property field of the Properties window,
as shown in the following image.
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The following image shows the design time view of a report that has been automatically
resized to take up the entire window. This property carries through to run time so when
the window is resized, the report will resize with it.
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5. You can choose whether the window starts expanded or collapsed by using the Initial
State option, located in the Properties window. The two options are Expanded and
Collapsed. The Expanded option sets the window to be expanded at run time and is set
by default. The Collapsed option sets the window to be collapsed at run time. The
following image shows this property on the Property window.
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6. You may rename the default window title by typing text in the Caption properties field
of the Properties window.

7. You may animate the window component itself, and any child object within the window.
Select the object and set the animation properties from the Properties window for the
location, size, and opacity. For details about animation properties, see Applying Animation
Properties to the RIA on page 346.

How to Minimize the Size of a Window ControlProcedure:

Minimize and restore buttons on a window control enable you to minimize the size of a
window to show just the title bar or to restore the window back to its original size.
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1. Run your RIA page and click the minimize button on the control, as shown in the following
image.

The window will collapse to show just the title bar, as shown in the following image.

2. To restore the size of the window, click the restore button on the control, as shown in
the following image.

The image is restored to its original size.

How to Add an RIA Accordion Control ComponentProcedure:

An accordion control behaves as a parent component, enabling you to create multiple pages
within the control that you can scroll through, each containing objects as children. An
accordion control can be animated at run time.

1. Select the Accordion Control button from the RIA Components toolbar.

The cursor changes into a crosshair.

2. Drag the crosshair to create the accordion control and adjust it to the size you want.

An accordion control with three pages is created by default and assigned the name
accordion(n), where n is a number.
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3. You may add and remove pages from the accordion control by using the right-click context
menu when the accordion component is selected.

4. Add objects, as children, to the accordion control page.

Note: Report, graph, and frame objects are added as children of the RIA component.
The role of a child indicates that they are grouped within the selected component and
function inside of that component.

To add objects as a child within the selected page of the accordion control:

Select an object from the Components toolbar from the Design tab in HTML Composer.

Drag the selected object component from the toolbar inside of the RIA component.

Tip: If you have other objects on your Design canvas, you may press and hold the
Alt key, left-click, and drag that object onto an RIA parent component.

Release the mouse and resize the object inside your component.

For example, to create a graph that runs within an accordion page, drag a graph from
the Components toolbar into the selected accordion page on the Design tab, release
the mouse, and resize the graph object within the accordion component. Note that
all the graph options and properties are available from the right-click context menu
of the graph, from within the accordion component.
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5. Add objects to other pages within the accordion control. Right-click the accordion
component and choose Select next page, from the context menu.

Tip: Double-clicking within an accordion control closes the selected page and opens the
next page of the accordion control.

The next page in the accordion control is selected. Insert and resize objects, such as
reports, graphs, and frames, within the selected page of the accordion component.
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6. You may rename the page titles by typing text in the Selected Page Title properties field
of the Properties window.
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7. To change the name of a different accordion page, right-click the accordion component
and choose Select next page from the context menu.

The next page in the accordion control is selected. Type the name for the page in the
Selected Page Title properties field in the Properties window.

Tip: Repeat this action (right-click the accordion component and choose Select next page
from the context menu) multiple times to get to the desired page of the accordion.
Optionally, double-clicking within an accordion control closes the selected page and
opens the next page of the accordion control.

8. You may set the accordion control properties, specific to the behavior of accordion page
speed in the RIA, by turning the animation on or off, and by setting the animation speed
for switching between pages.

The accordion page speed properties are Animated and Animation Speed in the Properties
window when an accordion component is selected.

Animated is set to Yes. The accordion control animation speed is turned on by default,
enabling you to set the animation speed for switching between accordion pages. The
default speed is Normal.

Selecting No turns off the animation speed for the accordion control, ignoring the
Animation Speed setting, and displaying the default speed in the RIA.

Animation Speed is set to Normal by default. The animation speed indicates the
speed for switching between pages in an accordion control. You may select from
Very Slow, Slow, Normal, Fast, Very Fast.

The animation speed is only applied if Animation is set to Yes.
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The following image shows an accordion control with the default animation and animation
speed properties.

9. You may animate the accordion component itself, and any child object within the
accordion pages. Select the object and set the animation properties from the Properties
window for the location, size, and opacity. For details about animation properties, see
Applying Animation Properties to the RIA on page 346.

Note: These location, size, and opacity animation properties are not the same as the
accordion Animated and Animated Speed properties, which are specific to accordion
page speed in the RIA.
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Applying Animation Properties to the RIA

Reference:

Animation Properties Dialog Box

Adding animation properties to the RIA enables you to create visual effects and animated
movement for your web application. The Animation Properties dialog box is available from
the Properties tab of the Properties window in HTML Composer. By default, the location,
size, and opacity animation options are not enabled for objects on an HTML page.

You may apply animation properties to the RIA with the Animation Properties dialog box in
HTML Composer.

Note: Animation properties are disabled for all objects by default, with the exception of the
accordion page speed options.

Animation Properties Dialog BoxReference:

The Animation Properties dialog box enables you to set the Location Animator, Size Animator,
and Opacity Animator options for RIA objects on the HTML page.

Note: The Animation Properties option is only available from the Properties window if an RIA
theme is enabled for the page. You may set animation properties for all objects on the page,
such as reports, graphs, buttons, windows, and accordions.

Click the Animation Properties ellipsis button from the Properties window in HTML Composer.
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The Animation Properties dialog box opens, as shown in the following image.

Location Animator

The Location Animator options set up the location animation for an object. The animator
is then instructed to move objects from one point to another in the RIA, based on the
control action, or automatically, after the page fully loads.

From/To Position Left/Top

The From Position and To Position indicates the starting position and ending position
for the location animation event.

Note: It is suggested that you keep the From Position Left/Top values the same as
the current position on the layout, otherwise, it will jump to the From Position Left/Top
when the animation starts.

Speed

Controls the acceleration and deceleration of the animation. Options range from
slowest to fastest, with normal being the default selection.
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Control to activate

Indicates the event that will start the animation. The default is Auto Start, which
starts the animation automatically. Otherwise, you may select another object from
the drop-down list to identify another control that will be used to start the animation,
like a button, for example.

Reverse on second click

Indicates that on a second click of the control to activate, the animation should be
executed in reverse.

Size Animator

The Size Animator options set up the width and height animation for the object. This
enables an object to grow or shrink in size when the animation is selected.

From/To Size Width/Height

The From Size and To Size indicates the starting size of the object and the ending
size it will be after the animation event is executed.

Speed

Controls the acceleration and deceleration of the animation. Options range from
slowest to fastest, with normal being the default selection.

Note: The location and size animation takes the same amount of time to complete.
They will be synchronized if used in conjunction with each other.

Control to activate

Indicates the event that will start the animation. The default is Auto Start, which
starts the animation automatically. Otherwise, you may select another object from
the drop-down list to identify another control that will be used to start the animation,
like a button, for example.

Reverse on second click

Indicates that on a second click of the control to activate, the animation should be
executed in reverse.

Opacity Animator

The Opacity Animator options set up the opacity animation for the objects. Setting the
opacity enables you to fade RIA components on your page.

Speed

Controls the acceleration and deceleration of the animation. Options range from slowest
to fastest, with normal being the default selection.
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Control to activate

Indicates the event that will start the animation. The default is Auto Start, which starts
the animation automatically. Otherwise, you may select another object from the drop-
down list to identify another control that will be used to start the animation, like a button,
for example.

Type

Sets the type of background opacity. Options are pulsate, blink, fadeIn, and fadeOut,
with pulsate being the default selection.

Usage Notes and RIA Example

Reference:

Matching RIA Themes and StyleSheets

Usage Notes For Creating an RIA

This section describes usage notes for creating an RIA and provides steps to create an RIA
example.

Matching RIA Themes and StyleSheetsReference:

The RIA look and feel that is inherited when an RIA theme is applied can be matched by the
Report or Chart StyleSheet in order for the styling to match the theme. The table below
describes the RIA themes and the StyleSheets that correspond to the theme for each tool.

Report and Chart StyleSheetBI Portal ThemeRIA Theme

AnyAnyClean

ENria_ocean_rounded_themeTealOcean Rounded

ENria_carbon_rounded_themeBlackCarbon Rounded

ENria_dark_ocean_rounded_themeGreenDark Ocean Rounded

ENria_olive_rounded_themeGreenOlive Rounded

ENria_blue_themeBlueBlue

ENria_charcoal_themeBlackCharcoal

ENria_gray_themeSilverGray
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Report and Chart StyleSheetBI Portal ThemeRIA Theme

AnyAnyHigh Contrast

ENria_ruby_themeRedRuby

ENInformationBuilders_Dark

ENInformationBuilders_DarkComp

ENInformationBuilders_Default1

ENInformationBuilders_Light1

ENInformationBuilders_Light2

ENInformationBuilders_Medium1

ENInformationBuilders_Medium2

Information BuildersInformation Builders

ENBlack_Dark

ENBlack_DarkComp

ENBlack_Light1

ENBlack_Light2

ENBlack_Medium1

ENBlack_Medium2

ENblack_theme

ENblackbluepurple

BlackBlack

ENBlue_Dark

ENBlue_DarkComp

ENBlue_Light1

ENBlue_Light2

ENBlue_Medium1

ENBlue_Medium2

ENblue_theme

ENblue-medium

BlueBlue
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Report and Chart StyleSheetBI Portal ThemeRIA Theme

ENGreen_Dark

ENGreen_DarkComp

ENGreen_Light1

ENGreen_Light2

ENGreen_Medium1

ENGreen_Medium2

ENgreen-gray

GreenGreen

ENOrange_Dark

ENOrange_DarkComp

ENOrange_Light1

ENOrange_Light2

ENOrange_Medium1

ENOrange_Medium2

OrangeOrange

ENPurple_Dark

ENPurple_DarkComp

ENPurple_Light1

ENPurple_Light2

ENPurple_Medium1

ENPurple_Medium2

ENpurple-light

PurplePurple

ENRed_Dark

ENRed_DarkComp

ENRed_Light1

ENRed_Light2

ENRed_Medium1

ENRed_Medium2

ENred-bronze

RedRed
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Report and Chart StyleSheetBI Portal ThemeRIA Theme

ENSilver_Dark

ENSilver_DarkComp

ENSilver_Light1

ENSilver_Light2

ENSilver_Medium1

ENSilver_Medium2

SilverSilver

ENTeal_Dark

ENTeal_DarkComp

ENTeal_Light1

ENTeal_Light2

ENTeal_Medium1

ENTeal_Medium2

TealTeal

When applying StyleSheets and Templates it is important to note the following:

You need to put the StyleSheet file in the Other folder of the Managed Reporting domain
in order for it to be visible by the tool.

For Report Assistant, you can select the appropriate name from the Predefined Templates
section of the Style File Selection tool. The names listed correspond to the names in the
InfoAssist column in the preceding table.

Usage Notes For Creating an RIAReference:

The following apply when creating an RIA in HTML Composer.

If you use the Olive Rounded RIA theme and reference a parameterized report, the
Schedule button is blank. The Schedule button displays correctly if you use other RIA
themes.

RIA only supports pixels for font size (Bindows limitation).

For iframes, reports, and graphs, you will only see a border if you specify a width. By
default, RIA gives the border a solid 1px border. If you want to specify a greater value,
select Custom, and give it a number in pixels (Bindows limitation).

Overline is not supported in RIA (Bindows limitation).
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The following features are not supported in RIA:

Multi-Select Drop-Down List control

Global Search and Paging control

Making an ActiveX control a child of another control

Undo/Redo option

The RIA theme overrides any styling that has been applied to individual objects.

If you have a CSS class referenced in a non-RIA page, when you convert to RIA, the CSS
reference is removed from the HTML source and is replaced with the RIA CSS. This is
because the RIA theme includes its own styling and will most probably require you to
update your styling to go better with the RIA theme.

When using an RIA-enabled page with an AHTML report, the Export as Procedure option
is not available in the File menu.

In migrating from a non-RIA page to an RIA page, any JavaScript calls that go against the
controls cannot be in the window_onload function because the controls are not available
until the RIA framework completely loads in the browser. This means that these JavaScript
calls need to be moved out of the window_onload function and placed in other functions
that get called after the page and RIA framework are loaded.

Migrating a non-RIA HTML page removes any custom styling. Applying an RIA theme
provides its own color scheme and styling. You may add custom styling after converting
the RIA page.

RIA only supports integers and pixels when specifying a measurement for font size and
border size.

When adding existing objects from the canvas to an RIA window or accordion control, you
may not just copy or move the object into the RIA parent component. Press and hold the
Alt key, left-click, and drag the object into the RIA component to make it a child of the
RIA component.

If you are adding objects as children to any RIA control by using the Insert menu, draw
the object in an open space on the canvas, press and hold the Alt key to drag that object
to the parent object, and release the mouse.

The location of accordion pages cannot be changed.

To support RIA controls in HTML Composer, additional StyleSheet templates are available
in and InfoAssist.
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Note: The file extensions of the RIA StyleSheet templates vary, depending on the tool,
but all appear as ria_stylesheet_theme.file extension, where the file extension is .txt or
.sty. The available RIA StyleSheets are:

ria_carbon_rounded_theme

ria_dark_ocean_rounded_theme

ria_ocean_rounded_theme

ria_olive_rounded_theme

ria_blue_theme

ria_charcoal_theme

ria_gray_theme

ria_ruby_theme

ria_turquoise_theme

Selecting one of these templates in your tool enables you to inherit the same RIA look
and feel for the report or chart when the same RIA theme is applied in HTML Composer.
For more information on StyleSheets/Templates matching the look of a certain RIA theme,
see Matching RIA Themes and StyleSheets on page 349.

Multiple vertical lines may appear across some RIA controls on the Design tab in HTML
Composer. For example, inserting an accordion control shows multiple vertical lines
through the accordion control page title toolbars. These lines are more visible when using
darker RIA themes for your document. These multiple lines do not appear in the RIA page
at run time.

When adding a Tab Control to the layout as part of an RIA page, you can switch between
tabs on the Design tab in HTML Composer. Double-click the desired tab to switch between
tabs or select the Tab Control, right-click, and choose Select next tab or Select previous
tab from the context menu.

The following image shows a Tab Control on an RIA page with these options.

Note: You can change the text on a tab control by entering the text in the Title of element
property field in the Properties window.

354 IBM

Creating a Rich Internet Application (RIA) With HTML Composer



Creating an RIA With HTML ComposerExample:

Suppose you want to create an RIA that shows:

An image.

A push button, that when clicked, animates the Sales Report window.

An accordion control that shows a Sales Graph on one page.

A report with controls to supply incoming parameter values on the Sales by Region page.

This example assumes that you are familiar with the basic Developer Workbench features.
The following example creates an RIA by:

Creating a graph to be used in the RIA.

Converting an existing HTML page to an RIA.

Creating an RIA window component with a report that has drill downs.

Adding a button that animates the RIA window.

Creating an RIA accordion control that shows a frame on one page, and a report with
chained controls on another page.

1. Create a graph to be used in the RIA.

Create the sales graph to be used as a target from a drill-down report in the RIA.

a. Create a new procedure in Developer Workbench:

With the Procedures folder highlighted, select New/Procedure from the File menu.

or

Right-click the Procedures folder and select New/Procedure from the context menu.

The Add Procedure dialog box opens.

b. Enter graphbyproduct as the name for the new procedure in the File name field and
click Open.

The Procedure Viewer opens.

c. Click a component connector (yellow diamond) and select Graph.

d. Select the ggsales.mas Master File and click Open.

Tip: The Gotham Grinds Sales data source (ggsales.mas) is available from the ibisamp
Applications on localhost folder of Developer Workbench. You may copy this source
file to the project directory of your choice.

InfoAssist opens.

IBM DB2 Web Query for IBM i 355

2. Creating Active Technologies Dashboards and Rich Internet Applications With HTML Composer



e. Select Build a Chart from the main menu.

Select the ggsales.mas Master File and click OK.

f. Select Format from the menu and click Pie from the Chart Types section.

InfoAssist refreshes showing a pie chart.

g. Drag State to the Slices category under the Query and then drag Budget Units to the
Measures (Sum) category under the Query section.

h. Select the Header & Footer button from the Home menu and type By Product:. Drag
PRODUCT from the Field Tree in the Heading window to the Header & Footer window.
<PRODUCT is inserted into the Header & Footer window. Position it after By Product.

The heading appears as By Product: <PRODUCT. Click Apply and OK.

i. Click on Product in the Data window. In the Home menu, click the Filter button. The
Filter tool opens. Equal to is set as the default operator. In the Add: box, type Product
Name. Click the add filter button. Click Ok and the Filter tool will create the following
parameter: WHERE PRODUCT EQUAL To Product Name

j. In the Format menu, click the Labels button. The Axes and Legend buttons are now
shown. Click the Legend button and select Left from the Legend Position drop-down
list.

k. Save and close the graph and Procedure Viewer.

2. Convert an existing HTML page to an RIA and add objects to the page.

a. Create a copy of chaining_example.htm, that was created in Applying Conditions to a
Chain on page 290 of this manual, and rename it to ria_example.htm.

b. Open ria_example.htm in HTML Composer.

c. Select DOCUMENT from the Properties window drop-down list.

The available properties for the document object appear.

d. Select Clean from the RIA Theme drop-down list.

The RIA theme is applied to all components on the page and the RIA Components
toolbar is added to HTML Composer.

e. Move the report and control down the page, as we will use those components later.

f. From the Insert menu, select Components, then click Image.

The cursor changes into a crosshair. Drag the crosshair to create the image object
and size, and select an image from the Get source file dialog box.

g. Select Push button from the Components toolbar and drag it onto the Design canvas,
underneath the image.
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h. Rename the button by selecting the Push button on the Design tab and double-click
in the field next to Value in the Properties window.

Tip: The button object appears as button1<DIV> in the Properties window drop-down
list.

i. Type Animate Sales Report in the Value property field and press the Enter key.

j. Click the Animation Properties ellipsis button from the Properties window.

The Animation Properties dialog box opens.

k. Select the Opacity Animator check box to enable the opacity settings.

l. Select blink as the Type, and leave the Control to activate as <Auto Start>.

This indicates that the blinking animation for the push button will start automatically
in the RIA page.

m. Click OK to close the Animation Properties dialog box.

3. Create and animate an RIA window component.

a. Select the Window button from the RIA Components toolbar.

b. Drag the window onto the Design canvas.

c. Release the mouse and resize the object.

d. Rename the window by typing Sales Report in the Caption properties field of the
Properties window.

Tip: The RIA window component appears as window1<DIV> in the Properties window
drop-down list.

e. Select the Report button from the Components toolbar and drag it into the window
object on the Design tab, release the mouse, and resize the report object within the
window component.

f. Double-click the report object and select ggsales.mas.

Tip: The Gotham Grinds Sales data source (ggsales.mas) is available from the ibisamp
Applications on the localhost folder of Developer Workbench. You may copy this source
file to the project directory of your choice.

g. Create the sales report, with a drill down on the Product field, to be used in the RIA
window:

Insert CATEGORY,PRODUCT, REGION, and ST as the By fields, hiding the ST field.

Insert DOLLARS as the Sum field.

Add Sales by: <GGSALES.SALES01.ST in the Page Heading.
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Select the Product field, right-click, and select Options to open the Field Properties
dialog box.

Select the Drill Down tab to apply a drill down to the Product field column data,
that executes a procedure in a frame.

Select Column Data as the active object. Select Execute Procedure as the Drill
Down Type. Select graphbyproduct.fex as the Procedure name (which we created
in step 1 of this example). Enter iframe1 as the Target Frame location, which we
will add later in HTML Composer.

Select Add from the With Parameters section of the Drill Down tab, and select
PRODUCT from the Parameter name drop-down list. This is the parameter that we
created in the graph. Leave Field as the Parameter value and select
GGSALES.SALES01.PRODUCT from the drop-down list.

Close and save the report.

The drill down report appears in the RIA window component.

h. Select the report component and set the Auto Fit property field to True in the Properties
window.

i. Select the RIA window component on the Design tab and click the Animation Properties
ellipsis button from the Properties window.

Tip: The RIA window component appears as window1<DIV> in the Properties window
drop-down list.

The Animation Properties dialog box opens.

j. Select the Location Animator check box to enable the location settings.

k. Select button1 from the Control to activate the drop-down list.

This indicates that clicking the Push button will activate this window at run time.

l. Type the From Position Left value as 10.

This indicates that the location of the window will start the animation 10 pixels from
the left position of the page when the window is animated.

m. Click OK to close the Animation Properties dialog box.

4. Create an RIA accordion control component.

a. Select the Accordion Control button from the RIA Components toolbar.

b. Drag the accordion control onto the Design canvas underneath the RIA window
component.

358 IBM

Creating a Rich Internet Application (RIA) With HTML Composer



c. Release the mouse and resize the object.

d. Rename the selected page of the accordion by typing Sales Graph in the Selected
Page Title properties field of the Properties window.

Tip: The RIA accordion control component appears as accordion1<DIV> in the
Properties window drop-down list.

e. Select the Frame button from the Components toolbar and drag it into the accordion
object on the Design tab, release the mouse, and resize the frame object within the
accordion page.

Note: The frame component appears as iframe1<IFRAME> in the Properties window
drop-down list. This is the name that we assigned as the Target Frame location for
the drill-down report that appears in the RIA window.

f. Select the Frame component and set the Auto Fit property field to True in the Properties
window.

g. Right-click the accordion component and choose Select next page from the context
menu.

The next page in the accordion control is selected.

h. Type Sales by Region in the Selected Page Title properties field of the Properties
window.

i. Scroll down the Design tab and select the existing report and control by using the
Shift key on your keyboard.

j. Press and hold the Alt key, drag the selected components onto the accordion page,
and release the mouse.

The report and control are added within the Sales by Region accordion page. Resize
the objects, if necessary.

k. Remove any unused pages from the accordion control by selecting and removing
pages from the right-click context menu.

5. Save and run the RIA.
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The following image shows the RIA at run time.
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